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Customer support

Customer support

Dear MAGIX customer,

Our aim is to provide convenient, fast and solution-focused support, which is why you
can get unlimited web support and help through our online community at
www.magix.info.

As a registered MAGIX customer, you have unlimited access to web support offered by
the MAGIX service portal in the Support area at www.magix.info. You have access to an
intelligent help wizard, high-quality FAQs, patches and user reports that are constantly
updated.

The Online Community is available for free to all registered MAGIX customers in the
Forum area. The community enables you to ask members questions concerning MAGIX
products as well as use the search function in order to search for specific topics or
answers. In addition to questions & answers, the knowledge pool includes a glossary,
video tutorials and a discussion forum. The multiple experts, who are on www.magix.info
everyday, guarantee quick answers, which sometimes come within minutes of a question
being posted.

Note: A free registration is required for a support request at www.magix.info.

MAGIX Sales Department

You can reach the MAGIX Sales Department workdays for help with the following
questions and problems:
« Orders
o Product consulting (pre-purchase)
o Upgrade requests
o Returns
Phone: +49 5741 3455-31, Monday to Friday 10:00 am - 4:00 pm
Email: infoservice@magix.net
Address: MAGIX Software GmbH, Borsigstrasse 24, 32312 Libbecke

Particularities for purchases made through Steam™

Different conditions apply if you have purchased the program through Steam™. You can
find more information at https://support.steampowered.com.

12 /216


https://www.magix.info/us/
https://support.steampowered.com/

Serial number

Serial number

A serial number is included in each product. This serial number is required for software
activation. Please store this number in a safe place.

Use of a serial number

With a serial number your program license is clearly assigned to you and only you. This
allows you to use the free customer service via email.

Serial numbers also help protect against software piracy. This makes it possible for us to
offer our customers the most value for their money.

Where is the serial number located?

For boxed versions of the program, the serial number can be found on the insert card
inside the box.

If you have purchased a download version, you will receive a confirmation email
containing the serial number that you can use to activate the program. This will be sent
immediately following purchase to the email address you provided.

When is the serial number needed?
The serial number is required when you start the program the first time, as well as for
program registration.

Using the serial number on another computer

If you want to use the serial number on another computer or after reinstalling your
operating system, you must deactivate the program on your current PC.

This "releases" the serial number from the current computer so that it can be used on
another.

Note: You can also deactivate the program in the MAGIX Service Center, but it is much
more convenient to do this with the integrated feature in MAGIX MusiC MAKER.
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Introduction

Note: This documentation describes Music Maker with all its available functions. Certain
functions are only available after an Edition has been activated or after the functions
have been purchased in the Store.

What is MAGIX Music MAKER?

MAGIX MusiC MAKER is the ideal program for creating professional sounding recordings
without having to learn any complicated musical theory. You can simply combine the
professionally produced loops in the intuitive arranger and mix them to create your own
personal sound.

Aiming for a one-of-a-kind sound that will let you stand out from the crowd? Try creating
your own sounds with the included software synthesizers or load your own plug-in
synthesizers. High-quality effects help to give your tracks the final polish or you can take
things in the other direction and distort them until they are almost unrecognizable.
Express your creativity by recording your own vocals or instruments and adding them to
the project.

Whether rock, techno or orchestral film music, you can produce all kinds of tracks using
the wide range of genres available in the program. When you combine elements from
different style libraries the tempo is adjusted automatically to make sure your
arrangement fits together perfectly. Who knows? Maybe flamenco rock or country
techno is the next big thing.

If you need even more sounds and samples, the in-app Store offers a rich selection of
audio, video, images and professionally created sound effects for adding even more
variety to your project.

Or how about a remix? Load up your favorite hits from the past and add some fat bass or
a totally modern beat! When you load audio CD tracks and MP3s into MAGIX Music
MAKER the tempo of the song is recognized and adjusted to fit the project. The track can
also automatically be cut into loops.

But music alone isn't everything! You can import images and video files to your project,
include text and add video effects and cool visuals. Your finished music video can then be
directly exported from MAGIX MusiC MAKER and posted on Soundcloud or YouTube.

Quick Start

This chapter explains the basic functions of MAGIX MusiC MAKER with a step-by-step
introduction. A systematic description of all program functions can be found towards the
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end of the manual.

~ Tip: Watch the tutorials videos on our website and learn some tips and tricks from other
users at magix.info - Multimedia Community.

Preview demo song

Upon opening the program, the start screen will appear.

If you are not signed into the Store, MAGIX MusIC MAKER runs as the free version of
MAGIX MusiC MAKER. In this case, many program functions are not available or are
limited, but there are still enough to familiarize yourself with the program's workflow.

To get an idea of what MAGIX MusiC MAKER can do, click on Demo projects and select a
demo song. Once it is loaded, the MAGIX MusiC MAKER interface will be displayed.

T

The large area with the horizontal tracks is the arranger. The colored rectangles are
objects. They represent various samples. Look at the individual tracks of the song in the
arranger: In MAGIX MusIC MAKER, create a complete song by compiling objects. Click on
the vertical scroll bar on the right-hand side of the screen and drag them down (hold
down the left mouse button) in order to be able to see each track.

Underneath the arranger you'll find the transport console (740) and some buttons for
opening important windows and a large volume control.

Below in the program window is the keyboard for playing the synthesizers and the Song
Maker, which can be used to automatically arrange songs.

There are several other windows that can be opened using the buttons in the top toolbar.
All windows can be freely positioned (723) around the arranger.
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To play the demo, click on the Play button with the mouse or press the spacebar on your
keyboard. A vertical red line (the playback marker) runs across the screen and music will
play from the speakers.

~ Note: If you do not hear anything, check if the correct sound card is active for playback in
the Setup window (P key).

Previewing and loading sounds
Now you can load your first sound into the arranger.

E Create a new, empty project. Simply click on this button.

« Click on Loops (1) in the top right. The Loops
window will appear.

« Various Soundpools (2) are displayed to the
right in a window. Soundpools represent
particular musical genres. Click on one of the
Soundpools to display the loops that match
this genre.

« Now, select which instrument you would like
to use under instruments (3). All of the loops
(5) will be listed below and you can select the
sound you want. The selected sound will play
back automatically.

« Most instruments are categorized according
to pitch. Click on the pitch (4) to listen to the
sound in the corresponding pitch. Other
instruments, like drums, are not categorized
according to pitch.

« Toload afile into the arranger, simply press the Enter key. You can also drag the
file from a list onto a track in the arranger. Once you let go of the mouse button,
the file will appear as an audio object at that position.

Create a Project
Start playback now.
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To load new samples into the arranger, you do not need to interrupt playback.

MAGIX Music MAKER has a "Smart Preview" function: You can simultaneously preview
new samples in the Loops window - they always run in sync with the song in the
arranger. This function considerably simplifies the search for suitable samples for a song
you wish to create.

Pt
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This way, any number of loops from any Soundpool can be dragged from any folder into
the arranger and placed on top of one another, on multiple tracks, or behind one another.

The pitch of the first loop is displayed in the pitch bar. When additional loops are are
added underneath at the same time position, they are automatically adjusted to the same
pitch.

Take note of the two markers at the top of the bar ruler - they represent the start and
end points of the range to be played (playback range). Playback is "looped" in this range
which means that it repeats continuously. New loops can be added when possible.

If you want to create a new part for the song you can reposition the start marker by left-
clicking on the bar ruler and the end marker by right-clicking on the bar ruler.

Each object can be moved in any way in the arranger with the mouse; horizontally on a
track as well as vertically between tracks.

Manipulating objects

Even though it's possible to make great projects with the audio building blocks provided,
you will probably get to a point where you want to add your own personal touch by
shortening or removing objects or adjusting the loops in specific areas.

All objects can be shortened or looped by moving the mouse to one of the lower corners
of the object until it turns into a stretch symbol. You can now stretch or compress the
object length as much as you like. If you make the object longer than it originally was, it
will be played back as a loop. This way you can create rhythm tracks from short drum
samples simply by stretching them.

If an object is selected, additional "handles" will appear on it.
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Br Bk,
Two fade handles are found on both sides, which can be dragged inwards in order to fade

the object in and out. The handle in the center can be used to adjust the volume of the
object.

You can conveniently adjust the volume of a track in the Mixer, which can be
opened with the M key or this button:

All objects can be split into multiple objects. Place the play cursor at the desired location
by clicking in the timeline and press the "T" key.

Alternatively, you can also use the "Split" button in the toolbar.

Right-clicking on an object opens the context menu with the options available for that
specific object in the Timeline mode.

Tip: You'll really notice the advantages of object-based editing when you start to use
Object Effects! You can apply audio effects to each individual audio object. For example,
you can cut a sample to create an object for the last beat before a pause in the project
and add an echo effect. Or create some crazy drums by applying various filter effects to
each beat in the loop.

Adding software instruments

The included audio loops in the Soundpool are of the highest quality and melodically
synchronized. But sometimes it's good to have a bigger selection of beats and melodies
or a way to create your own ideas. In this case you need software instruments.

While audio objects consist of pre-made recordings, the sound from software
instruments (synthesizers) is created during playback on the computer. The resulting
sounds are not as refined but allow for total control of every musical detail.

Software Instruments are loaded to a track and controlled by MIDI objects in the track.
MIDI objects only contain control information (notes) that is used to create sounds in
VST instruments. Various MIDI objects arranged on one track control the same
synthesizer and that means a maximum of one instrument per track.

Open the Software instruments window by pressing the | key or clicking on this
button:
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When the mouse is moved over a synthesizer, a play button appears that allows you to
play a sample of the instrument. Drag the desired synthesizer into an arrangement track
by holding down the mouse button.

A preset MIDI object is added to the track. Double-clicking on it opens the MIDI Editor
where you can make adjustments to the melody.

Or open the Keyboard window (keyboard shortcut: K). Here you can play the synthesizer
using your computer keyboard. You can also record your playing by clicking on the large
red record button.

" Tip: You can access the sound programs of the included VST instruments with the button
on the far left of the track.
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Effects

You can select a number of effects from the context menu for an object. Effect modules
can be opened and adjusted to get the exact sound you want.

Effects can be dragged as finished effect templates onto objects. Simply open the

Templates window and test out the effects listed in Audio FX by clicking on them.
You'll hear a short preview of the effects. If you like an effect, simply drag it onto the
object in the arranger.

Tip: Use the Object effects window (keyboard shortcut: O) to display all the important
effects for an object.

Another option for using effects is to apply Track effects. These effects influence the
signals of an entire track, making it a quick way to apply the same effect to several
objects or add the audio output from synthesizers.
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You can also select from a variety of useful track effect presets by clicking on the
button on the corresponding track. These are organized according to the
instruments and applications.

Export project:

When your project is finished, you'll most likely want to do something with it - for
instance share it with friends. To do this, you first need to export your project from
MAGIX MusIC MAKER.
The essential functions for exporting can be accessed under File > Export >
Standard export options (keyboard shortcut: X).
L] exportprrect * o Export as WAV: If you want to publish
e or archive a project, it's best to export it
vt s WAV in the highest possible quality, as a
e WAV file.
ot ae s o Export as MP3: You can export your
& project in MP3 format to listen to it on
smartphone.

Export as 0GG

o Burn to audio CD: The classic way to
present and share music. You can burn
individual songs or entire album projects
to CD.

Export your song in the

Post on Sound

o Publish on Soundcloud: Publish directly on these online platforms using this
option.

« Export in various formats: In the File > Export menu you will also find all
supported export formats for creating an audio or video file (for music videos)
from your project.
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Program interface overview
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o Menu Bar This bar provides the most important editing commands.

e Toolbar This contains the buttons for file operations, quick editing as well as
accessing the different window and mouse modes.

6 Track Complete tracks can be turned on or off (muted) or played separately
headers (solo). Use the FX buttons to apply track effects. Software instruments
can be loaded using the buttons at the front. Use the faders to adjust
track volume.

Q Arranger You can freely position any multimedia material on all of the arranger's
tracks.

@ Transport The transport controls for playback and record functions and for

control  displaying tempo are located on the right.

@ Zoom Here, you can enlarge and reduce the view. The horizontal scrollbar can

functions be stretched and compressed for zooming.

9 Docks All windows in MAGIX MusiC MAKER open by default in one of the two
docks either below the arranger or to the right of the arranger. However,
you can arrange any of the windows in a different way (see below).

@ User Here, you can see if you are currently logged in to the store, and if so,

accounts with which user account. You have to logged in to the Store to be able to
display  use purchased functions.
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Docking

Every window can be freely positioned. Using docking, you arrange the windows of
MAGIX MusiC MAKER on the program interface.

Every window (e.g. Loops, Song Maker, Object effects, Keyboard, MIDI editor...) can be
displayed in the interface either undocked (free-floating) or docked.

Undocked windows can be placed on top of other windows, resized as desired and feature a title bar.

You can dock undocked windows by touching them in the title bar and dragging them
next to or over other windows.

If you drag a window next to another window, it moves a bit to the side and the target area will be
displayed in blue.
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If you drag a window on top of another window, the entire target window will be colored blue.

The windows then share the same screen area as a "dock".

& Mixer X Keyboard X Song Maker X

1 REC 2 REC 3 REC 4

Click on the corresponding tab to bring the window to the foreground.

If you drag the tab, you can pull it out of its dock again to display it free-floating or dock it
elsewhere.

. In the View > Layouts menu, you can find preset window arrangements for specific
intended tasks.

In the View menu you can reset the standard layout (keyboard shortcut: F4) for
MAGIX MusIC MAKER.

Editions

Until now, MAGIX Music MAKER was available in different versions: "Classic",
"Producer”, "Premium", "Live", etc. The one things all versions had in common was that
they contained a set collection of Soundpools, synthesizers, available tracks, effects and
other functions. And if you needed a certain synth that wasn't included in a more basic
version, there was no choice but to purchase a more advanced version, even if this
contained other features you didn't need.

Now, things are different: An Edition contains some set elements, but also includes credit
for functions packs, presets, instruments, Soundpools and Soundpool Collections. You
can use your credit to buy the exact content you want. This means you no longer buy a
predefined pack, but instead select a number of synthesizers, Soundpools and features.
The amount of content you can select depends on the Edition you have.
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An alternative option is to start with the free program version and simply buy the
functions, sounds and instruments that you need. With an Edition you can really save big,
however, as it costs less than buying content individually.

Access all the new Editions, additional functions, Soundpools, effects and instruments via
the Store (7161).

Learn more about the Editions here!
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Loading sounds

Loading sounds

This chapter explains how to load sounds into MAGIX MusiC MAKER by using the
included Soundpools or the Song Maker, loading audio files via the file manager, or
importing CD tracks or your own audio recordings.

Loops

The Loops window can be used to load loops from Soundpools. You can access the
Soundpools via the clearly laid out database view, which lets you arrange the loops
according to Soundpools, instruments and pitch.

B Using this symbol or the L key, you can open the Loops window.

A Soundpool is a sound library that belongs together and covers a certain musical style.
The sounds of one Soundpool all have a certain tempo. You can also combine loops from
different Soundpools and the loop's tempo will be adjusted accordingly. Within a
Soundpool, loops are ordered according to instruments, and one instrument folder
contains different sounds. Each sound can have a different pitch (except for drums and
effects sounds).

~ Note: Only a small number of the available Soundpools are included in the Loop window
after you install MAGIX Music MAKER. You can add more Soundpools via the Store
(7161).

Soundpools from previous versions of MAGIX MusiC MAKER can also be imported. To do
this, click on Add new Soundpools... in the Settings menu under the gear icon.

~ Note: Under Program settings > General (7209), you will find different options for
maintaining and displaying the Soundpool database.

All of the Soundpools are displayed in the first column. Click on the Sort [El button to sort
them in ascending or descending alphabetical order. The second column lists the
instruments.

The list of samples found is created after entry selection in these two columns. With "Ctrl
+ click" you can reduce or expand a selection. Click on Select all to select all entries
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in this column. If you select an instrument, e.g. "Drums" and "Percussion", and all
Soundpools, all drums and percussion samples in the whole database will be displayed.

Filter results list

The results list can be filtered in a variety of ways to reduce the number of search results
according to different criteria.

_ Full text search: Above right in the search field you can

search the list of samples found for a specific sound file
name.

All loops The drop-down menu lets you filter the results further.

Only new loops: Only loops newly added during this session will be displayed.

Clicking on the heart in the sample list marks the loop as a favorite. You can use the u
drop-down menu option Only favorite loops to display only the loops that you have
marked as favorites.

Sort results list

You can sort the list according to criteria (Instrument category, name, favorite) by clicking
on the column header. Via "Optional columns" under the gear icon in the settings menu,
you can add in additional columns with loop characteristics such as BPM, length in bars,
harmony and type in list for use as sort criteria.

Smart Preview

The loops can be previewed while the project is being played. They are always played in
time with the song. This means that if you combine loops from different Soundpools that
have a different tempo they will automatically be adjusted to the current project tempo
even in the preview.

You can compose a song in realtime by loading different samples and searching for
suitable new building blocks during playback.

Start the playback and select a loop by simply clicking the mouse. The loop will be used
as a preview on the next available track and played back together with the pre-existing
audio material. Update the preview by selecting another loop. You can then try out the all
of the soundpool samples in the context.

As a preview, the loop will always be extended to the entire length of the playback range.
The result is therefore immediately audible, even if the loop is originally shorter than the
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selected playback range. If you adopt the loop in the project, it will be introduced in its
original length at the beginning of the playback range.

Tip: You can also use key commands to quickly change the playback area (742) by
using the arrow keys. This will let you add loops to your project with more precision.

Load loops

Simply clicking on a loop starts the preview. Clicking on the numbers 1 to 7 beside "Pitch"
changes the pitch. The pitch for that loop is set when you click on a different loop.

Load the loop you've selected using the arrow. You can also double click or drag
the loop into the project.

High quality loops

Soundpools are downloaded and installed in .ogg format by default. In the settings menu
(gear icon) under Soundpool format, you can change these settings from Normal quality
(ogg) to Best quality (wav). The Soundpools must then be re-downloaded from the
Store.

. The quickest way to find these downloads is to switch the filter in the Store from ALL to
UPDATES.

Song Maker

With the help of the Song Maker, you can automatically arrange loops using Soundpools
for complete songs or song parts without having to drag them individually from the
Media Pool into the corresponding tracks. Considering the relatively random selection of
loops that are combined you shouldn't expect the Song Maker to produce a chart-
topping hit, but it can be very helpful as a basis for making your own adjustments and
additions to create a cool arrangement.

Using this symbol or the W key, you can open the Song Maker window.

oM ENEN
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o Select a genre template (style). The templates contain information about the various
song parts and pitch sequences. In the Length column, the length of the generated
song is displayed, when all the song's parts are used, see 4. In the BPM column, the
tempo of the templates is shown.

a Select one or several Soundpools you want to use for the song.

Tip: The Song Maker works best if you use a Soundpool matching a template.

Additionally, once a template has been selected, the original tempo of the
Soundpools is no longer displayed in the BPM column, but rather how many beats
per minute the tempo of the Soundpools differs from the tempo of the selected
template. The smaller the deviation is, the better the Soundpool will work with a
template and the result will sound. The greater this deviation, the more the samples
used have to be stretched to match the tempo.
Click this button to sort the deviation in tempo between Soundpools in
ascending or again for descending order. Then, the Soundpools that are least suited
will be at the top of the list.

9 By default, all instruments contained in a Soundpool are used.
Individual instruments can be deactivated by clicking them. If, for example, you only
want a rhythm section with drums and bass, deactivate the other instruments with a
mouse-click. Individual instruments can be deactivated by clicking them. If, for
example, you only want a rhythm section with drums and bass, deactivate the other
instruments with a mouse-click.
If multiple Soundpools contain the corresponding instrument category, you can
deselect the instruments individually.
Use this button to select or deselect all instruments.

n There are more options in the menu of an instrument:

o Freeze: If you have created a song with Songmaker and you are happy with a
particular instrument, you can "freeze" it. If you now click on Create Song
again, this instrument will be retained for the new song.

This also lets you create a song in Song Maker step by step: Start with a few
instruments, for example bass and drums, and click Create Song until you like
these instruments. Then freeze it, add an instrument, and repeat the process
until the arrangement is complete.

o Deselect sound pools: If you have selected several sound pools, you can
specify here within an instrument that certain instruments should only be used
from certain sound pools.
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@ Select the song part or parts that you want to create. The parts differ in their
harmonic structure and instrument density, for example verses have fewer
instruments than refrains, while there are accompaniment variations between the
1st and 2nd verses as well as in the refrains.

The pitch sequence in the verses and refrains remain the same. If you activate all
parts, Song Maker creates a complete song, for example, for the pop genre in the
typical structure of a classic pop song: Intro - verse - chorus - verse - chorus - bridge
(instrumental or solo) - chorus - outro. This structure and also the names of a song's
parts vary from genre to genre.

In the simple version of Song Maker, as included in Music Maker free, the
instruments/song parts cannot be deselected.

6 Click Create song. Now, the Song Maker will fill the project according to your
specifications with suitable loops from the selected Soundpool. If you don't like the
results, you can repeat the process.

E Options: The Intelligent Song Creation prevents certain "unattractive"
combinations of loops and can be activated here if you are looking for adventure :)

Note: Song Maker will completely overwrite the existing project. If you open Song Maker
in a project that already contains audio material, there will be a security question asking
if want you to save this project.

File Browser

If you would like to load any other audio files into your project in addition to the loops
from the Soundpools, you need to use the File manager.

L . . . .
Using this symbol or the F key, you can open the File manager window.

The file manager works in a very similar way to Windows Explorer.
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G/ _audio

o You can access the File manager through the tab at the top.
9 My computer: Displays the top level of the file system for controlling all drives.

9 My music displays the music folder. The Music folder under My files is preset here,
but you can select one of your own folders through the program settings (7213).

Q Use the arrows to open and close folders.

6 All supported media files and subfolders of the currently selected folder are
displayed in the file list. All entries can be loaded into the arranger tracks by double
clicking or via drag & drop.

Double-click on a folder to switch to it. This folder will become the new starting
point for the tree structure.

@ Move up one level.
9 The file path of the displayed folder.

Audio recording

Songs, noises or instruments can be easily recorded in MAGIX MusIC MAKER using the
audio recording function.

I Click the REC button in the track header to specify the track for the recording.
The display in the track header will change AuBIOREG
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The input signal will be played back featuring all track effects (if there are any) (live
monitoring (734)).

Live monitoring requires the use of ASIO drivers (7211).

Click the red button on the transport bar to start the actual recording. Click
on the gear icon next to it to open the dialog box "Audio recording" (733)
with various settings options. This dialog box can also be opened after
starting the recording.

Adjusting the signal level

Adjusting the signal level to the sound card is also recommend to get the best sound
quality when recording digitally.

Once a recording source is connected to the sound card, the small gear wheel button
next to the Record button opens the recording dialog and starts the recording source.
You can now adjust the recording level with the help of the LED display in the record
dialog.

If the adjustment is set too high, distortion occurs and the incoming signal must be
reduced. If you have linked the sound source directly with the sound card without a
mixer, this can only be done via the Windows system settings "Sound". You can access
this directly from within the recording dialog via the “Recording level” button. You will
see which sound card input is already being used with the amplitude in the small peak
meter in the settings dialog. Double-click on this and change in the tab "Level",

If you reduce input sensitivity by using the input fader, the resolution at which the analog
signal is digitized is also reduced. Try to set these automatic controllers to the loudest
sound level possible! The loudest part of the material is the yardstick for an optimal level.
The loudest part should be adjusted to the maximum.

Note: Not all sound card drives fully support the Windows system mixer; this
functionality can also potentially fail. Some sound cards also come with its own mixer
application in which you can control the input level. If both fail, you need to match the
level to the analog source.
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Audio recording dialog

Audioaufnahme
Audioeingang:
ASIO 2.0-ESIU46(1+2) v
Audiodatei speichern als:
New - 0001.wav
Speicherort:
€ ic Maker 2016 Live\Recordings 0
Aufnahmequalitat:
(D Audio v Zurucksetzen
Mono @) Stereo
Aussteuerung...
44.1 kHz, Stereo,
172.3 KByte/s
¥ Mithoren T Erweitert.. |
Aufnahmeinformationen
Aufnahmezeit: 00:00:00:00
Aufnahmekapazitat: C: 06:34:12:16
( oK | Abbrechen

Audio Input: Selects the sound card for the recording.

Save audio file as/storage location: Here you can select the title of the audio file you
wish to record. You can also select the folder where you wish to store the file.

Recording quality: Sets the sound quality of the recording. In the preset menu you can
choose between AM Tuner, FM Radio, CD Audio, and DAT (Digital Audio Tape).

Mono/Stereo: The recording can be made in mono or stereo. Mono recordings are
recommended for song and instrument recordings made using only one standard mono
microphone. This reduces the required memory space in half.

Peak control: This opens the Windows system dialog for the selected sound card drivers.
There you can customize the input level and deactivate the system monitoring.

Level indicator (L/R): Use the level indicator (peak meter) to monitor the strength of the
input signal. Please read more on this in the section 'Adjusting levels'.

Direct monitoring: Select this option to switch the live monitoring on and off. Please
read more on this in the section Listening to the input signal - monitoring

Advanced: Use this button to open a window containing a selection of three special
functions.

« Mono recording: This can be activated to record in mono. This reduces the
required memory space in half. Mono recordings are recommended for voice
recordings made using only one standard mono microphone.
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o Real-time sample rate adjustment: Automatically matches the sample rate of a
new file to be recorded with the sample rate of the current movie's sound track (set
in the video recording).

« Ducking (reducing the sound volume): To add narration or other sound material to
a video that already has sound volume levels set, activate the option "Automatic
reduction of sound volume of remaining audio tracks”. This automatically reduces
the volume of audio objects in the project during the recording session ("ducking”).
This is achieved using an automatically configured volume curve: Before and after
the recording other tracks will be faded in and out, resulting in a homogeneous total
volume level. (Lowering of volume level during spoken comments is also called
"Ducking".)

Listening to the input signal - monitoring

You usually want to listen when you record something. This is called monitoring. There
are different options for monitoring available in MAGIX MusIC MAKER.

Live monitoring

This is the preset method and allows you to listen to the input signal with MAGIX Music
MAKER audio processing, that is, with all effects including the track effects as well as the
AUX send effects and master effects.

You can therefore hear your vocals or guitar recordings with the necessary effects while
recording or jam live to a finished project.

An ASIO driver is needed for monitoring. Professional sound cards come with these
drivers. For any sound cards that don't have drivers, the MAGIX Low Latency driver is
included, which provides any sound card or on-board sound chip fitted with WDM
drivers with an ASIO driver.

For more information, see the menu File > Settings Program settings > Audio/MIDI
(7211).

There will be a short delay (latency) caused by processing the audio signal. This delay
amounts to just a few milliseconds with modern sound cards, but you can deactivate this
option if you prefer. To do this, uncheck the Monitoring box in the recording settings
dialog.

System monitoring

You may already hear your input signal or two input signals with live monitoring before
you have activated the track for recording. This is because the line-in input is configured
so that its signal is directly routed to the output. This is a feature of the Windows
operating system, not of MAGIX MusiC MAKER. The purpose of this is to allow you to
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connect external audio sources, such as MP3 players, via the input and listen directly
through the computer speakers.

To disable this unwanted "monitoring”, click on "Peak control" in the "Audio recording"
dialog box, double-click on the input used (visible on the peak meter amplitude), and in
the settings dialog that appears, go to the "Listen" tab. Here, you can deactivate the
option "Listen to this device".

3

Wiedergabe Aufnahme  Sounds  Kommurikation

Wahlen Sie ein Aufnahmegerat aus, um die Einstellungen zu andern:

g, e .

Mikrofon -
Realiek Hior| & Eigenschaften von Mikrofon X

fingang | Algemein ABhiren Pegdl  Erweitert
Realtek High

Uber diese Mikrofon-Buchse kénnen Sie den Inhalt eines tragbaren
Musikwiedergabegerits oder anderen Gerats wisdergeben, Wenn
Sie ein Mikrofon anschlieBen, sind moglicherweise
Feedbackaerdusche zu héren.

i >

[Dmeses Gerat als Wiedergabequelle verwenden ]

Wiedergabe von diesem Gerdt:
Standard-Wiedergabegert v
Energieverwal itung
(®) Bei Batteriebetrieb weiterhin ausfihren
() Automatisch deaktivieren, um Energie zu sparen

On the other hand, you can also use this type of monitoring if the live monitoring is not
suitable because the ASIO driver is not functioning in a stable way. Or if you don't want
to use the live monitoring because you find even a small amount of latency annoying.
However, this means you cannot listen to audio along with MAGIX MusIC MAKER effects.

Note: Not all sound card drives fully support the Windows system mixer; this
functionality can also potentially fail. Some sound cards also come with their own mixer
that offers monitoring.

External monitoring with a mixer

You can also monitor independently of the computer by using an external mixer. Small
mixers with a USB connection that are both mixers and sound cards are suitable for this.
The same applies for system monitoring (no latency but also no effects). But it offers an
advantage in that you have direct access to the input level and monitoring level in the
mixer. The external mixer also enables you to use the in-program live monitoring. Be
careful not to create any feedback loops i.e. a repeat recording of the output signal when
using the external mixer for live monitoring.
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Record audio output

You can record the complete audio output of MAGIX Music MAKER directly into a WAV
file. This can be done using the "Write realtime audio to WAV file" option, which can be
found in the Program settings dialog (Via "File > Settings > Program settings" or the p
key) in the "Audio/MIDI" tab.

If this option is activated, with the next start the complete playback of the project will be
recorded live. With the next stop you can save your recording and load it for immediate
editing in the project. Use different names to save your single sessions, ensuring that no
recording will be mistakenly erased.

Import audio CDs

To import tracks from CDs, open the CD import dialog. In the CD import dialog box you
can select tracks from audio CDs and partially or fully import them into the project. The
data is imported digitally which eliminates any loss in sound quality. The CD tracks are
imported into the project as wave files. The files are saved in the import folder.

Insert an Audio CD into the drive and select Import Audio CD track(s) from the File
menu. A dialog with a list of the CD tracks will open.

If you have more than one drive, you may have to first select the drive containing the CD.
To do this, use the menu option CD Drive options... (see below).

LI track list
Jugke |Ssarcieme |Lengsh:  |Type  [Copy JResdstan |Resdesd | Geooed Do
o1 D0:00:=00 04:45:17 Awdic Yes Totsl thme: d:45
1 044517 053815 Ausdie Yes Requined memory: 48 MB

Select all iracks

Save peleched track..

Db - SeCior pyncheon. -

(D Dwive opticm:

Cote [

On the left-hand side in the list you can choose which track(s)/title(s) you wish to import
from the CD. Several subsequent tracks can also be selected by holding the "Shift" key +
mouse clicking; "Ctrl + mouse-click" selects several individual tracks. By clicking on Select
all tracks, all audio tracks will be selected, e.g. for copying the complete CD.
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Now click on Save selected tracks.... This will open the Save audio to... dialog, where you
can specify the name and target address of the audio files. The audio files are
subsequently numbered depending on their names (name -> name_1.wav, name_
1.wav...). Save starts the audio copying process. A progress bar is displayed. Once ripping
is complete, the dialog will be closed and the tracks are inserted into the project as
individual objects.

In the top right field, details on the total length and the memory capacity of the selected
track/section are displayed.

Transport control: This lets you start and stop
playback just like on a real CD player and skip
forward and backward in the playlist.

Track: 1 00:00

(> |m|m[w ][]

D With the faders below it you can go to a specific
- ° position in a track. To import just a specific section of
| Resdsmen | JI Resdend | 5 CD track, choose Start selection at the beginning
Volume: T of the section and End selection at the end.

Use the small Volume faders to control the preview volume. The chosen drive appears
below it. In the selection box you can select the read speed.

Copy-protected audio CDs

According to the copyright act it is forbidden to copy a CD with copy protection.
However, an owner of a CD may create a backup copy for themselves. The problem with
copy-protected CDs is that they cannot be imported using conventional PC drives. In
order to create a backup of such a copy-protected CD you have to play it on an audio CD
player and record it as a regular analog recording via the sound card.

Keyboard shortcut: C
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Arranging Projects

This chapter covers about how to edit your loops and samples in the Arranger.

Arranger with tracks

The arranger is organized into tracks. Each track corresponds to a mixer channel (751).
You can use this channel to control volume, place panorama, apply effects, mute or solo
all of the objects in the track. The loops of the same instrument are typically grouped
together on one track (bass track, vocal track, etc.) which makes it easier to edit them.
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Additional tracks can be added at any time using the button at the bottom of the
arranger or by selecting the Add new track option in Edit menu (Ctrl + I).

The context menu for a track header also includes the option Add track - if you select

this, however, the track will be added directly underneath the track that you have clicked,

not further below in the section. The context menu also contains an option for deleting a

track. To move a track, select Move track up/down.

At the beginning of each track there is a track header with controls and displays.
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o Instrument icon: When you drag & drop a MAGIX Soundpool sample onto an empty
track an icon will appear in the track header. You can replace this icon by right-
clicking on it and selecting a different one. A left-click on the icon opens the menu
for the track synthesizer (see below).

a A peak meter and a volume fader can be found beside the icons. These let you
control the volume of the track. For easier and more precise mixing of tracks, use the
mixer (751).

9 Track name: You can rename the track by double-clicking on the field.

@ You can use the Mute button to shut off the sound of a track or the Solo button to
play only the sound from one particular track. The Solo function is not exclusive,
meaning you can use it to play back the sound from several tracks. On the lower
border of the arranger, underneath the track headers you will find the buttons Reset
Solo/Mute which you can use to restore the previous solo and mute settings of all
tracks with one click.

6 Left-clicking on the field with the instrument icon opens a menu with the
sounds from the included software synthesizer which can be loaded to the
track. This software instrument will then be used by all MIDI objects in the
track. You can find out more about this in the chapters Software Synthesizers
(©»58) and MIDI objects (776).

The track header of a track with a loaded synthesizer has a few additional
controls. With the arrows (1) you can switch back and forth from the
previous to the next sound in the software instrument and the gear icon (2)
opens the instrument editor.

@ B8 Here you can open the Track Effects menu. In it you will find presets for track
effects sorted according to the instrument type.
A lit FX button indicates that the track effects are active.

9 I \Vith REC you can activate the track for an audio or MIDI recording.

AUBISRES. Simply click to switch the track to audio recording mode. This also activates
monitoring, which means you can hear the input signal of your sound card
during playback. Find out more in the section Listening to the input signal -
monitoring (734). If you start recording now (R key), the audio recording (731)
will start. The recorded audio material is added to this track in the playback
range (741).

LGN Clicking this button again puts the track into MIDI recording mode. If a
software instrument is loaded, you can play it with a connected MIDI keyboard
(Monitoring). If you start recording now, a new MIDI object will be created in
the track and MIDI recording (783) will begin.
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If the tracks in the arranger are not long enough, you can increase their length by
pressing the minus button (-) to the right. The size of the project adapts itself
automatically when objects exceed the space for them on the right-hand side or when
new objects are loaded.

Clicking and dragging on the bottom border of a track header allows you to adjust the
height of the display. Use the tab key to easily resize the tracks to their maximum or
minimum height.

Transport control (playback functions)

The transport bar's functions enable you to control the playback behavior of the project
using the mouse.

2 4 m p O n

~ Tip: Use the space bar to start and stop playback more easily.

Looped playback can be deactivated here. Playback will always stop when the
end marker is reached.

Back to start: With this button the start marker is quickly moved to the beginning
of the arrangement. Another click on "Back to start" moves the start marker and
the playback range to the beginning of the project.

Stop: The "Stop" button ends playback. The playback marker returns to the
position from which it started.

Play/Pause: This button starts continuous playback of the project. If the playback
marker reaches the end marker, the range between the start and end marker will
be played back as a loop. Another click on Play stops it at the current position of
the playback marker (Pause).

Record: Depending on the settings in the track header (738) an audio (731) or
MIDI recording (783) will be started.

With the gear icon next to it you can open the dialog for recording audio (733)
with additional settings options.

Time display

4 The time display is beside the transport console.

9921:01:000 3% e Xe
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o This is where the current playback position is displayed. By right-clicking it is also
possible to switch the time display to show the remaining time (relative to the end of
the project) or to choose various units of measurement, e.g. hh:mm:ss or frames.

9 With the position slider you can quickly move the playback marker within the visible
range.

6 The current pitch is displayed at the top and below it the project tempo in BPM
(beats per minute). The tempo is determined by the first sample used in the project.
To enter a new tempo, click on the number and enter a BPM value in the field. The
objects in the arrangement are adapted using time stretching.

Q Time Signature: Here there are various time signatures such as 3/4-,4/4- or 5/4
which can be selected for the project.

6 Click on BPM to open the Tap Tempo dialog where you can set the tempo by
"tapping" it out. Click out the tempo you want using the tap button, or press the T
key. The tempo is measured and displayed in the dialog. Apply the tempo by clicking
on "OK".

@ Metronome: This button activates a click track that is played back during recording.
This helps with maintaining the right beat and tempo when recording instruments or
vocals.

Volume control

The volume control is to the left of the transport controller. With it, you can quickly
control the overall volume of your project. To regulate the volume of individual tracks,
use the mixer (751).

Clicking on the speaker icon mutes the entire sound output.

Under the volume control there is a peak meter that displays the master signal peak level
and an indicator for incoming MIDI signals.

Bar ruler

A timeline is located at the upper edge of the arranger. It is used to determine the
playback range or set the playback position.

Playback area - Start and end markers

In the upper area of the timeline, there are two markers between which the playback
area is displayed.
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The playback range displays the length. The number before the period indicates the
number of bars, the number after the number of quarter notes. A tilde (~) in the indicator
means that the playback range does not have the exact pattern length and the loop is
therefore "non-circular". Double-click on the playback range to expand it to the whole
project.

This playback range is also the basis for the commands in the menu under Edit >
Range (7199) (Copy, Cut, Paste...).

To reposition the start marker left-click the upper half of the timeline. To set the end
marker. You can also drag each of the markers to the desired position with the mouse.

Move playback range with the keyboard

You can move the playback range also with the keyboard. Alt + cursor keys shift the
playback range by one full length forwards or backwards. Also press "Ctrl" to shift the
playback area a quarter of its length. With "Shift + Alt + cursor keys" you can halve or
double the length of the playback range. With "Ctrl + Shift + Alt + cursor keys" you can
extend or shorten the playback range by a beat. Use this function to the give the
playback area a smooth beat length (multiples of 2).

Note: If you deactivate the option "Cursor keys move playback marker" (7208) in the
"View" menu > "Arranger”, you do not have to press the Alt key. However, it is necessary
in order to move the playback marker with the cursor keys.

When you move the playback area while a playback is running, the old area is always
played to the end and smoothly changed into the new one after. In this way you can
remix your tracks in real-time with the keyboard!

Set playback marker

The playback marker can be moved independent of the start marker. Just click on the
lower portion of the timeline. Once the playback marker reaches the end marker,
playback will recommence at the position of the start marker. If the playback marker has
been set to the right, outside of the area, the project will be played to the end. The
stretched out playback range will then be played as a loop.

Use the cursor keys to move the playback marker with the keyboard. The option Cursor
keys move playback marker in the View menu > Arranger is preset as active. If you
deactivate this option, you can move the playback marker with Alt + cursor keys and only
require the cursor keys to turn down the playback range.

42 /216



Arranging Projects

Grid
At top of the toolbar there is a field for entering the grid step size.

The grid ensures that the objects and the start, end & play markers only snap into place at
specific positions so they can be positioned precisely according to the beat. When an
object or marker is close enough to a grid snap point, it automatically jumps or "snaps" to
this position. For example, if the grid has been set to "1/2 Note", the objects and markers
will snap into position when they are close enough to a half beat position (1:1, 1:3, 2:1,
2:3 on the bar ruler).

- Note: "Close enough" refers to the screen display, so the distance of the object from the
desired position in screen pixels. If you have zoomed in to just a few bars, but have the
grid set rather coarse (e.g. 1/2 notes), it is possible that objects can be moved to positions
between grid positions.

This way, there won't be any gaps between the objects and beat-matched cuts are made
possible. The selection ranges from full beats to 1/64 notes. Triplet values are also
possible. The setting "Frames" is important for videos and allows objects to snap to single
frames in video files.

In addition to the beat grid, two consecutive objects will seamlessly snap together. This
avoids undesired gaps or overlaps. This also works if they are located in different tracks.

Only objects deactivates the beat grid and the grid will now only affect the object edges.

You can also deactivate the grid entirely by selecting No Grid or pressing the shortcut
Ctrl + F12.

Pitch bar

A pitch bar can be found below the timeline.

When a Soundpool sample is moved to an empty section of the project, the
corresponding key will be displayed in the pitch bar.

The pitch bar can help make sure that the same pitch is always used in order to prevent
disharmonious sound combinations when adding more loops.
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When the "wrong" pitch is moved into a pitch range, you will be asked if the pitch should
be automatically adjusted. If you select Do not show this message again, your choice will
mean that the program will either automatically make adjustments every time from this
point on or it will not make any adjustments.

This setting can be changed via the menu under File > Settings > Automatic pitch
adjustment.

If several pitches are used within the same duration, several chords will be displayed in
the pitch bar.

| F * | Clicking on the small arrow on a pitch opens a menu where you can
set the same pitch for all the loops of this duration in the project.

In the "Advanced" submenu, you can find the full offering of major |
and minor chords. A pitch is pitch shifted (7118) to achieve the
chord.

You can also divide a pitch range in order to assign a different
chord to a single part. To do this, switch to the split mouse mode
(748) and click on the desired point in the pitch bar.

Clicking on a pitch opens a menu where you can load a preset song
template. Some of these templates are typical chord progressions that can
help you put loops together to form song parts. Others are complete song
structures with entire song sections (e.g. verse, chorus etc.) that are
defined by your chord progressions.

You can hide the pitch bar by going to View > Arranger.

Zooming

l The vertical zoom function sets the number of
visible tracks. On many tracks zooming is useful
i for selectively editing a track or an object in full
view.

Use the horizontal zoom functions to set up the visible section of the project on the
timeline. Clicking and dragging on the bottom border of a track header allows you to
adjust the height of the display.
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Zoom buttons

Zoom menu: Certain zoom levels may be selected by right clicking the horizontal
scroll bar or by clicking the zoom menu. You can also jump to certain positions in
the project here.

B Enlarge objects: Vertical and horizontal zoom levels are increased so that all of
the selected objects are displayed at maximum size. When the function is turned
off, the zoom level reverts to its previous value.

> Optimize view

BB  Zoom buttons Buttons for zooming in and out.

Move/Zoom with the scroll bar

The horizontal scroll bar can be dragged apart and pushed together at the edges in order
to quickly zoom in and out of the timeline. Dragging the middle of the scroll bar moves
the visible section. The vertical scroll bars control the tracks shown.

You can tell which part of the project is being displayed by the size and position of the
scroll bar. If the entire project is displayed, then the scroll bar will fill out the progress bar.
Complete view may be set by double clicking the scroll bar.

However, a track cannot be reduced in size completely. The number of maximum
displayable tracks is also limited, meaning not all tracks may be able to be viewed at once.

Move/Zoom with the mouse wheel

The visible section can be moved, reduced, and increased in size by using the mouse
wheel.

Displayed tracks Mouse wheel

Number of displayed tracks, increase/decrease track Ctrl + Mouse wheel

height

Moving a visible section Shift + Mouse wheel

Enlarge or reduce the visible section (Zoom) Ctrl + Shift + Mouse
wheel

Menu View > Arranger > Horizontal scrolling interchanges the horizontal and vertical
functions of the mouse wheel. This means you can use Shift and Ctrl+Key for zooming
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and scrolling the tracks instead of for the visible duration. This is the similar to the mouse
wheel behavior of older MAGIX MusiC MAKER editions.

(]
Objects
The audio files loaded to the arranger are displayed there as objects.

All object edits are virtual, that means they may be calculated in real time. The
multimedia material is not changed (virtual editing) Each modification can be undone by
pressing the "Undo" button (Ctrl + Z). You can play around with having to worry about
changing or ruining the original material.

Selecting objects

To edit or delete objects, you must first select them. Click on the object. To select
multiple related objects, click the first object and, while holding down the Shift key, click
the last object. To add individual objects to a selection, click on them while holding down
the Ctrl key.

To visually highlight the current selection, the object handles of the selected objects are

displayed.
Birbr s,

Several objects can be selected quickly by clicking on the first object in the first track
with the mouse and dragging out a square for selection. All objects entirely or partially
within the square will be selected with the (Lasso selection).

Shorten or loop objects

Objects can be shortened by dragging the lower right corner to the left. An object can be
shortened from the start in the same way, e.g. if too much silence was recorded before
the actual audio began.

To extend the object, drag the object border outwards. If you drag the object beyond its
original length, it will play in a loop (i.e. repeat). In this way you can create a complete
drum track from a short drum loop, for example.

Normally an object is always looped over the full length of the underlying audio material.
To set a clip from a file as a loop, drag the object inwards at the front and the back with
the handles to shorten it and choose the menu option Edit > Object > Loop range > Insert
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~ user-defined loop. This function is very useful for using one of your own recordings as a
loop, as the silence at the beginning of a recording can be cut out.

Fading in or out objects

An object can be faded in or out with the handles to the left and right upper corners of
the object. The length of the fade can be adjusted with the handles.

If an object on a track is moved to a position where it overlaps with another object, the
length of the overlap will automatically become a crossfade. This means that the first
object is faded out while the subsequent object is faded in simultaneously. The duration
of the fade-out is equal to the duration of the fade-in but can be adjusted using the upper
handles.

b Action Bajss B6_ogg 0.. |k ActionBass A&

Crossfade

Setting object volume

Using the volume handle located centrally at the top of the object, you can adjust the
volume of audio or MIDI objects.

It's easier to adjust the overall volume of a track or the volume levels between tracks in
the mixer (751).

Mute objects

Each object can be muted individually. Simply select the objects you want to mute and
press the shortcut Ctrl + M (or use the corresponding command from the context menu).

Splitting objects

All objects can be split. You can create two new independent objects in this way. To do
this select the object and move the playback marker to the position where you want to
cut by clicking on the timeline.

(8 Click on this button in the upper toolbar (7213)or click on Edit > Object and select
the option Split objects or press the T key. This is even easier with the mouse
mode Split objects (750).
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The two new objects maintain all the object effects (7108). For example, you can then
design a loop in a more varied manner by first overlaying an object as a whole with an
effect before cutting it into several parts and then varying the effect parameters in the
individual parts.

Duplicate objects

To duplicate objects select the object(s) and then select Edit > Object > Duplicate
objects (Ctrl + D). A copy of the object appears right beside the original which can be
moved to any position with the mouse.

Tip: Speed up this process by clicking on the object to be copied with the mouse while
holding down the Ctrl key. This generates a copy, which you can immediately drag to the
desired position.

Another way to duplicate is by using the copy/edit commands from the menu Edit (7196)
> Object or Section. For the latter, all objects in the playback range (74 1) will be copied.

Form or split object groups

Several objects can be grouped together to avoid the objects being accidentally moved
away from other. To create a group, select the respective objects and the command Edit
> Object > Group > Form group (Keyboard shortcut: Ctrl + G).

Once they are combined, clicking on one object of a group will select the entire group,
allowing you to move, copy, or delete the group as a whole. To ungroup objects, use the
corresponding command in the Edit menu or the keyboard shortcut Ctrl + U.

Mouse modes

MAGIX Music MAKER offers special mouse modes for arranging and editing objects.
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A small arrow next to the mouse pointer symbol allows different
modes to be set. You may assign a function to the left mouse
button. The right mouse button always opens a context menu
ST e el that opens a menu with related operations for the object which
was clicked.

I‘.'
".

Maove Ctrl+1

" Draw Ctrl+3
% Split Ctrl+4
Stretch Ctrl+5

Preview Ctrl+6

<~ Replace Ctrl+7

Move

n This is the default, standard mouse mode that can be used to select, move and edit
objects.

You can read more about this in the section Arranging objects (746).

If an Automation curve (#182) is active, the curve handles can also be selected and
moved in this mode. Double-clicking on the curve creates new handles.

Keyboard shortcut: Ctrl + 1, number key 1

Automation

Bl This mouse mode is used for drawing the volume and effect curves (7182).

When active, a new curve can be drawn on an object or track using the left mouse
button.

Activate the corresponding effects curve in the "Effects" menu in the track header
to enable track automation.

For the object, use the "Automation of this object" command form the "Effects >
Automation" menu (keyboard shortcut: Ctrl + H) and select the corresponding curve in
the dialog. Clicking on an object without an activated effects curve activates the volume
object curve for this object.

Note: In this mode, the object curves will always be edited, even if a track curve is also
displayed. If you would like to edit the track curve at this position, then you will need to
temporarily move the object somewhere else.

Individual automation points on a curve may also be created in the normal "Move" mouse
mode (see above) by double-clicking the corresponding curve.
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For more information about automation curves, please read the chapter Automation
curves (7182).

Keyboard shortcut: Ctrl + 2, number key 2

Draw

In this mode you can insert further similar objects behind an already loaded object.

Starting from the first object, the following objects are always inserted synchronously.
This means: The drawn-in loop is not played from the beginning, but rather starts from
the position where the original loop would be, if you had continued playback to this
position. Or, put differently: A running loop can be found on the track and you can draw
in at which position you can hear it ("Mute automation").

The synchronous start of the object in the mode has another consequence: When an
object is moved only object borders are moved, the underlying loop, however, always
remains intact.

Keyboard shortcut: Ctrl + 3, number key 3

Split

E You can split objects quickly in the mouse mode in order to, for instance, remove
unwanted parts or attach various effects to parts of an object.

Click the object to separate it at the corresponding position.

After splitting, the rear, newly created object is selected, which you may now delete
directly with the Del key or open the object effects window with the O key to apply an
effect to it.

Keyboard shortcut: Ctrl + 4, number key 4

Stretch

n This special mode is for customizing the length and pitch of objects.

Objects can be on the lower handles stretched or compressed with this tool. Audio

material is then lengthened via time stretching without changing the pitch itself The
middle object handles allow the object's pitch to be changed using pitchshifting in a
halftone range of -7 to +7.

Keyboard shortcut: Ctrl + 5, number key 5
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Preview

ﬂ In this mode you can individually preview audio objects in the project. Click on a
audio object and it will be played back alone for the entire duration and independent
of the start and end markers in the timeline for as long as the mouse button is held.

The objects are protected against inadvertent moving in this mode.

Keyboard shortcut: Ctrl + 6, number key 6

Replace

E This mouse mode simplifies searching for suitable samples: Left-click on an object
from MAGIX' Soundpools replaces the

object automatically with another from the same instrument category. Shift + left mouse
click keeps the object but changes the pitch. Ideal for quick experimentation!

Keyboard shortcut: Ctrl + 7, number key 7

Mixer

With the mixer you can adjust the volume and position of the entire sound in panorama.
You can mute or unmute individual tracks and can apply effects using the track effects.

The mixer can be opened by clicking on this button or pressing the M key.

———
Master

Mastering Sulte

FX

Surmound 5.1
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Slider

Each track in the project corresponds to a particular volume fader in the mixer,
which controls the volume of the track.

percussions

The stereo position for each track can be defined with the pan pot. The S
(solo) button sets the track to solo. This means that all other tracks are
muted, except for the tracks that are also set to solo. The M (mute) button
mutes the active track.

Right-clicking on any of the controls resets it to its default setting. Another right click sets
the previous value again.

With the REC button you can activate audio (#31) or MIDI (783) recording for
this track, as well as monitoring (734).

Track effects

Besides the object audio effects, a separate track effects rack can be used.

FX You can open the track audio effects rack with the FX button in the mixer. A
brightly colored FX track button signifies that effects are active in the track.

"™ You can also open the track effects rack by going to the
track effects menu in the Arranger track header (738).

Track effects always apply to the entire audio output of a track. They are used when
software synthesizers (758) serve as audio source, instead of audio objects.

Note: The Vocal Tune, Tempo-Pitch/Resample and Vocoder effects cannot be used as
track effects!

FX tracks

Use the FX send control to define how much signal you want to be
> B sent to the two available FX tracks.

Sends

An FX track is a additional mixer track which provides a dedicated track effect window
foruseasa.
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Insert effects and send effects

A normal track effect, also called an insert effect, is inserted directly into the signal path
of the track. It fully replaces the audio signal with its effect output.

For this reason, reverb and echo have a mix controller for leaving part of the signal
unprocessed when used as an insert effect, because you don't want a 100% "wet" signal
for reverb and echo. For a phaser or an amp simulation, however, you do.

With the send effect, the signal is processed on a separate track. Its output therefore can
be heard in addition to the track's signal. The signal from several tracks can also be
processed simultaneously.

This means that you should in particular use the echo and reverb effects as send effects
when the mix setting is set to 100%. You control the effect amount for each track via its
FX send control, and the overall volume of the effect via the FX track's volume slider.

In the FX track, you can use M (mute) to mute the FX track completely, just as with
normal tracks. Click S (solo) to listen to the FX track by itself. The other tracks will be
muted. The tracks that send to the FX tracks continue to do so, otherwise nothing would
be heard on the FX track.

In the first FX track, the reverb feature is activated by default, since it is the most
essential way of using send effects.

Master track

In the master track you can control the total volume of the mix.

The FX button works exactly like it does in the tracks and opens the panel for the master
effects.

Mastering: Opens the MAGIX Mastering Suite (7127).
5.1 Surround: This button switches the mixer to Surround Mode (7177).

These two buttons are only visible if the corresponding functions have been activated.

Change the playback tempo or pitch

If you want to combine audio material you have recorded yourself from different sources,
samples from Soundpools, or songs from CD with each other, then you will often need to
adjust the tempo or pitch of audio objects to match each other. To do this, you can use
an function that automatically adjusts the tempo of audio objects to the project's tempo
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when they are loaded to the project, plus advanced tools such as Remix Agent (7166)
and the time processor (7118).

Automatic tempo adjustment when loading objects

In general, MAGIX MusiCc MAKER automatically adjusts audio files to the project tempo.
Basically, you won't need to worry about the different tempos of audio files and
Soundpool samples, since these are automatically matched. But since automatic
processes can fail too, the following process explains when you may need to "manually”
adjust things.

In the new project (empty), the tempo will be determined by the first samples loaded into
it. All additional audio files will then be automatically adjusted to this tempo. If you are
planning a remix which is composed of different samples with different tempos, then try
to add the most important sample first. This minimizes sound distortions compared to the
other samples via timestretching.

In order to be able to correctly adjust an audio object to the tempo, its output tempo
must first be detected. If the sound is a Soundpool sample, then the tempo saved in it
("patched") will be used, and the tempo adjustment will always work.

For all other (short) samples, an attempt will be made to automatically calculate the
tempo. If the sample is not cut exactly, i.e. it does not contain an exact number of beats
or is incorrectly interpreted by the automatic detection process, then this may not work.
The sample will then be incorrectly stretched. In this case you can try to manually adjust
the sample.

The Remix Agent (7166) launches optionally for longer samples ( > 15 seconds), e.g.
entire songs from CD or MP3s. This also gives you the option of either adjusting the
sample to match the project or the project to the sample.

MIDI objects always have the correct tempo because they are aligned with the project
tempo.

In the dialog Program settings (7210) > Import (p key) you can deactivate the automatic
tempo adjustment or limit it to patched samples.

Changing the tempo or pitch of individual objects manually

You can change the pitch and the tempo of selected audio objects. You can access these
tools via the effects menu or the object effects rack.

The playback tempo can be quickly changed via the stretch mouse mode, i.e. by
compressing/stretching the audio object's lower handles -this will change playback
speed for the object.
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For example, to fit a "non-circular" loop with the stretch mouse mode (750) in a current
project, proceed as follows:

1. Load the sample. MAGIX Music MAKER will attempt to fit it into an even number or
bars. Set the appropriate track to solo and place the playback range exactly above
the sample.

2. Select it and click on "Enlarge Object" at the bottom left of the arranger window. B
The object will be displayed at the maximum size.

3. Turn off the grid (in the list field at the top right of the arranger or use the shortcut
Ctrl+F12)

4. Now start playback and move the end marker of the playback range to the right
until the loop runs smoothly. You can rely on your hearing and not just on the
waveform display.

5. Now shorten the object to the playback range length.
6. Deactivate "Enlarge object" and turn the grid back on.

7. Switch to the stretch mouse mode (Ctrl+7) and stretch or compress the object into
an even number of bars.

8. Deactivate "Solo", set an even playback range, and start playback. The loop should
run perfectly in time. To set the object as a loop, select "Edit > Object > Loop
section > Set custom loop".

To match the pitch of the loop to the current project, you can also change the pitch using
the mid handles on the object in the stretch mouse mode.

Change project tempo

You can use the tempo setting in the transport controller (740) to change the project's
tempo retroactively. This uses the time stretching effect to adjust all audio objects in the
project to the new tempo. In some circumstances this can lead to an increased demand
on the system and dropping out during playback. If this occurs, use the "Mix audio (757)".

Another option is to use the "Elastique Efficient" timestretching algorithm, which
provides a slight decrease in sound quality, but uses less computing power.

Choose a couple of objects that are not so important. Open the Inspector by double-
clicking on Tempo Pitch/Resample (Shift + P) and then click the "Setup" button. You can
switch to Elastique Efficient here. If the pitch still isn't being retained (drums, percussion,
FX sounds), you can switch to Resampling, which uses even less computing power.
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Takes

Each object can be saved as a "take". Takes save all editing done on an object, such as its
length, fade settings and all object effects. MIDI takes save the instrument controlled by
them (MIDI output or software instrument).

Takes are saved as "TAK" (*.tak) files and take up virtually no space on the hard disk. This
means you can cut a sample, add various effects to it and save it as various takes in order
to use these together with all their editing in other MAGIX MusiC MAKER projects.

Instead of repeatedly saving the original sample, only the object and effect settings are
saved.

Note: When loading takes, the audio or video file used by the take must be located in the
same folder as when the take was saved.

Keyboard shortcut: Alt + Shift + S
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Edit in external editor

A selected audio object can be edited in an external editor using a wide range of special
functions. Once editing has been completed, the edited material is used in MAGIX Music
MAKER instead of the original object.

The path to the executable file of the audio editor can be set in the program settings
under the "Folders" tab.

/1 This function is only available if you have purchased an audio editor from MAGIX as part
of your Edition, or separately in the Store even if you select a different audio editor there.

Shortcut: Ctrl + Shift + M

Mix audio

If the arranger becomes too full to manage, or you just want to sort out your work so far,
use the mix down function to convert the entire project or just sections of the project
into a single audio and/or video file.

To do this select the "Audio mixdown" function in the "Edit > Track" menu. You can
choose a name and a destination for storing the mix down object. The default directory is
"My Projects”. If only audio objects are in the tracks, a wave file will be created. If audio
and video objects are combined, you can choose whether an audio or a video file will be
created.

The objects of the project or the area will be replaced by the new object.

Mixing automatically normalizes the audio file, i.e. the loudest point of the audio object
matches the maximum level. This prevents loss in sound quality, even if you run the audio
mixdown function several times in a row.

This function is very helpful if you want to keep on using the mix down object. To create
the finished end version of the song, it's best to select the "Export arrangement" function
in the "File" menu instead of the mixdown function.

Shortcut: Ctrl + Shift + G
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Playing software Instruments

If would like to work beyond the included sounds and express your own musical ideas,
you can also record your own melodies. MAGIX MusiC MAKER has many synthesizers for
creating your own sound material.

Software Instruments are loaded to a track and controlled by MIDI objects in the track.
Instruments cannot be freely moved between tracks like audio objects. Effects may only
be applied at the track level.

Insert synthesizer

In order to use a synthesizer, you first need to insert it into a project track. There are
several ways to do this:

The VST instruments window

® . , . :
Using this symbol or the V key, you can open the VST instruments window.
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VST instruments ﬂ

B NAME

@ ADDITIONAL VST —_ 1957 WOODEN
INSTRUMENTS = CLARINET

=~  ACCORDION "= ANALOG SYNTHS

"=~ ANALOG SYNTHS 2 =~  BALALAIKA

All synthesizers that have been supplied with the software, purchased in the Store, and
located in the VST folders (7213) are listed here.

When the mouse is moved over a software synthesizer, a play button appears that allows
you to play a sample of the synthesizer. The synthesizer can be loaded to the next
available track by double clicking the instrument or just clicking the arrow button. The
synthesizer interface also opens.

_ The overview is quickly lost when a large number of plug-ins

have been installed, so you can also use the full text search
above.

In this menu you can specify whether you want the synths to appear
alphabetically or descending or ascending according to category.

Loading synthesizers via the track header

Another way to load synthesizers is to use the synthesizer menu in the track header.

59 /216



Playing software Instruments

At the start of an arranger track, the track header contains an empty field for the
instrument icon.

. Left-clicking on this field opens a menu with the sounds from the included
software synthesizer which can be loaded to the track.

AR SR RIS

(Ll R T [LTERART T A

~ Tip: You can also access this menu via the MIDI editor (783) and the keyboard (780).

Removing synthesizers

To remove a synthesizer, select the first entry in the right-hand column "No VSTi" in the
instruments menu (accessible via the track header, MIDI editor or keyboard).

The program's synthesizers

The software synthesizers included are based on VST plug-in technology (VST
instruments). A plug-in is an independent software component that can be loaded in
MAGIX Music MAKER. Various standards were developed for including plug-ins. The
"VST" standard has become the most widely used. "VST" stands for "Virtual Studio
Technology". "VST" stands for "Virtual Studio Technology". This means you can add to
the collection of instruments included in the program with additional instruments (and
effects (#7108)) from third-party providers.

Following instruments are available:

o DN-el (761): Avirtual analog synthesizer that is suitable as an all-round instrument
for many styles and areas of use.

« MAGIX Vita (763): A universal sample player that specializes in realistic playback of
"real" instruments for which it uses sampling technology. It contains sound
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programs for various conventional instruments: Guitar, bass, acoustic drums, piano,
strings, horns

o Revolta 2 (765): Another virtual analog synthesizer for advanced explorers in
sound.

e VITA Sampler (767) A simple sampler, which you can use to play sections of
samples via MIDI, for example individual drum sounds from drum loops.

« Vita Solo Instruments: (768) Individual instruments based on the same technology
as Vita. The interface has been customized and expanded for each different
instrument.

DN-el

DN-e1l is a virtual analog synthesizer that is suitable as an all-round instrument for many
styles and areas of use. It works in a subtractive way, i.e. first a basic sound is selected
that is then edited using a filter curve.

The DN-el is played with a MIDI keyboard or with the aid of MIDI objects. You can use
the keyboard in the program to set the sounds.

Sound selection

You can select the sounds and sound configurations at the top.
Bank: Here you can switch between three banks with various complete configurations.
Category: Here you can select a sound category.

Rndm (Random): Here you can activate a random selection of the parameter settings in
order to experiment with the sound.

Patches/Name: Here you can select a sound that will then be modulated.
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OUTPUT

The end of the signal chain is edited in this area.
Volume: You can adjust the volume here.
Voices: Control the number of voices generated (polyphony) here.

Glide: This controls the glide function. You can access sliding pitch transitions between
the individual notes.

Unisono: Switches to monophonic sound, but generates a number of slightly varied
voices for "thickening” the sound.

FILTER ENV

In this area the filter curve used to filter the output sound is modulated.

Attack: Use this controller to set the time duration that the filter curve requires in order
to reach its maximum.

Decay: This lets you set the time duration that the filter curve requires in order to go
from its maximum to the sustain level.

Sustain: Here you can set the degree of filtering that should take place after the decay
phase. This filtering remains the same until the key on the keyboard is released; in
contrast to the other three parameters, it does not also control a time duration, but a
specific level.

Release: Here you can set the time duration which the filter curve requires in order to go
from the sustain level to the zero point after the key is released.

REVERB

You can also apply a reverb effect.
Type: Set the sound coloration of the reverb effect using this fader.

Pre Del: For setting the time that passes between the direct signal and the arrival of the
early reflections, known as pre-delay. The reverberation time only comes after the pre-
delay.

Damp: You can define the cut-off frequency for damping highs for each delay here. This
can help make delays reverberate more naturally and is useful for creating special effects
(especially in a reggae or dub style).

Decay: Set the complete reverb time here.

Low Cut: Use to set the filter frequency of a high-pass filter. All signal components below
this frequency will be filtered out.
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Amount: Here you can set the mixing ratio between the effect and the "dry" original
sound that has no effect applied.

DELAY

An additional echo effect can be set here.

Type: Different types of echo can be defined here: normal echo, ping-pong echo (where
the sound swings through the stereo panorama) and various other forms.

Color: Use to set the sound coloration of the echo.

Feedback: This parameter controls the number of echo repeats.

L Rate: You can set the time duration for individual echoes for the left channel here.
R Rate: Set the time duration for individual echoes for the right channel here.

Amount: Here you can set the mixing ratio between the effect and the dry original sound
i.e. with no effects applied.

MAGIX Vita

MAGIX Vita Synthesizer specializes on realistic playback of "real" instruments for which it
uses sampling technology. This means that short samples of real instruments in different
pitches, playing techniques and volumes are used, combined, and played again at the
correct pitch.

The Vita interface

- 10E

& -‘-g: N A it N
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W n |
1. Layer selection/Peak meter: The Vita sounds, also known as layers, can be selected
here using the arrows. Right-clicking on the display opens the layer menu.
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2. Main parameter: Here the volume, panorama position, pitch characteristics
("transpose") and the fundamental frequency ("master tune") can be set.

3. AMP: This is the volume envelope. With this you can control the timing of a sound's
volume. A(ttack) stands for the volume increase at the start, D(ecay) for the length of
time the decrease in volume takes on a section set with S(ustain) at the maximum
volume. R(elease) is the length of time it takes for the sound to fade out.

Note Off

Mote ON |

Sustain Level

B Release _

~ Attack Decay

4. FILTER: Here you can switch on a filter which influences the sound. With FILTER TYPE
you can select the kind of filter you want to use. Cutoff controls the filter frequency and
"Resonance" controls the strength of the emphasized filter frequency. "Velocity"
indicates how much the velocity influences the filter frequency, using "Gain" you can
balance the volume. The filter envelope (ADSR slider) influences the filter frequency
depending on the time.

5. DELAY: Here you can switch on an echo effect. "Time" controls the delay time and
"Level" controls the strength of the echo sound.

6. REVERB: Here you can switch on a reverb effect. "Time" controls the delay time and
"Level" controls the strength of the echo sound.

7. TUBE DISTORTION: This is a tube distortion effect like those found in guitar
amplifiers. This is normally used for electric guitars but you can also get creative and use
it for other things. "Drive" controls the strength of the distortion. "High-cut" and "Low-
cut" filter out the high and low frequencies.

8. VALUE DISPLAY: This always displays the exact values of the parameter that was just
adjusted.

9. DYNAMIC RANGE: Usually the relationship between the created volume and the
MIDI velocity is proportional. You can compensate for the fact that some MIDI
keyboards need to be pressed forcefully to produce loud sounds (or conversely produce
loud sounds with a soft touch) using the "MIDI Input Curve". Using "Dynamic and
"Dynamic curve" you can manipulate the dynamics of a sound, i.e. the relationship
between the loudest and quietest sounds.
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10. Voices: Here you can control the number of voices played simultaneously. If notes
are no longer played, as is the case in some fast passages, you can increase the number of
voices at the expense of performance.

11. Keyboard: Here you can preview the Vita sounds. This only works during playback or
recording. 12. lets you hide the keyboard.

Revolta 2

The Revolta 2 is a further development of Revolta 1. It is polyphone and playable with up
to 12 tones, including an additional noise generator, a step sequencer and an extra
flexible modulations matrix. Its effects section of 9 different effects and presets,
designed by a famous designer, make its a full-fledged synthesizer for all kinds of lead,
sequence, and pad sounds.

REVOLTA 2 has a whole array of presets. The sounds were created by professional
sound designers and factory-direct they already show the amazing potential of this
instrument. However, we would still like to encourage you to try out the various controls
in the early stage and to experiment around as much as you like. The sky's the limit to
your creativity.

Revolta2 interface
Warning: Here, you will find only a short description of the Revolta 2 interface.

For a comprehensive documentation of this complex synthesizer please click the
help button on the Revolta 2 interface!

The Revolta 2 interface can be displayed in two sizes. In rack mode only the elements
necessary for preset loading are visible:

By clicking the edit button, you can open the complete interface.
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1. Main parameter: Here the volume, panorama position, pitch characteristics
("transpose") and the play modes (POLY, MONO, LEGATO) can be set. GLIDE controls
the portamento time.

2. Oscillator section: Two oscillators are available with smoothly adjustable curve form
and a noise generator. The two oscillators can be detuned against each other and
frequency modulate with each other.

3. AMP: This is the volume envelope. With this you can control the timing of a sound's
volume. A(ttack) stands for the volume increase at the start, D(ecay) for the length of
time the decrease in volume takes on a section set with S(ustain) at the maximum
volume. R(elease) is the length of time it takes for the sound to fade out. VEL specifies
how much the envelope curve depends on the velocity.

4. FILTER: Here you can switch on a filter which influences the sound. With FILTER TYPE
you can select the kind of filter you want to use. "Cutoff" controls the filter frequency
and "Resonance" controls the strength of the emphasized filter frequency. "VEL"
indicates how much the velocity influences the filter frequency, using "KEY" you can
change the filter frequency depending on the note value ("keytracking"). The filter
envelope (ADSR slider) influences the filter frequency depending on the time. "env mod"
controls the intensity of the filter envelope, "drive" allows you to overdrive the filter.

5. FX1/FX2: Here you can mix in 2 different effects out of a total of 9 available effects.

6. LFO1/LFO2/STEPSEQUENCER: Two LFOs and the step sequencer can be used to
modulate single parameters of Revolta 2.

7. Options and modulations matrix: The two buttons open the options page of the
Revolta for general and preset-specific settings and modulation matrix. In the modulation
matrix, modulation sources are connected with modulation targets. Simple modulations
like the oscillator, where the pitch will be modulated via an LFO (vibrato), may be set
quicker directly on the interface. Much more complex modulations are possible in the
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matrix, because the matrix offers more modulation sources (e.g. MIDI controller,
oscillators) and the modulation source may influence more targets.

8. VALUE DISPLAY: The value display shows the exact value of the parameter which was
just modified. You can also read the load for the twelve voices.

9. Preset section: Here you can select Revolta presets. Every sound can be listened to,
and an A-B comparison between two sounds is also possible (for example, an edited and
an unedited sound).

Vita Sampler

The Vita Sampler is a simple sampler, which you can use to play sections of samples via

MIDI, for example individual drum sounds from drum loops. This function as a so-called
"beat slicer", which means that it automatically finds the individual elements in samples

(e.g. kick drum in a drum loop), which in turn are available as destinations for eight drum
pads.
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o Wave form: Your own samples in the file formats .wav. .aiff, .ogg, and .mp3 may be
loaded into the Vita Sampler via drag & drop simply by dragging them there. In this
case, the sample segments ("slices") are detected automatically and marked in the
sample.

e Assigned slice: Of all the detected slices, 8 are selected randomly, assigned to the
drum pads, and specified as random playback modes (5,6).

9 .Drum pads: Slices may be played using the mouse with the drum pads and via MIDI
with the white buttons starting at C3 (MIDI note number 60, 62, 64, etc.)
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@ Selected slice: Slices may be selected for advanced listening by clicking them. The
associated drum pad is also displayed at the same time.
To change the slice assignment for this drum pad, drag the colored frame around
another wave form slice.
To change the size of the assigned slice, drag the edges of the frame using the round
handles. The edges will snap onto the specified slice borders. Pressing the Alt key
shuts off the snapping grid. This enables imprecise positions in the slice detection to
be corrected.

Note: Slices may not be assigned to multiple drum pads, which is why sometimes,
the selection cannot be dragged as desired.

6 Clicking the symbol changes E E
the playback direction of Forward Backward
the slice:
@ Clicking the symbol changes No loop. The slice is played back for as long as

the playback mode of the the drum pad or the MIDI note is active, but
slice: only until the end.

Loop. The slice is played back in a loop for as
long as the MIDI note is active.
@ One shot. The slice is played back

independently of the length of the MIDI note
until the end

@) Lock pad: Lock the pad out E Not locked

of the random function (see
E locked

below).

@ Random: A new, random selection of slices is added to the drum pads and random
playback modes (4,5) are assigned. Locked pads are not included. You can use the
random function repeatedly to discard unwanted results and keep the good ones.

9 Zoom: The zoom buttons enable you to enlarge the wave form display, to recognize

more details,which is practical for correctly slice edges with the ALT button (see
above)

Vita Solo Instruments

MAGIX Music MAKER includes some more synthesizers that are based on the VITA
Sampling engine. The Vita Solo Instruments are a sample player that have customized
interfaces for the relevant instrument.
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The basic controls are identical for all synthesizers.

E-Bass Plate ECO v

N_

One click on the arrow symbol opens a drop-out menu where you can determine the
general sound of the instrument. If "ECO" appears in the description, this refers to
especially performance-improving settings which may not sound so "smooth". You can
also save the settings you changed in order to add them to your favorites lists for later
use.

WOLUME

You can control the overall volume of the instrument.

KEYBOARD

You can turn the instrument keyboard on or off with this controller.

Because these samplers are enhanced for each instrument by tuned effects, the rest of
controls function analogously to the already familiar synthesizers such as Vita. If you
would like to know which result certain effects have, you will find explanations in the
Essential FX, Vintage Effects (7130), Reverb (7124) and Distortion & Filter (7112)
chapters.

Articulation

Some Vita Solo Instruments have a special feature: In the bass octave (on the keyboard
(CO-BO), there are special notes, which let you control the playing style (articulation). An
alternative sample set is loaded, which lets the sound even more realistic using various
playing styles natural to the instrument, for example note bending and flageolet on the
guitar or staccato on the saxophone.

Articulation is switched on and continues until normal articulation is switched on again
through the corresponding note (CO).
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In the keyboard of the instrument interface are the buttons to switch articulation, displayed in a
different color. In the MIDI Editor appearing above, you can watch a practical application of
articulation. The notes on 1:4 and 4:1 will be played back with varying articulation. Before the next
"right" note, normal articulation will be switched on again through CO.

Automation of Vita Solo instruments.

In MAGIX Music MAKER it is possible to automate Vita Solo instruments. This allows you
to change a specific value during playback using an automation curve automatically.
Below we describe how to work using an automation curve.

1. Right-click on an effect knob. This opens a context menu where you can select a
MIDI controller number for the automation using "midi ctrl #". A few standard
controller settings are already preset, e.g. 7 for volume, 10 for panorama, 91 for
reverb.
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Open the MIDI Editor (Y key) and switch into the "Velocity/Controller Editor".
3. At the bottom right, you can now select the pre-selected controller number in the
MIDI controller selection field.
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4. Now, draw the desired automation curve.

. Additional information can be found in the Controller Editor - Select and edit events
(789).

" Tip: If you are using an external controller, you can also use it to control and automate

values. To do so, select "Learn MIDI" in the Vita Solo Instruments context menu. Also read
the Using external equipment (.778).
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BeatBox

BeatBox

BeatBox is a simple drum machine which is programmable using a step sequencer and
was designed to be as easy to use as possible and produce fast results. It holds a special
status among the synthesizers in that it has its own window in the main interface and is
not controlled by MIDI objects, but by its own sequencer.

This means that you don't have to load the BeatBox onto a track first from the track
header like the other synthesizers, but simply open the BeatBox window.

The BeatBox can be opened by clicking on this button or pressing the B key.

01(1208,M) 4 ~ SH 6IRusd

HiHat Closed
Conga High
Conga Low

Rimshot

o Step Sequencer: Here is where you program your beats. Each row corresponds
to a drum instrument, the 16 boxes in each row indicate where within the
measure that particular rhythm instrument sounds.

. To add several steps in a row, simply click and drag with the mouse.

9 Play: The Step Sequencer has its own play button. If the small lock symbol Fi is
set to open, you can start and stop the BeatBox independently from the
arrangement.

Drum set: Use this button to choose from a menu of different drum sets.

Pattern: You can select between various drum patterns here. (Patterns are the
programmed drum sequences.)

0

72 /216



BeatBox

Save pattern: Use this button to save the patterns you have programmed.
They can be loaded the same way as the ones included in the collection of
patterns.

Please note that each drum set has its own list of patterns meaning that you
will only find your custom-programmed pattern if you have also chosen the
appropriate drum set.

It is not possible to save patterns in Music Maker free.

Render audio loop: If you drag the loop symbol el onto an empty track
in the arranger, the current pattern will be saved as an audio file and inserted
into the arrangement at that position as an object.

When you play back the arrangement with the inserted BeatBox loops, don't
forget to stop the BeatBox window, otherwise the drum beats might be
doubled (from the synthesizer and the loop), which might sound a bit strange.

When you play back the arrangement with the inserted BeatBox loops, don't
forget to stop the BeatBox window, otherwise the drum beats might be
doubled (from the synthesizer and the loop), which might sound a bit strange.
This allows you to combine different BeatBox patterns in your arrangement.
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VST Plug-in Editor

The VST Plug-in Editor can be opened by right-clicking on the instrument's name in the
MIDI Editor, via the corresponding plug-in slot in the Mixer, or via the "VST Instruments
Editor" entry in the instrument list.

The Instrument Editor has two views, the so-called "GUI" of the plug-in (Graphical User
Interface) and the parameter view. This is either automatically activated when the VST
plug-in does not have its own GUI or can be used if the GUI of the plug-in is too unclear
or takes up too much space on the screen. The parameter view displays the eight
parameters of the plug-in as sliders. In the File menu you can change between these
views (plug-in dialog/plug-in parameter).

Load/save patch/bank: The instrument settings can be saved and loaded in the patch
formats typical for VST plug-ins (*.fxp) and bank formats (*.fxb).

Random parameters: This function can be an important source of inspiration. If using it,
however, please save the preset you have just created first, as the program does not ask
you for confirmation before applying this function.

Menu program: Here you can select the presets integrated into the plug-in or loaded via
the File menu.

Adding your own plug-ins

You can use your own VST synthesizers and effects with MAGIX Music MAKER. The
program supports VST2 and VST3 formats in 32- and 64-bit.

A VST bridge is required for using 32-bit plug-ins (this comes with some program editions
or can be purchased separately from the Store).

Synthesizers and effects that are included in MAGIX MusIiC MAKER or are purchased in
the Store are automatically recognized and can be used right away. To use third-party

plug-ins in MAGIX MusIC MAKER, you must tell the program in which folder they have

been installed. To do this, proceed as follows:

1. Install each VST plug-in according to the instructions provided by the manufacturer.
In most cases the plug-in installer suggests a default folder (e.g. C:\Program
Files\VST): these System VST folders are included in the plug-in scan by
MAGIX Music MAKER by default. You can also use any other folder. If you already
have VST plug-ins installed on your system, it is best to use the existing folder.

2. Open the program settings (P key) in the Folders tab and select Add VST plug-in
path.... The VST plug-in scan paths will open.

3. Click on Add scan path and select a path for the folder.
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4. Click on Scan now to start the plug-in search. This scan may take some time for
many installed plug-ins and instruments. Not only are all the plug-ins imported, but
they are also checked for usability within the program. Incompatible or incorrectly
installed plug-ins and those that cause the plug-in search to crash are also included
in the list and flagged as unusable, so that they are skipped during the next scan
and cannot cause problems again.

5. The newly found plug-ins can be used immediately.

You can also specify and scan any number of plug-in paths. To remove a path, select one
or several and click on Remove selected paths to delete them from the list. Reset to
default removes all paths apart from the VST system folders and the internal paths used
by MAGIX MusiC MAKER.
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MIDI objects

MIDI objects do not contain audio material. They are used to control synthesizers (/758)
that then create corresponding sounds. They are comparable to music notation that is
about to be played by a musician.

MIDI s a standardized command language that helps control synthesizers..

In addition to the command to play a note (Note On, Note Off), there are control
commands (control change) for internal synthesizer parameters (volume, panorama, the
pedal for piano, filter settings and others), program change commands (program change)
to open saved sound programs and for other tasks. These commands are called MIDI
events. A MIDI object contains a series of events and the times at which they occur.

You can create MIDI objects by loading MIDI files, playing and recording with an external
MIDI keyboard, or by drawing notes in an empty MIDI object with the MIDI editor.

Arrange MIDI objects

MIDI objects can be positioned exactly like audio objects in the arranger, the volume may
be modified (middle handle), or fades (in or out) may be added (top right and left handles).

The differences to audio objects (loops) are:

« Volume changes in MIDI objects mid handles or fades in/out are controlled by
adjusting the velocity (MIDI Note On velocity) with the handles on the upper left
and right of the object. Many synthesizers do not change the volume, but rather the
sound in relation to the velocity level. If you do not want that, adjust the volume in
the mixer instead or by using a controller curve (789) (usually controller 7).

« MIDI objects always control the synthesizer that is loaded into its track. If you
move a MIDI object onto another track, then a different synthesizer will be
controlled and the sound of the project changes accordingly.

« Self-recorded MIDI objects are not available as a loop.

You can shorten MIDI objects with the lower front and rear handles as desired and
convert them to a loop with the menu command Edit > Object > Loop range > Set
custom loop.

Transpose MIDI

Using this function from the "Effects" menu, the pitch of MIDI objects can be altered.
You can find this function in the Effects >Pitch, Tempo & Remix > MIDI transposition....
Enter the number of half steps to transpose all the notes in the MIDI object up or down!
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Note: For drums each note corresponds to a different percussion instrument (kick drum,
snare, toms, etc.). Transposition of a drum track is therefore not recommended. Instead,
directly adjust the pitch of the respective synthesizer.

MIDI files

The file format with file extension *.mid is used to save and load a standard MIDI file.
Many pop hits are online free to download as MIDI edits. They may serve as a good
springboard for your first musical experiments or cover versions.

You can save the content of a MIDI object as a file in the MIDI editor. In the "File" menu
of the MIDI editor (783) use the command "Export MIDI".

Preview of MIDI files

Like audio files, MIDI files are loaded by using the file manager. A simple click will start
the preview.

Since the number of possible sounds is virtually unlimited and because such files should
be universally applicable, they are usually arranged so that they require certain standard
sounds. This number of standard sounds is called General MIDI (GM) or in an expanded
form General Standard (abbreviated GS). To preview a MIDI file in the file manager
MAGIX Music MAKER uses Microsoft GS Wavetable SW Synth, this is a software
synthesizer that is part of the Windows operating system and contains these sound
programs.

Its sound quality is rather modest compared to "proper" software synthesizers. For
further work with imported MIDI data, we recommend using the software synthesizer
supplied. And due to another reason: "Microsoft GS Wavetable SW Synth" is not part of
MAGIX Music MAKER and the sounds it produces are therefore not included in a finished
song that has been exported.

Note: MIDI data that contain a complete arrangement should be copied onto multiple
tracks and filtered by MIDI channels with help from the MIDI channel filter (7101).

If the preview in the file manager does not work:

o Check the output device for MIDI in the Program settings window in the
Audio/MIDI tab (P key or via File menu > Settings > Program settings). "Microsoft
GS Wavetable SW Synth” should be selected here!

o The sound card synthesizer's volume is set via the the sound card mixer. Double
click the small loudspeaker icon in the notification area and find the controller for
the SW synthesizer.
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o Several sound cards cannot use the SW synth simultaneously with ASIO drivers
(2211).

Connect MIDI keyboards

You can use MAGIX MusIC MAKER in conjunction with a MIDI keyboard to play and
record the included synthesizer plug-ins or VST plug-ins. You can also control sound
generation from external devices using MIDI objects in the project of MAGIX Music
MAKER.

Basics of MIDI interfaces and cabling

MIDI interfaces are system devices that enable communication between the computer
and an external MIDI device. They provide music programs with one or more MIDI ports.
The music software (in our case MAGIX Music MAKER) sends and receives MIDI data via
this port, everything else is handled by the drivers and operating system. You can set the
ports for MIDI input and output in MAGIX MusIC MAKER in the Program settings (7211)
(key P, Audio/MIDI tab).

A MIDl interface can be integrated into the computer system in different ways. It can be
part of the sound card built into the computer or externally connected via USB or
FireWire.

In this case, two MIDI jacks (MIDI IN and MIDI OUT) are located on the
sound card. With older sound cards an additional adapter cable must be
connected; this provides the classic 5-pin DIN jacks.

MIDI
connectors

MIDI connection cable

Connect your MIDI keyboard to your computer by running a MIDI cable from the
keyboard MIDI output jack (MIDI Out) to the MIDI input jack (MIDI In) on the MIDI
interface. If your MIDI keyboard can generate its own sounds and you would like to use
them, connect the computer's MIDI Out jack to the keyboard's MIDI In jack.

With USB MIDI keyboards the MIDI interface is part of the external hardware. USB
MIDI keyboards are a unique category of devices that are specially designed for
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controlling software synthesizers. These devices usually do not contain any separate
sound generators, but rather consist of just a keyboard, different controls, and a USB
MIDI interface. They are connected via USB to the computer - in this case, no MIDI
connection cables are required.

Note: Even on "proper" keyboards and other synthesizers you can now find a USB MIDI
interface alongside traditional MIDI connectors.

Normally, no special drivers are needed for these keyboards. All you have to do is
connect them. In some cases, you may have to select the port for the device as a MIDI
input device via the Program settings ("Audio/MIDI" tab) (7211). This is usually called
"USB audio device"

In the event that your external device does not have a USB port and the sound card does
not have MIDI connectors, you will need to purchase an additional USB to MIDI
interface.

MIDI Local Off: If the MIDI keyboard has its own sound source, it must be switched off
when you use its keyboard for recording. This enables you to play the software
instruments without hearing the sound of your keyboard at the same time. This function
is referred to as "Local OFF" and can be directly set on your keyboard. If necessary, refer
to the user manual for your keyboard to find out exactly how to do this.

External synthesizers

MIDI objects can also be played back over a MIDI interface onto external synthesizers,
sound modules, etc. Set as default, the "pure" MIDI output (i.e. without using software
synthesizer plug-ins) is sent to the system software synthesizers (Microsoft GS
Wavetable SW Synth). This is required to preview (777) MIDI files.

If you set the MIDI port of an external synthesizer as the MIDI output device (see
previous section), the content of each MIDI object will be output in this manner.

Note: If the MIDI object is in a track containing a software synthesizer, the object will
control this synthesizer. To output MIDI via an external sound synthesizer, select "no
VSTi" from the list of software synthesizers.

/5 All MIDI tracks that control external synthesizers via a MIDI interface will not be
included in the export. To be included, they need to be converted into audio objects first.
Connect the output of the MIDI sound generator to the input of the sound card, and play
back the MIDI track while recording it again using the recording function.
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Keyboard

The enables software synthesizers to be played and recorded directly via the on-screen
keyboard.

m Use this icon or the K key to open the Keyboard window.

The keyboard always controls the synthesizer in the track for which MIDI recording has
been activated.

You can operate the keyboard with the mouse to play the instrument. The closer to the
bottom edge you click on the "virtual keys", the louder the sound will play. Of course, you
can't play music properly by clicking with the mouse (this function is more suitable for
testing out sounds quickly). That's why you can also play the keyboard with the keys on
your computer keyboard.

~ Note: This works only after you first click once on the on-screen keyboard using your
mouse - otherwise the keystrokes will correspond to keyboard shortcuts for various other
MAGIX Music MAKER functions. If the computer keys control the program's keyboard, the
piano keys will display the corresponding letters and characters.

- Use the vertical arrow buttons to shift the octave range so that the keyboard
can be played using the computer keys.

- You can use the horizontal arrow keys to select the next/previous sound of the
synthesizer, or they may be selected directly in the list field on the side.

This button opens the synthesizer editor window for fine-tuning the sound.

Arpeggiator

m The arpeggiator is a special function that can be used to create full chords or
broken chords (arpeggios, i.e. the notes of a chord played in quick succession)
by pressing a single key.
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C note C minor chord C minor arpeggio with 1/16 notes

o This button activates the arpeggiator.

@ This switch determines whether the played note will generate no chord, a minor
chord or a major chord.

9 This switch determines the type of arpeggio. When set to the far right, a normal
chord is played. The other positions are up, down or up and down. The figures are
repeated as long as the note is played.

Q The tempo of the arpeggio is set here and can range from 1/4 notes (slow) up to
1/32 notes (very fast).

Scale

With the "scale" feature, you'll never hit the wrong note! The keys of the screen

keyboard are replaced by a bar of playing areas where you can only play notes from the
scale that has been selected.

- This button activates the scale feature.

B

The keyboard in scale mode.

Choose between various scales by clicking on the arrow.

The circles on the playing areas will guide you. The doubled circles indicate the tonic,
which is the note that the scale begins with. The following scales are available:

Major C,D,EFG,AH
Harmonic Minor A H,C,D,E,F,G* A
Pentatonic CD,E G, A
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Major Blues (Major) C, D, D¥, E, G, A
Major Blues (Minor) C, D*, F, F¥ G, B
Indian C,C* E F,G,G" H
Japanese C,C* F,G,G*

Tip: The scale feature also works with the MIDI keyboard. The scale is played on the
white keys and the black keys play the same note as the white key directly below it.
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Playing and recording MIDI synthesizer

MAGIX Music MAKER allows you to play and record software synthesizers or external
MIDI devices from the arranger. The MIDI editor does not have to be open.

Presuming that the MIDI input and output devices are set correctly (see above), you
should be able to play software synthesizers with the MIDI keyboard.

NEEEEE M DI recording mode must be activated in the corresponding track by clicking
"Rec" twice in the track header. Now, all of the notes that you play via the
keyboard will be played back through the synthesizer.

If a software instrument is loaded via the track header or opened via the MIDI Editor,
then MIDI recording mode is activated automatically.

@ = In order to record a new MIDI object, simply click the red "Record" button in
the transport bar

MIDI editor

The MIDI Editor makes it possible for you to edit MIDI objects. The MIDI Editor provides
different views and aids to do this.

m Using this symbol, double-clicking on a MIDI object or pressing the Y key, you can
open the MIDI editor window.

In the center you'll find the Piano Roll Editor (787), in which the notes are displayed as
bars and from which they can be edited using the mouse. There are various buttons
located just above the Piano Roll:
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Clicking on this button opens the Event list (791). In this list you can view all
MIDI data of a MIDI object, including those that cannot be edited in the piano
roll or controller editor. You can use the Event List to remove unwanted
commands included with imported MIDI files.

Use this button to switch to Drum Editor mode (793).

You can use this to leave the Drum Editor and return to the Piano Roll section.

Clicking on this button opens the Controller Editor (789) in the bottom area.
This allows you to edit features such as the note velocity, pitchwheel, and
controller data.

Deletes all MIDI data from the object.

0 BEE

N Undo/Redo is, of course, also available for all changes you make in the MIDI
Editor.

Along the top edge, you will also find buttons for selecting the editing tools (787), for the
Piano Roll, quantization (797), for the output used by the MIDI object (MIDI out or VST
instrument), and for step recording (799).

The MIDI editing window features its own menu (7103) with its own keyboard shortcuts
(2105).

Moving and zooming

The vertical and horizontal view or zoom are adjusted with the Scroll bars just like in the
project window.

Mouse wheel: Scroll horizontally
Alt + mouse wheel: Scroll vertically
Shift + mouse wheel: Zoom vertically

Ctrl + mouse wheel: Zoom horizontally

Select sounds

[ ] [Instr:'STi 1 Century Guitar v | |

Select the desired VST instrument from the menu. This corresponds with the instrument
menu in the track header. This can also be done by using the gear icon to open the
synthesizer's interface. You can test the same MIDI object with various VST synthesizers.

If there is no VST instrument loaded, the MIDI object uses the MIDI output for the
external synthesizer or for the synthesizer supplied by your operating system (Microsoft
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GS Wavetable Synth). The MIDI output can be adjusted in the "Program settings"
window in the "Audio/MIDI" tab (P key or via "File" menu > Settings > Program settings"

You can set up the MIDI output channel under MIDI channel. MIDI objects can contain
objects on different channels. In the Multi default setting, these channels are maintained.
This is important for VST instruments which can receive MIDI notes on multiple channels
and play several different sounds simultaneously (multi-timbral). If you select one channel
instead, all events will be output only on this channel. To use different MIDI channels,
refer to the section on the MIDI channel filter (7101)

Play/ Play solo

"Play Solo” only plays the MIDI Object that is currently opened in the MIDI Editor
(corresponding with the filter settings in the “Options” menu).

“Play” plays the entire arrangement.

MIDI recording options

You may also begin MIDI recording directly in the MIDI Editor. To do so, simply click the
red "REC" button. Compared to the simple "Record" featured directly in the "Arranger”,
this version features several additional options for you to select

Overdub: Normally, existing notes are deleted with each new recording. Overdub simply
adds new MIDI notes to the existing MIDI recording. "Overdub" allows you to create a
completely new MIDI song step-by-step (or take-for-take).

Cycle: This plays the MIDI object in a loop during recording. This enables you to let the
object play through a few times before you get started recording your own melody.

Metronome: In order to play back the proper tempo, you can activate the MIDI
metronome to provide the beats. This is only for orientation while you play and is not
recorded.

m Play project during recording: If this option is active, then the project will play
during recording.

Selecting MIDI events

Selection of MIDI events for editing is generally the same in all three editing areas (Piano
Roll, Controller Editor, List Editor). The differences are visible in the table:

Selection Mouse action

Select the Event Left-click on event

85/216


../../../../../Content/MIDI Kanalfilter.htm

Add/Remove event
from selection

Select current event,
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Marquee selection

Unselect all

Set or change current
events within multiple
selection.

Selection of section of
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Selection of all notes
of a pitch

Selection of all events

Select next or
preceding note
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Ctrl + left-click on event

Double-click on event

Left-click on a free space and click and drag selection.
(Selection tool in Piano Roll and Controller Editor)

Left-click on a free space (only in selection mode, not in the
List Editor)

Left-click on selected event

Left-click on first event, Shift + left-click on last event

Double-click on a free space with this pitch or press the
appropriate key on the keyboard (only Piano Roll)

Ctrl + A,

depending on the editing section, includes the selection of
notes (Piano Roll), Controller events (Controller Editor), or all
events (List Editor).

Arrow left/right (only Piano Roll)

Fundamentally, an event selection always applies to every other range as well with just a
few exceptions. You can, for example, select a group of notes in the Piano Roll and then
change the velocity for the selected group of notes using the Controller Editor, modifying
all selected notes simultaneously.

Meaning of the colors in the Piano Roll and Controller Editor

Notes which are not selected within the editor are displayed in blue. The intensity of the
color represents the velocity: With increasing velocity the color will become

darker/stronger.

Selected notes: Multiple selected notes are displayed in yellow. Here too, a more intense
color symbolizes increased velocity.
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Alternatively, the color in the Piano Roll can symbolize the MIDI channel of a note. Select
in the "Options" menu "Use MIDI channel colors".

Current event: Appears with an orange border. If an event is selected with the mouse, it
turns into the current event.

Filtered Events: Events filtered with the MIDI channel filter (7101) appear in gray.

Muted Notes: For test purposes you can mute notes (Menu "MIDI Functions (7102)"),
which then for selected and unselected events will be displayed with a fainted color.

Events outside of the object borders: Events in front of or behind the beginning and end
of the object - recognizable by the blue lines in the Editor - also appear fainter and have
a white border.

Piano Roll

For notes inside the Piano Roll, various editing tools, so-called mouse modes, are
available.

When clicking existing notes all tools generally act in the same manner: You can select
notes simply by clicking on them (see Selecting MIDI events (785)) and then by clicking
and dragging notes, whose start time, pitch or note length you are editing. Depending on
where you click on the note bars several options are available, which are visible by
different mouse pointers.

i Change note start time: Grab note bar at the beginning, note end remains the
same

Change note length: Grab note bar at end

B + Set fixed note length for multi-selection: Hold Shift key and drag current
Shift  reference note longer/shorter. This sets all selected notes to the same length.

B + Scale note length for multi-selection: Hold Ctrl key and drag current
Ctrl reference note longer. All notes will be lengthened by the same factor.

BB Move note freely, pitch and start time change

If His also pressed in Move mode, the note will only be moved horizontally,
retaining the pitch.

i If Shift is pressed while in Freehand Draw mode, only the pitch can be
changed, the position will remain the same.

o= /M If the setting Ranges for limited movement is activated in the Options menu,
clicking and dragging the first half of the note results in a change to the
position, while clicking the end half changes the pitch.
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Pressing the Alt key while moving the mouse temporarily deactivates the quantization

grid.

There are two exceptions: The eraser tool deletes notes by clicking on them and with the
velocity tool, notes are not moved but rather their velocity is adjusted (see below).

The mouse modes display their special functions by clicking or clicking and dragging
into empty sections of the Piano Roll:

Selection
(Ctrl + 1)

H Velocity

mode (Ctrl

+ 5)

Simple click: Clear existing selection.
Click + Drag: Draw out a rectangular selection frame. For additional
selection options see Selecting MIDI events (785).

Draw note: The start position and the length snap respectively to the
current quantization settings. Draw mode can be activated in all
modes by pressing the Shift key.

Draw sequence of notes: The lengths and distances of the notes are
set according to the current quantize settings.

If H is pressed while drawing, the pitch of the first note will be applied
to all subsequently drawn notes. Moving backwards with the mouse
when drawing removes notes already drawn.

Draw note pattern: A selection of existing notes can be saved as a
pattern (phrase) and then drawn in different pitches.

To create a new pattern select the respective notes and press Ctrl +
W or select in the Edit menu > MIDI/Drum Editor > Create pattern
from selection. Draw the pattern at the position of the deepest note
of the pattern. This makes an original pitch sound. You can, of course,
draw in different pitches. If H is pressed when drawing, the basic tone
pitch from the beginning will be retained.

Moving the mouse back (to the left) while holding down the mouse
button removes the notes which were just drawn.

Click an empty section like in selection mode.

Left-clicking on notes and dragging them vertically alters the
velocity of the notes. The velocity of notes can be edited directly in
the Piano Roll and the Controller Editor remains free for other
outputs.
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Delete Left-click: Delete note. Clicking one selected note deletes all selected

(Ctrl + 6)  notes when multiple notes are selected.
Click and drag: Delete all notes that come into contact with the
eraser.
The Delete mode can be activated anytime by clicking with the right
mouse button. You can add new notes with the Drawing pencil by
using a left-click and remove existing notes with a right-click, without
having to change the tool.

Jol Magnifying Left click: zoom in
glass Right mouse button: Zoom out
(Ctrl+7)  Leftclick + drag: Zoom in into a range

Controller Editor

The Controller Editor is a graphic editor that allows you to edit the velocity of notes in
the piano roll and in controller events. A Continuous Controller abbreviated as CC or
simply referred to as the Controller allows you to transfer control values such as for filter,
volume and panorama position.

Tip: All control elements for MAGIX Vita Solo Instruments and MAGIX Vita can be
controlled via the MIDI controller (770).

The Controller Editor is preset as hidden. You can have display by clicking the
button below the piano roll or with the key shortcut "Alt + V".

The velocity values of note events are displayed as colored bars in the Controller Editor,
whereby darker and higher bars symbolize larger values. The bars are located directly
below the respective notes.

The values of other controllers are shown as bars. The width of the bar extends to the
next event that has a different value. Because the controllers typically change more or
less continuously in smaller time intervals independently of note events, they appear as
ascending or descending ramps. The height of the ramps and their color intensity also
represent the last defined value of an event. Selected controller events also appear in
yellow.

MIDI controller events can be quantized and thinned out. To do this go to the MIDI
functions menu and select Quantize/thin out controller. Quantization is defined by the
quantization settings (798).
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Utilities

Controller Editor for editing the velocity of existing notes (left) or controller values (right)

o B sSclection tool: Specifically select existing controller events or notes and adjust
their values.

9 Freehand drawing tool: Freely draw new controller values or a gradient.

9 IESl Draw line: Use the line function to quickly insert a straight controller gradient
(ramp).

@) EEE9 Controller Selection. Select a controller to edit by clicking the menu.

Controllers, whose data is already available for the MIDI object, are marked by
an asterisk.

9 Velocity values are only available at time positions of the corresponding notes and in
the case of multiple notes occurring simultaneously, several appear on top of each
other (791). Controllers are independent of the notes.

Selector tool

Select multiple controller bars by clicking and dragging a range in the Controller Editor;
individual values can be selected by single-clicking within the bar. When selecting a
velocity bar, the corresponding notes will also be selected.

By clicking and dragging the upper edge of a velocity or controller bar, you can
immediately change its value. For multiple selection, the following rules apply: Each
controller is increased or decreased by the same absolute value. Holding Ctrl while
dragging changes the values relative to each other.

~ For example: Two controller values are selected:; the first is 30 and the second 60. If you
drag the end of the larger bar up by 30, then the values will change to 60 (30 + 30) and
90 (60 + 30). If you increase the larger bar with relative values (by holding Ctrl) by 30, it
will result in an increase of 50%. The smaller bar will also increase by 50%, meaning a
increase by 15 (50% of 30), resulting in a final value of 45. If you instead drag the
smaller bar (+ Ctrl) and move it from 30 to 60, it will result in an increase of 100%. The
larger bar will accordingly be increased to 120. In other words: The relation between the
selected values will remain the same when they are relatively changed.
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If you hold Shift while changing the value of a multiple selection, all of the selected
events will be set to the same new value.

Drawing tools

With the Freehand drawing tool (Mouse pointer: pencil) you can draw any number of
controller curves. With the Line drawing tool (Mouse pointer: crosshairs) you can create
a linear controller gradient (ramp). You can temporarily activate the Freehand drawing
tool with the Selection tool by additionally pressing the Alt key before clicking. The Shift
key temporarily activates the Line drawing mode when using the Selection tool as well as
the Freehand drawing tool.

Hint: If you edit velocity using the drawing tool, no new notes are generated; only existing
velocity values are modified.

Tips for editing velocity

In polyphonic events where multiple notes are played simultaneously, the bars appear on
top of each other, making it difficult to edit the end of a particular bar.

To edit only notes in a certain pitch, e.g. all C1 notes in the Controller Editor, click on the
respective key on the keyboard to the left of the piano roll. The key and the background
of the selected pitch are highlighted. Now only the velocity values of notes in this pitch
are displayed in the controller editor. This also works for several pitches. You can add
additional notes with Ctrl + click or create a range between two notes with Shift + click
on the second note.

This is simply a view option of the Velocity Editor. You can double-click the key to select
multiple notes.

Another option is to selectively edit velocity bars located on top of each other, since the
bar of the currently selected note is selected or edited using the mouse. First, click on the
note within the piano roll, or click on the bars located on top of each other and then
select the required note using the up/down arrow keys. You can then change the velocity
value by dragging out the highlighted (current) bar.

List Editor

In addition to note and controller events, which can be edited with the Piano Roll or
Controller Editor, MIDI objects usually contain other types of events, e.g. program
change commands (Prog Ch) to change the sounds in the software synthesizers. The
MIDI editor has an integrated display of all events in list format. Here, you can edit MIDI
data in detail.

91/216



Playing and recording MIDI synthesizer

This List Editor is opened either with a click on this button or by using the shortcut
"Alt+L".

Display fiter: oo ] The List Editor lists all MIDI events in tabular form.
001:01:000 b The time position in beat: quarter note: tick is at the
very front. Ticks are the 192 subdivisions of a quarter
note. After that is the event type, the MIDI channel,
and depending on the event type one or two data
fields.

When the List Editor is opened and activated for
editing it has a narrow red border. This makes it clear
that certain functions, for example, select
next/previous event (cursor keys) or the command
"Select All" (Ctrl+A), only refer to the list.

0010
001
001

Al

58 A#2
6 A1
Al

7 Note On
& Note On

(01:03:043 Mote On

1
1
1
1
1
1
1
1
1
1
1
1
1
1
1

[ Mute Controller [ Display note off

Mute Controller: MIDI controller commands can be filtered during playback.

Show Note Off: Each note contains a "Note On" and a "Note Off" event, which are
always selected and edited together, therefore, Note Off is preset as hidden. Use this
check box to see Note Off events.

Display filter: To edit specific events only, the List Editor provides a view filter for each
column. These are small check boxes above the list editor columns.

Select a representative event. This can be, for example, a note with a certain pitch. Then
click on a display filter for a specific column to only display events of this type, here with
the selected pitch. All other events will now be hidden.

Display filters can be combined with one another. This way, you can, for example, when
working with the "Select All" command (Ctrl+A), select and edit all control change events
of type 10 (volume) on MIDI Channel 6.

| To add special events use the button below the List Editor.

Select an event type in the list field on the left and click "Insert". The event will then be
added with preset parameters, which can be adjusted in the List Editor.
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Drum Editor
Clicking this button switches the MIDI editor to Drum Editor mode.

The same MIDI object content can be edited with the drum editor like in the "normal"
MIDI editor - you can access the same tools in both. The "Piano Roll" here is specially
adapted to edit drum sequences:

« For each pitch there is a drum editor track header instead of simple piano keys.
Here, you can assign a name to each drum instrument or rather to each pitch, as
well as set the output note and channel, grid and quantization settings, and velocity
scaling in %.

o Cell mode (794)is used. The display width for each drum event in a cell can be
individually set for each instrument as well as in the respective track header.

« Allindividual settings for each note can be edited as a whole in a drum map.

" Note: When you switch from drum editor mode back to the standard piano roll, you will
be asked if you wish to apply mapping (795) or not. If you add mapping, all mapping
settings will be applied to the MIDI object. For example: You changed the output value for
an instrument with a pitch of 35 ("Bass drum 1" in GM Standard) to 36 ("Bass drum 2")
in the track header. If mapping is applied, these notes will be replaced by corresponding
"real" notes with a pitch of 36.
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Cell mode

Cell mode serves to improve the overview as it limits the display to only the most
important information, note starting points and velocity.

Each time position of a bar is displayed as a row of cells in On/Off states. The note length
is not displayed, rather a unified display width is used. This way, it all looks similar to the
step sequencer of a drum computer (like the BeatBox).

The set quantization grid can be read from the width of cells. Swing and Offset settings
of the quantization options are also made clearer thanks to cells of various widths and by
repositioning.

The height of cells displays the velocity of the note. When drawing new drum notes the
velocity can be specified via the vertical drawing position within the cells. In connection
with the Drum Draw mode, increasingly loud drum rolls can be drawn in easily.

By clicking on the upper edge of a cell and dragging it vertically with the mouse, the
velocity can be adjusted directly without having to use the Controller Editor. In Velocity
Mouse Mode (Ctrl + 5) it's even easier; all you need to do is click anywhere on the cell.

Drum editor track header

Each individual note has its own track header in the drum editor. Here, individual settings
can be specified for each instrument. When zoomed out, each track header can be
increased in size with a simple click.

[SIM] 46 221 Open HiHat .

G110 KSo Selo Lo Woo

S/M: Each individual instrument can be played solo (S) or muted (M).

Note number: The output note from the instrument can be set here. This can be
different to the note currently displayed in the MIDI object so that individual drum
instruments can be substituted. To put the display of notes back into the usual order
(deep notes at the bottom, highs at the top), click on "Map" at the top and use the "Sort
Drum Map" command.

Instrument name: Double-clicking on this field lets you rename your drum instrument.
! Quantization options/Colors: Use this menu to assign any one of the eight different

colors to the cells of a drum instrument. The dialog for the instrument's quantization
options is also opened here.

The dialog is the same as for global quantization options (798), but the settings only
apply to the individual quantization options if an individual grid value is set for the note
as well.
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K Output channel

# Quantization grid, "Glo" refers to the global value (797).

L Note length, # corresponds to the grid value, "Glo" to the global value

Length of the notation, # corresponds to the grid value (i. e. the entire cell width),
"Glo" refers to the global value of the note length

V Velocity scaling: The velocity value of each note is multiplied by the value set here in
%.

Scaling is audible, but is not visualized further. The purpose of this setting is for adjusting

the volume ratio between the individual drum instruments. Software instruments usually

include their own mixers.

Drum Maps

Drum synthesizers usually respond to notes with different pitches and different sounds.
You're able to control an entire drum kit and an array of other percussion instruments via
one MIDI channel. Assigning a MIDI note to a particular drum sound is called "mapping".
A "General MIDI" map is used by default.

It may be the case that your synthesizer (regardless if real or virtual) uses a different
mapping setup. This means that when you play the drum event, the sound you wish to
hear may not be heard (for example, instead of a bass drum, you get a high tom). In this
case you must adjust the mapping. The settings for individual instruments can be
specified in the track header (the number/note value next to the solo/mute buttons).

For more extensive changes we recommend using the Drum Map editor (see below). You
can save your Drum Map as a file in the editor.

A project may contain various different Drum Maps. All Drum Maps saved in the project
can be selected via the menu. If you require a Drum Map from a *.map file, you will have
to load it into the Drum Map editor first so that it can be shown in the menu. You can edit
individual Drum Maps in the Drum Map editor.

E The Drum Map can be set in the drum editor by clicking on the list
field above.

You can also open the drum map editor in this menu.
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Drum Mep Editor X
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All Drum Maps that are available for the project are listed on the left. The Drum Map GM
General MIDI is always available to start off with.

New: This creates a new empty Drum Map.

Copy: A copy of the existing map is created. This way you can quickly create variations of
a Drum Map with various note allocations, which can then be toggled from within the
drum editor.

Load/Save: Use this to save a Drum Map (*.map file). This way you can use a Drum Map
you created for a synthesizer in other projects as well. All loaded maps will be displayed
in the "Map" menu of the drum editor.

Delete: Removes the selected Drum Map from the project.

Use the Name field to rename the selected Drum Map. The settings (mappings) of the
individual notes for each Drum Map selected will be displayed below this in table form.

Pitch: This is the incoming MIDI note.

Instrument: Displays the name of the drum instrument, for example, "Bassdrum 1".
Grid: If you like, you can set up a grid for the starting point of the drum events.
Length: In this field you can set the grid for the note length.

Output note: This is the note value to which the drum instrument (the incoming MIDI
note in the "Pitch" field) should be routed or mapped.

Channel: You can set up an individual channel for each instrument here.

Quantization options: This opens the dialog for the each instrument's quantization
options (798).

Instrument, grid, length ... apply to all: This applies the corresponding setting of the
selected instrument to all other instruments.
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Quantize

Small irregularities during recorded playing can be smoothed with the quantization
function. In contrast, mechanical sounding sequences can be made a little more groovy
by applying the "Swing" function.

3l Clicking on the Quantize button shifts all selected notes to a customizable
quantization grid. All notes are quantized without previous selection. Right-clicking
on the symbol opens the quantize settings (see below).

E 1/4,1/8,1/16 and 1/32 notes and corresponding triplets can be
selected as starting points (grid) and lengths.

g2 ]

The Quantize button always performs standard quantization (the note's start point and

length are preset). In the menu MIDI functions (7102) > Advanced quantization
provides other quantization modes (e.g. length only or Soft Q).

The quantization options enable the type and scope of the quantization to be set more
precisely.

Quantize grid

. If snap is activated, the notes "snap" to the quantization values when they are
created or edited.

The quantization values are also considered. For instance, the notes snap to the
corresponding positions within the quantization window.

The snap positions are displayed within the Piano Roll as a matrix. A swing quantization is
displayed by the different intervals of the vertical partitions in the Piano Roll. The grid
can be hidden with the "Show Quantization Grid" command in the options menu (Ctrl +
G).

You can deactivate the snap function while creating or editing notes by holding down
"Alt" as you draw them.

Move relatively on grid ("Options" menu): If this option is activated, notes keep their
original intervals relative to the grid and not to the note start when they are moved; the
distance moved snaps to the quantization value. Use this option if you want to move
unquantized notes a certain distance without disturbing the timing.

Soft Grid ("Options" menu): If this options is activated, the quantization options are
applied, e.g. when notes are moved they will only snap to the corresponding position
within the quantization window.

Keyboard shortcut: Shift + G
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Quantization settings

The quantization settings can be found in the menu "MIDI functions > Advanced
guantization" in the MIDI editor. The dialog with the settings is not "modal", i.e. you can
leave it open if you wish, and test certain passages with different settings.

Global Grid/Quantization Options X
| |||2|||||3|||||4|||2| |||2|||||3 |||4|
Show bars: -
Q Grid Q Length s
| 16 |v| | # |v| Beat signature Jnf
Options Humanize
Q Threshold E I'{ \I 10| [ Humanize |
O [x0) s
ar
Q Window Zeliil]
FiF () E
) =]
Swing I', \\I | Apply soft Q
() Lo .
Offsat Ir/_\‘l Settings for "Standard quantization"
p =g - .
| Start and length Q |' |
| Apply standard Q |
| Reset quantization | | | Default settings ] | | Help |

The selected quantization settings may be visualized in the top of the dialog. The blue
lines indicate the target positions for the quantized notes, i.e. the snap points. The gray
area around this show the quantization window, i.e. the target positions that are affected
by the quantization.

Q-grid/length: The quantization grid and length at the target points within the bar on
which the note start points or lengths move. (see above)

Q threshold/Q window: With the parameters Q threshold/Q window you can restrict
the quantization to certain notes in order to retain the genuineness of an MIDI recording.
The parameter "Q threshold" can be used to exclude notes from quantization that are
very close to the next snap point. Only notes that are far enough from the raster will be
guantized. Conversely, by reducing the "Q window" notes that deviate too much from
the raster can be excluded from the quantization. It is therefore possible, for example, to
guantize quarter and eighth notes and retain the sixteenth notes that lie between by
reducing the appropriate window.

In summary this means: Events less than the "threshold”-distance or more than the
"window"-distance from the grid point will not be quantized. The time range affected by
the quantization is indicated in gray in the dialog graphic.
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Swing: Starts swinging, groovy playback (for example, triplet). Specifies the division for
uneven grid points.

« 50...“50-50" division: The odd eighths are exactly halfway between the even
eighth notes (“even” playing method)

o 67... triplet playing method, 3-2 division

Offset: The value range in this parameter stretches from -100 to +100. By changing the
offset values, you move the whole quantization grid. Negative values move the
guantization to the left, i.e. forward in time; positive values move to the right, i.e.
backward in time. The maximum of 100 corresponds with an offset distance of half the
grid width.

Presentation of blue grid points in the dialog as well as of the grid in the MIDI editor
directly reflects changes to these values.

Humanize: The "Humanize" parameter creates another variation option, i.e. notes are
able to be assigned according to the randomization principle up to a specific interval to
positions around the exact quantization value. The setting occurs in % of a 16th note.
The specified value thus regulates the maximum possible spacing of the quantized notes
at the exact quantization value.

Soft Q: This value sets the strength or "Soft Q" value of the quantization.
« “100” moves the event precisely to the quantize grid point

o "50" shifts the event to the middle between the current position and the
guantization grid point,

« "0" means no movement, i.e. quantization off

The command "Soft Q" considers the current level value in the quantization options. The
simple quantization command always occurs at 100%. In this manner, you can always
select between approximation (soft) and hard quantization without having to adjust the
guantization options every time.

Standard quantization settings: Select from a list of quantization actions (see MIDI
functions (7102)), that are listed by clicking the "Quantization" button.

Reset quantization: All notes will be reset to their original positions.

Standard settings: Restores the default values.

Step Recording with a Keyboard or Controller Keyboard

In the MIDI editor, you can also carry out so-called "Step recording" using the computer
keyboard or MIDI keyboard. Step Recording means you can enter the notes with the
computer keyboard or another keyboard but you do not have to enter them in realtime.
You can allow for as much time as you like between notes.
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The notes are added with a predetermined length and after each entry the playback
marker moves one step farther. Step length and note length can be specified by the grid
and length quantization values. The note lengths cannot, however, exceed the step
lengths.

. Activate Step Recording with this button.

The playback marker shows the scope of the current octave for the following entries.
Now you can enter MIDI notes step-by-step. Push multiple keys simultaneously to enter
chords. The most important keyboard shortcuts for entering MIDI notes using step
recording:

TAB One step forwards (set pause)

Shift + Tab One step backwards

Page up/Page down Enter octave upwards/downwards
<yxcvbnm... (the precise keys depend on Enter notes in current octave (see Playing
the type of keyboard you have) instruments with the keyboard (7100))

Playing instruments with the keyboard

Open the MIDI editor to be able to play software instruments directly via the computer
keyboard. The assighment of the notes to the computer keyboard is displayed in the
following graphic.
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"Page up" and "Page down" move the octave up or down.

MIDI channel filter

You can control multiple instruments with one MIDI output via the MIDI channels. A
MIDI object can contain events in up to 16 channels.

Events in one object from all channels or only from selected channels can be played back
with the MIDI channel filter in the MIDI editor. To play back or edit events only from
certain channels, select the appropriate channels in the Options menu > MIDI channel
filter. Events in channels that are not selected will be filtered out. Play back all
deactivates the channel filter.

Events that have been filtered out appear in gray and can be edited using the selection
tool. They can be hidden with the command Hide filtered MIDI data in the Options
menu.

" Note: The list editor (79 1) provides additional filters (such as filter by event type,
controller number, Note Off events) that only function within the list.
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Using the MIDI channel filter

Completed songs in MIDI files as you would find them on the Internet usually contain a
complete arrangement in which various instruments are played on different channels
simultaneously. The standard software synthesizer for Windows that is used to preview
MIDI files (777) can receive MIDI on multiple channels and play several different sounds
at the same time. This is called a multi-timbral synthesizer.

If you load a MIDI file, it will load as a MIDI object on a single track. However,

MAGIX Music MAKER can only control one software synthesizer per track, and most
software synthesizers, also those available in MAGIX MusiC MAKER, can only play back
one instrument at the same time and are thus not multitimbral.

For this reason, duplicate your MIDI one beneath the other as often as there are different
instruments involved and set the corresponding Channel filters (7101) in the MIDI
objects ("Options" menu in the MIDI Editor) so that each object only plays the notes for a
single channel. Next, assign software instruments for the individual channels via the
Track menu (738).

You can quickly find out which MIDI channels events are assigned in a MIDI object by
adding the list editor.

MIDI features

The MIDI functions menu contains advanced quantization (797) and editing functions
for MIDI notes. The commands in the "MIDI functions" menu always affect the selected
events. If nothing has been selected, the functions are applied to all events.

Legato: If necessary, notes may be lengthened until the next note to be played in legato.

Quantize notes (default): A standard quantization will be used on all selected notes. If no
notes are selected, all notes will be quantized. The standard action can be defined in the
Quantization Settings Dialog (798). "Quantize notes (start and length)" is set as default.
This function can be accessed via the "Quantization" button in the MIDI editor.

Advanced quantization

This submenu contains additional quantization commands.

o Start Q: Selected notes will be quantized corresponding to the set grid quantization
value. Note lengths remain unaffected.

« Start and length Q: Selected notes will be quantized corresponding to the set grid
and length quantization values. Hard quantization always occurs at 100%.
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« Soft Q (Quantization approximation) : This command considers the current level
value in the quantization options. The simple quantization command always occurs
at 100%. In this manner, you can always select between approximation (soft) and
hard quantization without having to adjust the quantization options every time.

« Length Q: Selected notes will be quantized according to the set length quantization
value. The start time remains unaffected.

o Quantize Note Ends to Grid: The end of selected notes will be quantized according
to the set grid quantization value. The start time remains unaffected, but the note
lengths will change.

« Undo quantization: Use this command to reverse all completed quantization steps.
This works even after the project has been saved.

« Quantization settings: Opens the selection dialog for the quantization settings
(298).

Quantize controller events: Allows you to quantize controller events to reduce their
number.

Humanize: Use the Humanize function to make quantized notes sound more "human"
meaning less perfect. Notes will be moved to a random value. See Quantization settings
(298).

Mute Notes (Mute): Mutes and reactivates notes or selected note groups with a click.

Remove overlaps (polyphonic): Notes are shortened so that there are no longer any
overlaps. Chords (simultaneously played notes) are recognized and left uncorrected, i.e.
chords are not split up.

Remove overlaps (monophonic): Notes are shortened so that there no longer are any
overlaps. Forces monophonic voice leading.

Convert sustain pedal to note lengths: This function converts sustain pedal controller
events (controller 64) into note lengths. All notes which were started after a "Pedal
pressed" event (CC64 > 64) will be extended to the "Pedal released" event (CC64 < 64),
and the pedal events removed.

Menu reference MIDI editor

file

« Import MIDI: Load a standard MIDI file (*.mid) to the MIDI object. See Load and
save MIDI files (777).
« Export MIDI: Export the content of a MIDI object as a standard MIDI file (*.mid).

« New (Delete all MIDI data): Deletes all MIDI data in the object

103 /216


../../../../../Content/MIDI-Dateien laden und speichern.htm
../../../../../Content/MIDI-Dateien laden und speichern.htm

Playing and recording MIDI synthesizer

Edit
o Undo/Redo: The last editing function is undone or restored.

« Copy/Cut/Paste: Depending on the editor area, the copy actions can be used for
notes (Piano Roll), controller events (Controller Editor), or all events (List Editor).
You can copy and paste within one MIDI object or between different ones. Events
are inserted at the position of the playback marker.

o Duplicating: If the grid is activated, the notes selected in the Piano Roll are copied
and inserted from the next grid point following the selection. They are otherwise
inserted immediately after the selection.

« Select all: Select all events in the MIDI object. Depending on the editor area, the
selection includes notes (Piano Roll), controller events (Controller Editor), or all
events (List Editor).

« Reverse selection: All non-selected MIDI events are selected and selected events
will be deselected.

« Create pattern from selection: Selected MIDI notes are saved as a pattern. The
length of the pattern is quantized when the grid is active. Afterwards, the pattern
can be drawn in the Piano Roll in Draw pattern mode (787).

o Delete selected MIDI data: Selected MIDI data are deleted.
o Delete all MIDI data = File > New
« MIDI recording: Same as the REC key and starts the MIDI recording (785).

MIDI features
see MIDI Functions (7102)

Options
« Hide MIDI channel filter/filtered MIDI data

« Use velocity colors/Use MIDI channel colors: Changes the colors of the MIDI
notes from a graduated representation of the velocity values to different colors for
each MIDI channel.

« Scroll mode/Soft scroll mode: In Scroll mode (preset) the displayed section of the
MIDI object follows the playback marker. In Soft scroll mode, this is done
continuously, meaning the section moves behind a fixed playback marker.

« Show event list/Show Matrix Editor (Piano Roll)/Drum
Editor/Velocity/Controller Editor: Shows or hides the elements of the MIDI editor.
(corresponds to the functions of the buttons above in the MIDI editor)
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Step input

Play notes that have been clicked: Deactivates the playback of notes that have
been clicked or the piano keys on the left

Zones with restricted movement for notes: If active, the notes react differently to
the movements of the mouse, depending on where you click on the bar in the Piano
Roll, see Edit notes with the mouse (787).

Quantization grid active: Activates/deactivates the quantization grid (797).
Show quantization grid: Shows/hides the quantization grid.

Automatically quantize selection: If active, quantization takes place automatically
after recording.

MIDI Panic (End all notes): In rare cases, after a Note On event the corresponding
Note Off event may not be sent to the synthesizer and the notes "freeze". Use this
command to send Note Off events to all channels in all pitches.

Mouse mode

Mouse mode for editing events, see Piano Roll (787).

MIDI Editor shortcuts

Play/Stop Spacebar

Stop at position O (Number block)
Delete all selected events Ctrl + Del

Delete selected MIDI notes Del

Select all non display-filtered notes (piano roll) or events (list) Ctrl+ A

Mute notes Ctrl+M
Create pattern from selection Ctrl + W
MIDI recording Ctrl+R
Undo Ctrl +Z
Redo Ctrl +Y
Cut Ctrl+X
Copy Ctrl+C
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Paste

Duplicate

Imported standard MIDI file
Export standard MIDI file
Fade in/out Event Editor
Fade in/out Velocity Editor

Show Quantization grid

Mode selection
Drawing mode

Drum (Draw Mode)
Pattern (Drawing) Mode
Change velocity

Delete Mode

Magnifying glass

Quantize

Quantization options

Select previous note/event
Select next note/event

Play selected notes

All notes off

Grid on/off

Auto-scrolling during playback
Vertical zoom in

Vertical zoom out

Horizontal zoom in

Playing and recording MIDI synthesizer

Ctrl +V
Ctrl+D
Ctrl+l
Ctrl + E
Ctrl + L
Ctrl+T
Ctrl+K

Ctrl +1
Ctrl + 2
Ctrl+3
Ctrl +4
Ctrl +5
Ctrl + 6
Ctrl +7

Ctrl + Q

Alt+Q

Up/Left arrow
Right/Down arrow
Ctrl + N

Ctrl + P

Ctrl + G

Ctrl + F

Ctrl + Up arrow
Ctrl + Down arrow

Ctrl + Left arrow
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Horizontal zoom out Ctrl + Right arrow
Horizontal scrolling Mouse wheel
Vertical scrolling Shift + Mouse wheel
Zoom Ctrl + Mouse wheel
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Audio effects

MAGIX Music MAKER offers a variety of intuitive and customizable audio effects.

For editing the sound spectrum, there is a graphic 10-band EQ (7117) and a
parametric EQ (7123) with 6 bands.

The stereo processor (7122) lets you correct stereo width and direction.

Reverb (7112) provides an artificial room sound.

Delay (7116) creates an artificial echo.

The compressor (7117) lets you compress volume levels.

Filter (7125) and distortion (7124) let you add subtle to drastic levels of distortion.

The tempo pitch/resample (7118) effect can be used to change the tempo and
pitch of objects and you can use Vocal Tune (7119) to adjust the melodies of
recorded instruments and vocals (autotune).

The Vocoder (7125) can transfer the sound sequence from one audio signal to
another. You can use this to teach synthesizers to talk, or to create ghost voices.

Effects from third-party developers in VST format can also be used for effects editing.
Some of the included effects are plug-ins. MAGIX MusiCc MAKER contains the following
plug-ins:

Vintage FX Suite (7130) includes tiny guitar effects (also known as "stomp boxes")
and recreated standard effects, including Analog Delay, Flanger, Chorus, Vintage
Filter, Vintage Distortion and Bit Machine.

Essential FX, a collection of "bread and butter effects" for basic tasks. Includes efx_
StereoDelay, efx_Phaser, efx_ChorusFlanger and efx_VocalStrip (optional).

VandalSE (7141) - the "lite" version of guitar amp simulator MAGIX Vandal.

AM-Track SE (7129), an analog vintage compressor that produces an especially
warm, pumping sound.

Using audio effects

Audio effects can be added at different positions in the project, to individual objects, to a
complete track, or to the master (i.e. everything you hear).

The effect window's operation is the same for all three effect positions, which is why it is
described collectively below (7110) .
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Audio effects

Object effects

Object effects only affect individual objects and not the entire arranger track. This has
the advantage that you can use effects in a targeted and multifaceted manner.

For example, try adding a distortion effect to a drum loop, then cutting it into separate
beats and setting different sound parameters for each object.

To activate an effect for an audio object, double click on the audio object or select
the object and click on this button in the toolbar.

Right clicking on an audio object or going to Effects > Audio opens individual audio
effects which can be activate via menu commands.

Track effects

Besides the object audio effects, a separate track effects with an equalizer, reverb/echo,
compressor and the Vintage Effects Suite plug-ins can be used.

You can open the track effects window with the FX button in the mixer. A lit
FX track button signifies that effects are active in the track.

You can also open the track effects by going to the track
effects menu in the Arranger track header (738).

Track effects always apply to the entire audio output of a track. They can be used when
software synthesizers (758) serve as audio source, instead of audio objects.

Note: The Vocal Tune, Tempo-Pitch/Resample and Vocoder effects cannot be used as
track effects!

Master effects

Master effects influence the mixed sum of all audio tracks.

The master effects are opened in the mixer window by using the FX button
over the master volume control.

The controls work similarly to the object and track effects. The MAGIX Mastering Suite
(#7127)is also available to help produce perfect sound.
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Effects window

The effects window comes equipped with the most
frequently used effects. At first, they are deactivated and
Parametric EQ won't use up any computing power. Clicking on the effect
name opens the effect's interface.

Once you have selected an effect preset or have set the
parameters manually, the effect will be activated.

You can tell an effect is active if the on/off button is lit.

o Compressor

Vocoder

You can also use this button to temporarily bypass effects without losing their settings.

Clicking this button lets you activate additional effects.

This button removes effects from the window. Since deactivated effects don't use
up any computing power, this option is used mostly for maintaining an overview.

The effects unit interfaces are controlled by using slider controls, knobs and buttons. The

individual effect descriptions provide more detailed information. Several effects contain
two special features:

Sensor fields: Sensor fields allow you to control two
parameters at the same time by moving a circle around on a flat
surface. The horizontal and vertical positions correspond to the
parameters.

A/B: If you have selected a preset for the effect and make
: manual changes to it, you can compare the original preset

sound with the new settings using the A/B button.

Presets for individual effects

Each effect in the window has a range of presets that can be easily loaded by clicking on
them. You can scroll through the list with the mouse wheel. Some lists also contain
subfolders. Each list contains the Reset subfolder, which in turn contains the entries
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Standard setting and Settings before opening the dialog. You can use these to
completely reset the effect or reset it to its last value.

.
Presets:

The list can be hidden using the arrow to the right.

Tip: Presets often contain more effect parameters than are normally accessible through
the control elements of each effect. It's worth spending some time turning the knobs and
trying out the available presets.
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Templates

The folders for effects presets will be opened. Included and saved audio and video effect
presets, as well as title templates end up in these folders, so that over time, a complete
library of your own presets will be created.

|/
Using this symbol or the G key, you can open the Templates.

The buttons to the left open the folders for audio effects ("Audio FX"), title templates
("Titles"), and video effects ("Video FX").

These contain a range of presets for the most important effects and effect combinations.
The presets have a preview feature, which lets you here an example of the effect when
you click on it. You can drag & drop presets into audio objects in the Arranger.

You can also add effects by drag & drop. They can be dragged onto the corresponding
object using the mouse.

Tip: When an audio effect lands on the audio objects using the context menu, the dialog
for the particular audio effect (7108) will open and you can adjust it more precisely!

The current settings for each applied effects device in the object effects window can be
saved together as an effect preset, e.g. so that it can be used for other objects. To save
your own effect preset, go to Effects > Audio > Save audio effects. Your own templates
will also be available to you in the Templates window.

B8 You can find presets for track effects sorted according to the instrument type in
the track effect menu in the Arranger track header (738).

In this menu you can also save and load your own effect settings or completely reset the
track effects.

Reverb

The reverb effect device offers realistic reverb algorithms to add more room depth to
your recording.
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The Simulate space presets attempt to realistically replicate spatial impression, while the
Reverb presets create more artificial reverb effects.

You can control the sound of the reverb effect using the following parameters:

Room Size: Defines the size of the room (or the system for the plate and spring). The
larger a room, the longer the sound travels between walls or objects. With some low
"size" settings you can also reduce the distance between the individual reflections. This
allows resonance to develop (accentuated frequency ranges), which can sound
oppressive if the reverb sustain is too long.

Tone Quality: You can manipulate the sound characteristics of the effect to an extent.
The effect of this controller depends on the used preset. In rooms, "tone quality" controls
the dampening of the highs in the reverb (from dark to bright) as well as pre-filtering of
the signal. With plate and spring presets, this fader determines the dampening of the
basses as well.

Reverberation Time: With this knob you can adjust the reverberation time and
determine how much of it will be absorbed and, simultaneously, the reverb's decay.

Pre-Delay: The reverb portion ("Mix") and the early reflections play a big role in the
spatial perception of the sound. Here the time required for the perception of the early
reflection is know as "pre-delay". For sound sources that are close, the reverb portion is
usually low, and the early reflections reach the ear noticeably later than the direct sound.
By contrast, sound sources that are far away usually have a high reverb portion, and the
early reflections reach the ear almost simultaneously with the direct sound. The length of
the pre-delay can be used to influence the perceived "distance" between the sound
source and the listener.

Mix: This controller sets the mix ratio between the original and the edited signal. For
rooms, you can move a signal further into the room by increasing the effect share.

The basics

Our everyday experience shows that not every room matches every instrument. For this
reason, we've designed a number of "virtual" rooms. However, finding the right
parameters is still important. Here are some examples of parameters that are decisive for
the sound impression in real and virtual rooms:

« Size of room. The larger a room, the longer the sound travels between walls or
objects. Our brain "calculates" the size from the time difference.

o The size impression is mainly determined from so-called first reflections and the
discreet echo. We don't notice a (diffused) reverb.

o The reverberation time is mainly influenced by the composition of the walls,
ceilings and floors. This reverb time is highly frequency-dependent. For instance,
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the highs and mids are dampened more in rooms with curtains, carpets, furniture
and some corners than in an empty and tiled room.

« The density of the reflection. The sequence of the first reflection is particularly
important. A room with many individually recognizable echoes feels alive, especially
if they are quite far apart.

o Diffusion. Simple reverb machines do not take into account that reflections become
more and more complex as they develop. They blur the first echoes at the
beginning, which sounds artificial and "two-dimensional" for many signals. Our
reverb effect works like a real room instead where individual echoes can still be
heard at the beginning of the reverb but then reflect amongst each other more and
more until they fade out as diffuse noise within the reverb time.

The 24 presets include many rooms that were designed for certain instruments and
applications and whose internal parameters have been optimized for these applications.
However, you can influence most of the characteristics of the room using the sliders
provided.

In addition to the rooms, we have modeled two device types in the reverb effect that
allow you to create an artificial reverb for a longer time: Plate Reverb and Spring Reverb.

A plate reverb consists of a large metal plate (often 0.5 to 1m? thick or more), that is put
into motion by a magnet and coil system (similar to a loudspeaker). On the reverb plate,
"taps" are positioned at different locations. These are pick-ups comparable to those on a
guitar. Several of these taps are combined to make up a full signal. Reverb plates have a
very dense sound (high diffusion); no direct echo can be heard. They are therefore ideal
for percussive material. With vocals, a plate reverb can create a "feel-good" effect.

Spring Reverb You are probably familiar with spring reverb from guitar and keyboard
amps, particularly older ones. At the bottom of these amps a unit consisting of two to
four spirals is mounted on a vibration-free carriage. Like the reverb plate, it uses systems
for transforming the electric signal into a mechanical one and the other way around.
There are different designs and sizes of spring reverb; however, they all have the same
quite peculiar sound: the typical "bloing" sound when the springs are moved, similar to
splashing. When the reverb dies off, the basic pitch of the spring(s) can usually be heard
quite clearly. Furthermore, the frequency range is considerably limited due to the losses
in the spirals and used pick-up/transmitter. Despite this, or maybe because of this, the
sound is unique, and spring reverb is essential for the sound of certain music styles (e.g.
dub & reggae).

Presets

The presets represent the basic settings for the various room algorithms, which can be
still be varied along with the other parameters. In this respect, they are more than just
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parameter sets.

The presets are primarily sorted by instruments; however, you can (and should) choose
which preset you want to use for which instrument. The rooms in particular have
completely different characteristics which are noticeable for some and more subtle for
others. In general, we recommend reverb with many individually audible reflections and
slight diffusions for dense arrangements. On the other hand you can use Plate Reverb for
minimally arranged songs in order to create a richer atmosphere.

However, you should avoid adding reverb to too many instruments. Sometimes some
extra mixing is sufficient to move an instrument slightly away from the total sound. It is
often recommendable to adjust the sustain to the song tempo, i.e. the faster the track,
the shorter the reverb. Otherwise the sound easily sounds washed-out and indifferent.

Here is a list of the presets and their characteristics:
Drums and percussion
Drums: Studio A: Small room, high diffusion, good for percussion instruments

Drums: Studio B: Slightly larger & more lively than A, medium diffusion, distinct first
reflections, signals seem closer than those in A

Drums: Medium-sized room: Medium-sized room, moderate reverb, medium diffusion,
relatively few first reflections

Drums: empty hall: Medium-sized empty hall, medium diffusion

Drums: Snare reverb plate A: Plate reverb, high diffusion, relatively bright sound
character. Typical hiss of a reverb plate

Drums: Snare reverb plate B: Reverb plate, high diffusion, slight dampening of highs &
basses, sound moves more to mids over time, stereo panorama narrower than for A

Vocals

Voice: main hall A: Standard hall, e.g. for monitoring/recording, medium-sized room,
medium diffusion, minimum sustain time

Voice: main hall B: Like A, but as a small hall (longer delay times than A), more distinct
reflection pattern, longer reverb time

Voice: early reflections: Medium-sized room, low reverberation share, very distinct early
reflection pattern, e.g. for spreading vocals

Voice: warmer room: Small, intimate room, dark character

Voice: studio reverb plate A: Reverb plate with medium diffusion, slight dark
adjustment, comprehensive sound characteristics

Voice: studio reverb plate B: Like A, but more diffusion and bright to medium sound
adjustment, slight vintage character
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Voice: large hall: Large hall, medium diffusion, relatively long reverb time

Voice: cathedral: Delayed attack, slight diffusion, complex echo pattern, some hard
reflections, dark voice adjustment, long reverb sustain

Guitar

Guitar: Spring reverb mono A: Spring reverb simulation, typical oscillating sound of the
springs, limited frequency range

Guitar: Spring reverb mono B: Like A, slightly broader frequency range, greater diffusion

Guitar: Spring hall stereo A: Similar to spring hall mono A, but one spring/transmission
system per channel (L/R), as a result of the mechanical interlinking of the systems, the
reverberations meet at the middle of the stereo field

Guitar: Spring reverb stereo B: Like stereo A, slightly broader frequency range, greater
diffusion

Keys (piano, synthesizer)

Keys: Stage reverb: Larger room with stage, high amount of complex first reflections,
slightly delayed attack, medium reverberation

Keys: piano reverb: Concert hall, long reverberation, medium diffusion, minimum dark
adjustment

Aux (to be used as a send effect in a mixer FX track)

Aux: Room: Standard room for the aux path, mix 100%, medium-sized, medium diffusion,
some distinct first reflections, low reverberation

Aux: Hall: Medium-sized hall (100% wet), medium diffusion, short reverberation
Aux: Reverb plate: Reverb plate (100% wet), high diffusion, light bright adjustment

Aux: Spring reverb: Reverb spring (100% wet), stereo, high diffusion, slightly mid-range
sound characteristics

Echo

© @ @

Delay: This sets the period of time between the individual echoes. The more the control
is turned to the left, the faster the echoes will follow each other.
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Feedback: This adjusts the amount of echo. If you turn the dial completely to the left,
there is no echo at all; if you turn it completely to the right, there are seemingly endless
repetitions.

Mix: This fader determines how much of the unprocessed original sound (dry signal) is
subjected to the echo (wet signal).

Graphic equalizer

The graphic equalizer subdivides the frequency spectrum into ten areas (bands) and
equips them with separate volume controls. This makes it possible to create many
impressive effects, from a simple boosting of the bass to complete distortion. Note: If low
frequencies are boosted too much, the overall sound level is heavily increased, which
may cause distortion. In this event, adjust the overall volume downward by using the
"master volume" control situated at the bottom center of the effects rack.

Bullets 1-10: Each of the 10 frequency ranges can be separately made louder or softer
with the 10 volume controllers.

A/B: If you have selected a preset for the effect and make manual changes to it later, you
can compare the original preset sound with the new settings by using the A/B button.

Link: Using this feature randomly combines the frequency ranges with each other in
order to avoid artificial-sounding overemphasis of an individual frequency range.

Dynamics
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Dynamics is an automated dynamic volume control. It limits overall dynamics, maintains
the volume of loud passages so they stay loud, and increases the volume of low passages.

Processing is carried out using a "look-ahead" method, similar to high-quality studio
appliances. There are no peak overmodulations or other artifacts, as the algorithm can
never be 'surprised’ by sudden level peaks.

Threshold: Set the volume threshold, below and above which compression is applied.
Ratio: This parameter controls the amount of compression.

Attack: Sets the algorithm's reaction speed to increasing sound levels. Short attack times
can create an undesirable "pumping" sound, as the volume is quickly reduced or
increased correspondingly.

Release: Sets the algorithm's reaction speed to falling sound levels.
Gain: The gain controller amplifies the compressed signal.

A/B: If you have selected a preset for the effect and make manual changes to it, you can
compare the original preset sound with the new settings using the A/B button.

Tempo pitch/resample

This effect device changes the object’s speed and/or pitch.

Note: This effect may start automatically if you use loops with different original tempos in
a project or when you make changes to the project tempo at a later stage. This effect is
also used when you use the stretch mouse mode (750). You can find more information
about arranging in the audio object chapter, Change the playback tempo or pitch
(753).
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Tempo: This control changes the tempo independent of the pitch ("time-stretching"). The
object acts as if it were compressed or stretched on the track.

Pitch: This control changes the pitch independent of the speed of the object ("pitch
shifting").

+/- buttons: Use this feature to change the pitch in semitones.

Setup: This button opens a settings dialog where you can set the algorithm for tempo and
pitch correction.

« Elastique Pro:This algorithm is used by default and provides optimal results for
most audio material.

« Elastique Efficient: This is a version of the algorithm that saves computer power
and has reduced sound quality as a result.

« Monophonic voice: This is a special algorithm for vocal solos, speech or solo
instruments. It is also used for the Vocal Tune Vocal Tune (7119) effect.

« Resampling: This effect corresponds with faster or slower playback of records or
tapes. Every change in tempo results in a simultaneous change in pitch. This
function requires very little processing time and is a popular design element for
"Mickey Mouse" voice effects or drum loops, for example.

Note: Other algorithms (e.g beat marker stretching) are available for older soundpool
samples. These ensure that older MAGIX MusIiC MAKER projects sound exactly the same
as before in the new version of Movie Edit Pro. However, these algorithms cannot be used
once the sample has been changed to the default Elastique algorithm and the settings
dialog has been closed.

Vocal Tune

The Vocal Tune effect can be used to edit the pitch progression of an audio object. On
the one hand, it is possible to rebalance "distorted” vocal passages. Depending on what
you want, this can be as inaudible as possible or even drastically distorted.

It is also possible to completely change the melodic line into a piano roll (see MIDI Editor
(283)).

To customize the pitch correspondingly, the original pitch of the audio material must, of
course, be known. Fundamental to the functionality is therefore a preliminary pitch
analysis of the material. This is basically only for tonal, monophonic audio material like
solo vocals, solo instruments, and speech. Polyphonic material, effects such as reverb or
chorus and background noises do not provide good analysis results.

The analysis function starts automatically when the vocal tuner is opened. For larger
objects, the analysis can take longer. After the analysis the audio object is divided into
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individual slice objects according to the detected pitches; a slice object corresponds more
or less to a sung note. If the pitch deviations within a note are too large or the audio
material contains noisy components that interfere with the analysis, this also results in
two or three slice objects per note.
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0 Slice Object: The mid pitch of a slice object determines its position in the graphic
independent of the set progression of the pitch inside the slice object.

e Pitch Curves: The resulting pitch progression is displayed with a yellow pitch curve.
The original pitch progression is displayed as a blue curve.

6 Selected Slice Objects can be edited with the Move Tool. (see below)

0 The vertical axis is the pitch, the corresponding notes are displayed as a piano
keyboard on the left border. Individual keys can be removed from the pitch grid (see
below) by clicking on them (displayed in gray).

6 Similar to the arranger (745), the displayed time section or the pitch range can be
controlled with the +/- buttons and the scroll bar.

@ The play and stop buttons at the bottom left can be used to start and stop the
playback of the project. S causes the audio object to play solo in the Vocal Tuner.

6 Tools for editing pitch (see below)

@ »4Auto” Automatic pitch correction

9 ,Reset” removes all edits and returns all settings to their original status.
@ Activates the pitch grid for automatic pitch correction.

GD The Naturalness slider sets the intensity of the automatic pitch correction

@ ,Bypass” temporarily deactivates the effect

120 /216



Templates

Editing Pitch
There are three tools available for editing pitch:

k ok Va Move tool: You can use this tool to select slice objects for the editing by
simply clicking on them.

Ctrl+click enables the multiple selection of individual slices. Clicking on an empty area of
the editing window and dragging a selection frame is another method for selecting
several slice objects simultaneously. Selected slices can then be moved vertically, i.e.
moving the pitch.

If "pitch grid” is active, the slice objects always snap precisely to the

semitones of the chromatic scale.

To limit the snap function to specific keys (e.g. G minor) individual notes on the piano
keyboard can be deactivated by clicking on them. The slice objects will then snap to the
next "allowed" semitone.

On the borders of the slice objects two handles are created on the pitch curve. These
handles can be moved in order to produce an increasing or decreasing pitch characteristic
while retaining the small changes in the basic frequency (vibrato).

The handle at the end has been moved up to create a rising pitch progression. The small
pitch fluctuations remain intact.

Double-clicking on an individual pitch slice makes it possible to enter the pitch more
precisely in a +/- cent deviation from the corresponding semitone.

N o / Cut Tool: You can use this tool to cut slice objects and create two slice
: objects that can be edited separately. This does not affect the pitch of
the slice object.

It is possible, however, that a slice moves when cutting because the pitch of a slice
displayed is only ever an average value across the total pitch progression within the slice.

k ol Va Draw Tool: This tool can be used to directly draw the pitch curve. If you
hold the Shift key while drawing, a straight line will be drawn between
the start position of the drawn curve and the current mouse position.
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If a pitch curve extends beyond the borders of a slice object, the two slice objects will be
joined together.

Automatic Pitch Correction

The "Auto" function for automatic pitch correction can be found beside the draw pitch
function. The Auto button moves all selected slice objects to the next semitone.

Single notes can be deactivated by clicking on their respective keys on the piano
keyboard. The will result in the note being moved to the next available semitone during
the correction process. This makes it possible to limit the automatic correction to specific
notes in a key.

The "Naturalness" slider determines how much the original pitch progression is retained.
With small values, the natural vibrato of the voice is radically "flattened” and the famous
"Cher effect” results.

Stereo Enhancer

With the Stereo Enhancer you can determine the positioning of the audio material in the
stereo balance. If the stereo recordings sound unfocused and undifferentiated, an
extension of the stereo base-width can often provide better transparency.

Use the maximize feature to move the echo (e.g. into the foreground) and improve the
stereo picture.

o Volume controller: Adjusts the volume of every single channel, thereby adjusting
the entire panorama. The reduction of left and right levels is displayed under the
control buttons.

6 Panorama: Use this controller to move the sound source from the middle into stereo
panorama. The signals at the outer edges of the sound picture remain unchanged.
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6 Bandwidth/maximize sensor field: Adjusts the base width between mono (extreme
left), unchanged base width (normal stereo), and maximum base width (wide,
extreme right). Raising the bandwidth (values over 100) diminishes the mono
compatibility. This means that recordings edited this way sound hollow when

listened to in mono.
Maximize strengthens the spatial component of the recording, which also increases

the stereo transparency without influencing the mono compatibility.

@ Multiband: This can be used to switch Stereo FX to Multiband mode. Stereo editing
only applies to the middle frequency, the bass and highs remain unchanged.

6 Stereo meter (correlation gauge): This provides a graphical display of the phasing of
the audio signal. You can use it to check the alignment of the signal in the stereo
panorama and the effect of the stereo enhancer. To maintain mono-compatibility,
the "cloud" shown should always be higher than it is wide.

Parametric EQ

The parametric equalizer has six filter bands that you can use to shape the sound of the
music track. Each band is a filter with a typical "bell shape". Within a certain frequency
range around an adjustable middle frequency, you can increase or reduce the signal level
gain. The width of this frequency range is called bandwidth. The bandwidth is defined by
the Q value. The higher the Q value, the narrower and steeper the filter curve.

You can influence the basic sound of the mix by boosting or cutting specific frequency
ranges (low Q value) to give it more "depth" (lower mids 200-600 Hz) or more "air" (Highs
10 Khz). You can also decrease very specific frequencies (high Q-value) to remove
unwanted noise.

o Sensor field: The sensor field displays the resulting frequency response of the
equalizer. The frequency is displayed horizontally and the increase or decrease of
the respective frequency is displayed vertically.

e Spheres 1-6 in yellow symbolize the six frequency bands. You can move them
around with the mouse until you find the frequency response you want. The
bandwidth (Q value) can be adjusted using the mouse wheel.
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e The faders under the filter graphic display the parameters of the currently selected
band. You can use the knobs to set the values for each band more precisely:

6 Frequency: The center frequency of the individual bands can be set between 10 Hz
and 24 kHz with the frequency controller. The freedom to select frequency enables
you to set multiple filters to the same frequency in order to have a greater effect.

6 Gain: This controller allows you to raise or lower the filter. Setting the controller to O
deactivates the frequency band so it does not use any processing time.

@ Q factor: Here the Q factor (bandwidth) of the individual filters can be set.

9 Band 1 and 6 are special in that they can be operated using three different filter
curves.
G Peaking: This is the same bell shape used for the center bands.

( Shelving (basic setting): Starting from the set frequency, there is a gentle
~increase or decrease in the frequencies.

'\\ High-pass and low-pass: Starting from the set frequency, all higher and lower
- frequencies are filtered out.

9 It is possible to control the output level of the equalizer with the Peak Meter, and
with the output amplification beside it you can balance level changes resulting from
EQ adjustments.

Distortion

This is a distortion tool that overmodulates the audio object.

Gain: With these faders you can specify the degree of distortion.
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Cut-off frequency: Here you can set the frequency range you want to distort A specific
frequency band will be made stronger with a bandpass filter. The filter deactivates if the
cut-off frequency is set to 100%.

Threshold value: You can have the distortion applied once the level exceeds a certain
threshold value, so that quiet signals remain undistorted.

Volume: Here you can set the volume of the distortion. This allows you to even out a
stark increase in volume which can be caused by the distortion.

Tip: Be sure to try out Vintage Distortion (7137) or the VANDAL SE (7141) amp
simulator for authentic guitar sounds!

Filter

Note: This effect is only contained in MAGIX MusiC MAKER for the sake of compatibility
with older projects. You can get better results by using the parametric 6-band EQ
(7123) or the Vintage Filter! (7134)

The filter controls the volume of specific frequency ranges similarly to the Equalizer. You
can use the filter to completely suppress frequencies, which can in turn create quite
strong distortions.

Frequency: Here you can set the frequency you want to filter.

Level: Here you can set the strength of the filter. The frequency can be increased or
decreased.

Q factor: This sets the filter Q factor. This defines the filter bandwidth around the
frequency to be increased.

Volume: Here you can even out volume differences resulting from the filtering.

Vocoder

The vocoder works as follows: Carrier material (e.g. a string instrument pad or synth
chord) is affected by a modulator (e.g. language or singing) to give the impression that the
pad sound is “speaking” or “singing”. Additionally, rhythmic pads can be created by
modulating an area with a drum loop.

This works by transmitting the modulator's frequency characteristics (language) to the
carrier (chord).
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Select the carrier signal for the vocoder here. Click the arrow button to select one of
the predefined carrier samples in the list field. The carrier sample can be previewed
via the small "Play" button. Another carrier sample can be loaded via the folder icon.

By switching to "Track", the output signal of another of the project's tracks can be
used as the carrier signal.

Carrier

Modulator

By clicking the double-arrow button you can swap carrier and modulator signal. The
object's audio signal will then be modulated by the selected sample or track signal.

9 Set carrier signal volume with the "Carrier input" in the middle.

6 Material containing all frequencies in equal amounts, such as strings, orchestra
chords, broad synthesizer pads, hissing or wind noise, are particularly suitable for
carrier samples. If this is not enough, additional white noise can be mixed into the
carrier signal with the "Carrier Noise" fader to improve speech clarity.

6 Filter graphic: Here you can draw any frequency progression you want with the red
line in order to optimize the vocoder output. For example, you can get rid of
disruptive bass frequencies by adjusting the curve downward in the left area. Or you
can boost weak highs by adjusting the curve upward in the right area. The yellow
line shows the frequency curve without filters, the blue line the frequency curve
with filters.
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@ Dynamic reduction: Influences the dynamics of the modulator signal to reduce the
modulation depth of the vocoder. This prevents two often undesired side effects of
modulation. On the one hand the volume change of the modulator signal is added to
the output signal in a slightly more moderate form, which may improve the power of
the vocoder voice. On the other hand, the low-level portions of the modulator signal
are ignored in order to prevent modulation of the carrier by breathing or noise.

9 Dynamic release: Influences the speed of adjusting the vocoder to the modulator
spectrum. As this value increases the vocoder starts to follow the modulator more
slowly resulting in softer, reverberated sound changes in the carriers.

@ In the Mixer you can also mix parts of the carrier and modulator signal to the
vocoder output signal. If the output signal of a track is used as a carrier in the
vocoder, this track will first be muted. In the vocoder mixer you can then make it
audible again.

MAGIX Mastering Suite

MAGIX Mastering Suite is a special effects rack for use with the mixer master channel.
The effects in the Mastering Suite are used as part of the mastering process, in which the
mixed music piece is given a final polishing.

Auto Mastering

The Auto Mastering feature enables you to automatically apply the sound of typical
musical styles from the past and present (e.g. '70s disco, '90s club, jazz etc.). The sound of
the source material is analyzed and appropriate equalizer and dynamic effects are

applied.

Start by choosing a musical style.

MAGIX Music MAKER will analyze the audio material in the project.
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The Auto Mastering results will be played back immediately. You can now click through
the different styles to compare them.

Selecting "Original" allows you to compare the edited version with the original.

Stereo processor / parametric EQ

The stereo processor (7122) and the parametric EQ (7123) in the Mastering Suite are
identical to those in the effects window for objects, tracks and the master.

MultiMax

Multimax is a compressor with three independent frequency bands. The dynamics are
edited separately for each band.

The advantage of a multi-band compressor versus a "normal" compressor is that the
"pumping" tendency and other unwanted side effects are dramatically reduced while
editing the dynamics. For instance, it can prevent a bass top peak from "dragging down"
the entire signal.

Multiband technology also lets you specifically edit individual frequency ranges.
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Setting the frequency bands: The settings of the frequency bands are changed directly
in the graphic. Simply click on the separator lines and move them.

Lows/mids/highs: These knobs control the level of compression for each frequency
band.

Link: When this button is activated and a fader is adjusted, all other faders are changed
proportionally. However, the way the dynamics are edited is not affected.
Presets:In MultiMax, you can use Presets 2 to open further special features:

« Cassette NR-B decoder: MAGIX MusiCc MAKER simulates decoding of Dolby B + C
noise suppression if a Dolby player is not available. Cassettes recorded with Dolby
B or C sound more muffled and dull if played back without the corresponding
Dolby.

o De-esser: These special presets help to remove overemphasized sibilants from
speech recordings.

Analogue Modelling Suite: AM-Track SE

AM-Track SE is a purely analog compressor simulation. The tape simulation contained in
the full version (Analog Modeling Suite AM-Track) is not included. This is used primarily
for so-called "tracking", i.e. editing individual channel strips or subgroup signals.
Compression uses the "vintage" setting - an additional "VCA" mode is available in the full
version. The plug-in recognizes the number of incoming signals and, if necessary, edits
the signal in mono.

Am-Track SE limitations compared to the full version:

« No tape simulation

o No "VCA" mode in the compressor, only "Vintage" mode can be implemented along
with the presets

o Some expert compression settings are integrated in the interface, parameters:
"ahead" (pre-delay) and "adapt release" (switchable release automation) are missing.
(Release automation is always activated in the SE version which corresponds to the
set value of the mid position of the 'capacity' controller.)
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Vintage mode

In this mode, you can intuitively (by ear) use the dynamic editing features with just three
knobs. You can edit as much as you want, but keep in mind that less is often more.

Drive: You can use the "drive" potentiometer to control the amplification factor in
the feedback loop, i.e. the signal strength which the detection circuit calculates.
Furthermore, the internal 'ratio’' changes within a limit, the more 'drive' there is, the
higher the compression ratio.

attack and release: The same basic conditions as in VCA mode apply here.
However, not only do you change the actual control response time after detection,
but also the 'temporal window' in the detector. Additionally, the feedback
arrangement method does bring about a certain amount of unpredictability. You
should expect less control over the device in this mode, but more leniency on its
part.

Detector hp filter: This high-cut filter is positioned before the two compressors'
detection circuit. You can use it to specifically exclude basses and mids from these
rules. Complex signals with bass and hi information such as a subgroup or complete
mixdown tend to produce less pumping artifacts. This is because low frequency
signals have the most power and would thus always trigger the regulation and
modulate other frequency ranges in the volume.

Auto makeup gain: Normally, you have to continuously adjust level reduction to
generate "compression" at the same maximum level. This is done by activating auto
makeup gain. The volume difference expected from the set working parameters is
determined and applied as an output factor after master regulation. If you prefer to
adjust the "classic" level reduction and amplification manually, you can deactivate
this function.

Mix: Parallel compression is a popular "studio trick", particularly with complex
material. Adding the original signal retains the transients and spectral balance of the
source. You can add compression by turning the mix controller. A "mixed" signal is
particularly discreet, more transparent, and less "squishy" with vocals, whereby the
compressed part usually has a higher level reduction than without adding the
original.

Vintage effects

If you're a guitar, bass or keyboard player, you'll probably recognize the look of our
"vintage effects" suite. They are accurate digital models of analog "standard effects" used

130/216



Templates

by live musicians. Although we have adopted the appearance of stomp boxes and have
given these effect a typical analog sound they are ideal for studio use.

All effects of the Vintage Effects Suite are subject to a soft rule behavior - internally,
parameters are softly faded from the old to the new value. This is particularly noticeable
when playing live.

Analog Delay

MODULATION FILTER FEEDBACK
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This delay offers creative playing along with common delay effects. "Analog" in this case
means, for instance, that you can change the delay times while playing without the risk of
typical, scratching artefacts developing. Instead, the times are softly faded out, similar to
the old tape echo machines that used the tape speed to change the delay and where the
system also had a certain sluggishness.

"Analog" in terms of this delay also means that typical tape echo sounds can be mimicked,
e.g. tape speed fluctuations and loss of highs during playback ("feedback"). The feedback
has a two-band filter that can be used to create dark, bright, or mid repetitions depending
on the settings.

These properties can be useful, for example to create dub/reggae-style echoes that move
towards the center of the sound with each repetition and even drone slightly. In this case,
"analog" means that you cannot digitally overdrive the delay. Even in a "looped"
repetition, the signal cannot be distorted indefinitely, but is increasingly compressed and
distorted similarly to a tape.

Analog delay parameters

Delay Type

Delay Type (L+R): The delay times can be controlled separately for left and right (see
below). You can choose a note value for the control pots to snap to. Even and
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syncopated note values from 1/2 to 1/32 are available. Note that the delay times are
always in relation to the project's current tempo.

K& Link button: Press this button to control the "delay type" pots for both channels
simultaneously.

Mix: Adjusts the ration between the original signal and echo.
Modulation

Speed: The speed of "wow and flutter" variations. Low-speed variations (wow) result in
very light fluctuations, high-speed values (flutter) result in drastic warbling.

Depth: The intensity of variations. If the control is turned all the way to the far left then
there is no pitch modulation. For a subtle "analog" feel we recommend that the controller
setting is at somewhere between the 9 and 11 o'clock position.

Filter

"Low" BB This control progressively reduces the bass frequency as it is turned to the
right, making the signal sound "thinner".

"High“ B Here the inverse is the case, i.e. the control only attenuates the treble very
lightly; turned completely to the left, the delay repetitions become
progressively less treble.

Feedback

Width: This controls the stereo width of the delay repetitions. The "Stereo effect" does
not only work when the values of both of delay type controllers are different, but also
when the settings are the same. This happens because the delay switch functions
internally with minimal drift between both channels to create the effect of more space.

When you turn the width function to the right, an additional effect is produced: the
panning of the delays increases. This is commonly known as the "ping-pong" effect,
which in turn increases the spatial quality of the sound.

Drive: You can define repetitions here. When turned to the left, only a single repetition
will occur (feedback is inactive). Turned to the right, the feedback is virtually unending, it
takes a very long time for the repetitions to die out.

The actual strength of the effect is dependent on the material as the feedback loop is
compressed and applied with a tape saturation effect. If you send a loud signal to the
delay, the feedback will last longer than at a lower input level as compression "brings it
up" to a certain level. If you are used to "purely digital" delays this might take a short time
to get used to. However, the results will most probably sound "livelier".
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Flanger
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The flanger effect is similar to that of the chorus, but has a different technical and
historical background. It came about by chance when someone (according to legend,
John Lennon) slowed down one of two running interconnected tape machines in a studio
with their hand. A rather brief delay of the second signal compared to the first resulted in
cancellation within the frequency spectrum, leading to a comb filter effect (since the sum
of both signals creates peaks and valleys in the spectrum that look familiar to the teeth of
a comb).

Flanging is basically a chorus effect, but it has a lower delay time (less than 10 ms).
"Release" or signal doubling is not the focus here; the result is a much more creative
frequency response deformation.

A "complete" flange effect will definitely require feedback, where the flange part is sent
back to the input to increase the effect. People often talk about the flanger's "jet effect",
since it resembles a plane on take-off.

Flanger parameters

Speed: As with Chorus, you can define the modulation speed here.

Depth: The amount of modulation in terms of the entire sound.

Feedback: The extent of the internal feedback.

Mode: As with the Chorus effect, there are four different operating modes:
Normal: One consistent flanging effect.

Dual:2-voice, across left and right in panorama. As with the chorus, modulation and delay
between the voices are independent.

Quad:4-voice, alternating between left and right in panorama.
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Quad Pan: Like Quad, but the additional depth control determines how the intensity of
the signal traveling in panorama (between left and right).

Filter

Like chorus and flanger, "filter" is a modulation effect. However, it controls the frequency
response of a modulation source as well as the pitch. There are various filter types and
modulation sizes available for this.

Possible areas of application are synthesizer sounds (filter sweeps on pads) or creative
distortions of drumloops (e.g. for variations, fills, etc). With guitars you can create typical
'wah' effects: either by tempo modulation or in a special mode, modulation via the
envelope curve. The decisive factor is the current signal strength above the frequency set
for the filter.

Filter parameters

Speed: The modulation speed. This is adjustable in note values from 1/1 to 1/16, either
straight or dotted. As with the delay effect the tempo information is removed from the
project.

A distinctive feature is the last stage of the controller: ™

The tempo synchronization is deactivated and the modulation from the signal level is
controlled.

Freq: Here you can define the start frequency of the filter modulation. This is generally
carried out above this frequency, i.e. the filter frequency is increased by the modulation.

Depth: This fader adjusts the modulation depth, i.e. how much the speed fader (called the
"envelope curve mode" above) moves the input frequency upwards. If you want for
example a "maximum" effect turn "Freq" to the far left and "Depth" to the right.

Filter mode
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Low A steep 24 dB octave filter with some resonance, which greatly restricts
pass the highs above the input frequency. Potential use: For filter sweeps for
synth interfaces and drum loops.

Band E Only the frequencies around the application point are let through (24 dB
pass with resonance). Suitable for "wah-wah" effects on guitars for example.

Notch E Two parallel filters (-36 dB) with separate frequencies, which move
together and provide frequency response in two notches. You can use this
to create some interesting sounds e.g. with guitar chords. This effect may
remind you of a "phaser".

High Basically, the opposite variation of the low pass. Frequencies below the

pass application point are sharply reduced. Due to the tempo-based thinning
out of sounds you can place emphasis on individual sections (e.g the
drums), especially if the full spectrum is subsequently available (for
example, when the following object doesn't have a filter).

Chorus

The chorus pedal creates characteristic "floating" sounds which one typically recognizes
from guitar or synth pads. You can add acoustic "depth" to an instrument to add more
power to the sound or to create the illusion that it exists multiple times.

The chorus sound is created by using the so-called Doppler effect. You probably have
noticed this phenomenon in day to day life: the sound of an approaching ambulance
sounds higher than when it is moving away. This effect is a result of the speed of the
sound which first increases and then decreases, thus also changing the sound pitch. If
there were a second siren at your location, an oscillation would develop between both
sounds (just like when two instruments are out of tune).

Chorus also splits the signal in at least two: direct sound and effects part. The double
effect is created by a short signal delay of the effect.
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This delay is within the range of 10-30 ms (as in this one), this means that it is short
enough to be perceived as an "echo". The times would also be similarly short if you were
to double a guitar track for instance. A short delay in the mix already sounds "doubled"
but is not authentic. This is where the above-mentioned "out-of-tune" effect comes in:
The pitch of the effect signal is slightly modulated by gently "drifting" forward and
backward in the delay curve. The result is a floating effect where the speed is influenced
by drifting

Chorus effect parameters

You can enter the following parameters to control the floating effect:

Speed: The modulation speed. Slow times create a quiet, continuous beat; high speeds
however sound like vibrato or, in extreme cases, like it's under water.

Depth: The modulation depth. This describes to what extent the speed affects the pitch
modulation. At max, the amplitude is at its largest; in the minimum position, the effect
remains static.

Mix: Here you can set the mixing ratio between the direct and effect signal.
Mode: You can choose between four operating modes of the Chorus effect:
Normal: A combination of the direct signal and the detuned delay signal.

Normal, low cut: Like "Normal", but the bass is trimmed in the delayed signal. For
example this is advantageous for bass guitars because the "down low" the sound remains
clean and defined but the effect is noticeable in the mids.

Dual: Delivers a combination of direct signal and two delayed and off-tune parts. These
two "voices" are modulated independent of one another and possess different delay
times. This makes the character of the sound livelier than with a single voice only. It is
also distributed over the stereo panorama so that this mode sounds "broader".

Quad, low cut: Here four voices are active, which, like in "normal, low cut" mode begin to
have an effect in the mids range. Ideal for example when creating deep "Synth pads" with
tight bass frequencies.

Tip: Clicking on the "rubberized" surface of the pedals (under the logo) turns the A/B-
comparison effect on and off, just like with "real" models. Incidentally this applies to all
effects in this suite.
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Distortion

The distortion pedal is a "high gain" distorter for crunch and lead guitar sounds. If you like
typically "British" amp sounds and want to quickly record a guitar track with little effort,
this pedal is for you.

An entire valve pre-amp circuit has been modeled, including the typical EQ curve. The
amplification is "valve-typical", i.e. it doesn't start quickly but is harmonic and soft. Even
at full power the pedal still reacts softly to a guitar and its settings (e.g. pick-up choice
and tone controller). For instance, you can influence the distortion even more by using
the volume knob on the guitar.

Distortion parameters

This effect only has three parameters; however, you can have them interact with each
other to generate quite a variable sound:

o Low: The "bass" controller. This allows you to define the amount of bass before or
after distortion. The type of prefiltering is important for guitar amps in particular,
and is characteristic for the basic sound. You should set the bass controller
depending on the basic sound of the guitar and the sound you are aiming for
("powerful" or "cut").

« High: Mainly controls the share of highs before and after the distortion. If you are
not using an external guitar speaker as a monitor, we recommend setting the
controller to the middle position or even moving it slightly to the right. This way the
"sharp" highs disappear, which all guitar amps generate without the suitable
loudspeaker. At the same time the mids stand out more, which gives the sound
more "kick". On the other hand you can further emphasize the highs if you want the
sound to be more neutral.
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o Drive: The level of distortion. This controls the amplification used to operate the
"virtual valve circuit" (max. 60 dB). As the level increases, the valve goes into
overdrive and generates typical distortions. For a slightly distorted sound
("crunch"), it's sufficient to set the controller to 10-11 hours at maximum; the
modeled circuit also provides the usual "weight" for power rock chords, and more.
The further you turn this controller to the right, the more the mids of the signal
move to the fore so that the "high-gain" lead sound is better heard.

~ You can also use the distortion effect in combination with the amp simulation!

BitMachine

oTT

Audio material can always be edited in high quality with MAGIX MusiC MAKER. There are
sometimes cases where, for example, an "imperfect" lo-fi sound would work perfectly
with a drum loop or a synthesizer sound.

Remember that the first hardware samplers from the '80s that usually only ran at 8 or 12-
bit rates and at low sample rates. With BitMachine, modifying the sound to create an
"antique" vibe is simple.

You can use the BitMachine to bring back to life the times when minimalist and scratchy
sound chips in home computers were commonplace.

The BitMachine opens up a gateway to "acoustic time travel" where you can encounter
bit and sample rate reduction and downstream filters based on analog models.

The effect also has a modulation section with which you can control individual
parameters using an oscillator (LFO) or the input signal.

Reduction

Bits: This dial controls the resolution of the audio material. Turning the dial to the left
results in 16-bit quantization, and thereby CD quality. The further it is turned to the right,
the lesser the signal dynamic becomes. In extreme cases (1-bit), there are only "on" or
"off" states.

In the intermediate levels, you'll notice an increase in the background noise and a
decrease in the dynamics. For example, 8-bit quantization will exhibit dynamics of only
48 dB. Quieter points in the material sound noisy and very quiet points sound "capped".
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This effect is amplified the more you turn the dial to the left, until it starts crackling or
"groaning".

Sample rate: The audio material is calculated with this dial to reduce the internal sample
rate. Here, a new separation ratio between old and new rates is created and a sample
from the data stream will be "dropped" at the various points in accordance with this ratio.

Note: The two smaller dials from this section are explained under Modulation.

Filter

The filter in the BitMachine is a digital model of one of the most well-known filters in
music electronics. The filter in question is the "Chamberlin 2-pole" filter, which was used
in old Oberheim synthesizers. These types of filters sound exceptionally musical. They
can also be used in quite creative ways in the BitMachine and don't necessarily have to
be used only to smoothen out artifacts.

The filter works in low pass mode - according to the settings, it lets through low
frequency (or medium) material and dampens the highs and medium ranges.

Freq: With this dial, you can specify the cut-off frequency of the filter. Filtering starts
above this frequency.

Reso: The signal in the range around the cut-off frequency can be significantly increased
("resonance": to just below the self-oscillation) using this function. This makes sharp,
cutting sounds possible. The effect becomes even clearer when you vary the cut-off
frequency.

Drive: Both of the individual filters of the connections mentioned above have the ability
to overmodulate themselves internally. With the "drive" dial, you can regulate the
amount of overmodulation. The more you turn up this dial, the more the signal is
overmodulated. What happens is that the parameters of the internal workings of the
filter interact with one another. So increasing drive weakens the resonance, but at the
same time, the signal receives more volume, more bass and becomes acoustically fuller.

Note: The two smaller dials from this section are explained under Modulation.

Modulation

You can automate your effects via the settings in the Modulation section.

Here, you'll find what is known as a low frequency oscillator (LFO), which resonates with
adjustable speed. You can influence the speed and type of resonance.

To influence the resonance, use the two small dials in both the Reduction and Filter
areas. These four dials display modulation targets.
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Example: You've left the dial for the sample rate at its default setting. Change the small
dial beneath from its middle position to either side. The modulation for the dial value is
added to the sample rate: The LFO now controls these parameters proportionately and
the sample rate reduction resonates at this modulation.

You can use this technique on other dials as well. Make sure that the main dial isn't
turned up to full. If this were the case, the modulation wouldn't have any effect. The
modulation is always added to the set value.

Example: Turn the small dial beneath the "bits" dial fully to the left (Value: -50) and the
one beside it (beneath "sample rate") to the right (+50). You've now assigned modulation
to both parameters with the LFO. They are not changed uniformly, but rather in contrast
to one another. A negative setting is nothing more than an inversion of the modulation -
in effect, you're turning down the control signal.

Waveforms in modulation section

We've already explained this example with the help of sine oscillation. The LFO can be in:
« Sine
« Square wave (that is, only O or 1, no intermediate level)
« Random value (an internal randomizer will be queried at the set speed)

Oscillator speed

The LFO speed is specified with the "speed" dial. If the "sync" button is active, the LFO
adapts to the song speed, and the dial locks musical values into place (for example, %
note). With it, rhythmic paths of the sound distortion are made possible. You can also
switch off this synchronization and set the speed manually (in Hz).

Modulation with the "Envelope follower"

In the modulation section, you'll find a fourth button, the audio input signal. If this mode
is active, the signal itself can be used to extract "modulation tension": here, an envelope
follower continuously scans the volume of the input signal.

Note: The BitMachine doesn't recognize the type of audio signal automatically. For this
reason, you should roughly set the input sensitivity with the "gain" dial. To do this, use
the control LED: With accurate detection of the signal dynamics, assigning the four small
dials to modulation lows is easier and you can use the full control range.

In Envelope Mode, the "speed" dial is used to control the response speed of the envelope
(the display now switches to milliseconds). Lower times result in a faster response, higher
times make the envelope rise (and fall) slower. We recommend you experiment with the
signal according to its complexity. The presets provided can only point in a rough
direction.
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Vandal SE

HAGIX

VANDAL is a complete simulation suite for guitarists and bassists. The plug-in is capable
of simulating the entire signal chain, from input to stomp boxes, amplifiers, microphone
loudspeaker boxes and post-processing studio effects, all in top quality.

Quick start via preset selection

Would you like to know about everything that's possible with Vandal SE? Play yourself or
use some of the presets. These are available via the list in the upper edge of the interface.

A preset includes all settings for the main elements of Vandal SE: Stomp boxes, amp
settings, cabinet simulation, studio effects, and a series of control parameters.

default

* Hass Amps
Guitar Amps
T9E2AMm
1#12TuheCombo
2412 Combo BL
ACZDC

Angus

Brit \Wiall

* Jim 149549
Flex
Recto 4212 %30

Tuner

The best amp or the best simulation is useless if the guitar is out of tune. VANDAL offers
its own chromatic tuning device for this. You can use it like any analog device: It
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automatically displays the note that has been struck (in octave) and the display visualizes
deviations (in cents).

The following describes the major components of VANDAL. The stations are described
according to their position in the signal chain.

Input

The station that you will most likely want to activate first is the input controller. Just like
with a genuine guitar or bass setup, it's important to ensure the highest possible input
level, in order to work optimally. This is even more important for distorted sounds and
natural high-gain playing styles Use metering for this, too.

As required, activate the noise gate and adjust it so that it lightly suppresses the input
signal during pauses in playing. VANDAL does not cut the input on classic gates too hard,
but rather regulates them finely via the signal energy beginning at the highs (where noise
is most audible).

Stomp boxes

The real world has produced a series of effect devices popular with guitarists and bassists
in the "stomp box" format. We've also included a rich palette of these devices. Vandal SE
includes four "stomp slots" that can be equipped with effects from the list. The signal
flow within this chain runs from left to right. Since all of the controls are self-explanatory,
we won't describe them here.

hexllfires

E iV =
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Vandal - Amplifier

Vandal SE basically offers 2 different amplifiers: Guitar Amp and Bass Amp. The amplifier
type depends on the selected preset.

During development, a large selection of famous amplifier brands and models were not
included. To guarantee that you are nevertheless able to get a number of different sound
characteristics out of your Vandal SE amp, the amplifiers are set up variably. Internally,
circuit designs work absolutely the same as the real devices. In several ways, however,
Vandal SE goes in its own direction in terms of the sound it offers.

Guitar amp

The Vandal SE guitar amp offers three different pre-amp modes and two switchable end
stage models. These basic configurations differ according to the selected preset.

The guitar amp is set up with three channels. These may be set up with the pre and post
gain controllers per channel (Clean, Crunch, and Lead) for the desired mix ratio. Don't
worry about switching things around: The amplifier will remember the gain settings when
channels are changed. These are the gain presets for the different playing styles within a
song.

Voicing: We have provided Vandal SE pre-amps with something that we call Curve EQ.
For example, if you take a simple EQ pedal and shape the signal a little before the amp,
then this may change the sound quite drastically. Curve EQ does something similar: It's
located (in some cases multiply) at strategically important points between individual
amplifier stages and filters the signal, before it is distorted by the next stage. Move the
curve in both directions and navigate through the spectrum using the "Freq" controller.
This will give the amp a completely different character...

Equalization: The actual sound control (the "tone stack") functions rather conventionally:
Vandal SE offers low, mid & high settings. Everything functions like the passive sound
regulation network in genuine amps, so that the controllers influence each other to
produce numerous variations.

Reverb: Surf and twang simply need on-board spring reverb. We relied on well-known
reverb springs for modeling. Everything sounds natural with complete authenticity.
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Bass amp
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After roughly setting the Gain controller, the bass signal will first be treated with the
Contour circuit. This filtering stage works similarly to the "Loudness" function by cutting
the (lower) mids and lifting the deep bass and highs. It's sort of like an "instant slap".

Next, the signal passes through the compressor stage (Comp). This is a simple but
extremely musical, visual design: The bass triggers a light source that is coupled with a
photo resistor which dampens the signal. This may already be familiar to you from the
most famous studio compressor for bassists, i.e. Urei LA2A, which functions according to
the same principle.

After any possible compression, Drive provides the option to take the bass sound to the
next level. Saturating the signal takes place depending on the frequency: In spite of a
possibly high level of distortion, the basses remain relatively clean and contoured.

The equalization stage offers 4 frequency ranges, whereby the two mid bands are
variable. The final master volume controller specifies the volume of the final stage. As
with the guitar amp, the end tubes are also engaged in this case as much as remains
sensible.

Rack effects (FX1/FX2)

There are effects that don't always work well before the amp, e.g. reverb or delay,
especially when they are distorted. Normally, these effects are better placed at the end
of the signal chain.

For final processing and enriching, we offer two separate studio-quality effects units just
like real 19" rack devices.

Many algorithms create a stereo signal. Take care that the sequencer track operates the
duct in "stereo" mode.

Effects units may be selectively operated one behind the other (serial) or parallel.
Switching may be changed via the mode switch.

The following algorithms & effects are available:
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Mono delay (msec & tempo sync): Possibly a simple delay with free selection of
delay time or synched to the sequencer tempo with a musical raster. In case of high
feedback values, a reduction of the damping frequency is required to provide
naturalness to echoes.

Stereo delay (msec & tempo sync): Like mono delay; features two models.
Repetitions may take place on separate channels (feedback controller to the right:
dual delay) or in ping-pong mode (controller to the left), whereby the signal
alternates between the sides.

Chorus: Produces a typical "floating/shimmering sound" by modulated detuning of
a signal to "thicken up" its sound or spread it across the stereo field. Detuning is
achieved via a short delay, the length of which can be varied by the modulation.
This produces the so-called "Doppler" effect and broadens the signal.

Flanger: Algorithmically similar to chorus, but different in that the delay time is
significantly lower and delay works with repetitions (feedback). A flanger sounds
more "cutting" and up-front than a chorus.

Phaser: A modulation effect just like chorus & flanger, but in this case no detuning
takes place. Filter components periodically alter the signal's "phase response"
(principle of the "phase shifter"). Characteristic notches are produced in the
frequency spectrum response (comb filter effects).

Room reverb/hall reverb: Reverb offers realistic simulation of realistic
reverberation. Room creates the impression of a small to mid-sized recording room,
while Hall produces the sound impression of a concert hall. A particular is that both
effects algorithms provide a modulation parameter, which may remove possible
resonance at low dosages and can produce a soft chorus effect at higher values.

LoFi: This algorithm gives the sound a little bit of "grit", or a certain measure of
signal destruction depending on its setting. Turn down the internal sample rate as
much as you like to steal a few bits from the sound's resolution This is definitely
unconventional...

Vintage compressor: Ideal for thickening up the signal a little. The algorithm
emulates an older popular circuit design that is similar to studio legends like the
Urei 1176 or simple compressor pedals. A so-called "FET building block" controls
the volume via the input level simply, effectively, and quite musically, as well as the
set compression ratio and the attack and release.

3-band EQ: This sound controller works like a conventional mixer with controller
for bass, highs, and two controllers for the (variable) mids. This adds the final touch
to your sound.
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Volume Former

The Volume Former is an automated volume envelope, that is controlled by a beat-
synched or free running LFO. For the volume control you can alternatively manipulate
the volume level (VCA) or use a low pass (LPG) or high pass gate (HPG). With the Volume
Former you can apply a Tremolo effect, transform pads into pumping chords (for hosts
that doesn't support side-chaining) or accentuate rhythmical aspects of a drum loop, like
isolating the kick drum. Just try the presets to get the idea!

Trigger LFO

The Trigger LFO (low frequency oscillator) periodically triggers the envelope. So, for
instance, set the time to 1/4 to trigger the envelope every beat.

When Sync(1) is active the trigger frequency is set dependent
from the host tempo and you can chose a Time(2) between 1/1
(whole note or once a measure with a 4/4 beat) and 1/64 note (a
quite fast stutter effect). The envelope tempo and phase always
follows the host tempo and beat position.

When Free(3) is active, you can set a trigger frequency between
0.2 and 25 Hz. This is independent from the host tempo and also
from the playback position, the trigger oscillator is free running,
that means, it just runs once the plug-in is loaded and the actual
trigger time is more or less random.

Some hosts may reset the LFO on playback start due to
technical reasons.

The Time value for the Sync and Free modes are independent
parameters. When you switch from either mode to the other

and change the time, the former mode's time is still set when

you switch back.

Move the Phase of the LFO with the Shift value (4). You can shift
the starting point of the envelope from -50% to +50% of the
selected time.
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Envelope

Envelope Gate 1

Attack 22% Shape 2.2 3 Hold 36%

The envelope is an AHD envelope, thus consisting of three phases Attack, Hold and
Decay. The Envelope can be used in Gate or Pump mode (1). In Gate mode the Envelope
rises the volume over the attack time, keeps it at maximum level for the hold time and
lowers it over the decay time. In Pump mode the envelope is mirrored horizontally and
works vice versa: starting from maximum level, it fells to zero over the attack time, stays
there for the hold time and rises back to maximum over the decay time.

(2)Adjust the time spans and curve shapes by dragging the circular handles at the
envelope. Below the graphic there's also a numeric readout of the values (3). You set the
time spans in percent of the whole LFO cycle.

You'll notice, that the values don't have to add up to 100%. That means, you can set
envelopes that are longer or shorter than the LFO cycle. By this you can use only the
parts of the envelopes or open/close the gate for just a part of the LFO cycle.

(4) You can see the effect of the Volume Former on the volume directly in the waveform
display, that runs through behind the envelope.
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Gate

JY— sl Choose between VCA, LPG and HPG with the gate type
switch (1).

VCA: The envelope controls the volume with a Voltage
Controlled Amplifier, so all frequencies are affected equally.
LPG: The envelope controls the volume with a Low Pass
Gate. The low pass gate comes from the "west coast style"
synthesizer design and works differently: The volume
reduction is accomplished by a 1-pole low pass filter where
the envelope controls the cutoff frequency (higher
envelope level = higher cutoff frequency = more of the
whole signal coming trough the gate). This results in a more
natural sounding volume reduction, where the higher
frequencies are reduced earlier as the lower ones when the
level turns down. (With a departing sound source, the
higher frequencies also disappear first.)

HPG: With the High Pass Gate a high pass filter is used for
gating, here the lower frequencies disappear first.

The Amount slider (2) controls the overall effect of the volume former: When set to 0% it
has no effect at all, at 100% it turns the volume to silence when the envelope level is O.
You can check the input and output levels with the peak meters (3).

Bypass the whole effect with the Bypass checkbox (4).

Non-realtime effects

All the effects mentioned above are calculated in realtime. Some audio effects are not
calculated in realtime. When you apply the effect to an object, copies of the audio
material are created for calculating the effect after the settings dialog is closed. You
cannot change the effect parameter in realtime during playback. However, no additional
calculations are required during playback.

To change these effects, use the undo feature.

Sketchable filter

Use the sketchable filter to draw the wildest filter effects with the mouse. The left side of
the graphic is for the lower frequencies of the sound, the right for the higher. Click Test
to switch on realtime playback.
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From now on all changes to the red line can be heard immediately. A "mountain” in the
left part of the graphic creates a large increase in bass, a "mountain” in the right increases
the highs noticeably. Often, interesting effects can be achieved when the filter curve is
deleted for the entire range (i.e. set completely to the lowest value in the display). This
more or less deletes the sound.

A couple of mouse clicks in the upper display area will make only individual frequency
ranges audible. In this way a normal drum loop can be quickly turned into into a science
fiction-esque sound.

With Reset you can quickly restore the filter curve to its initial state.

The Anti-clipping option will automatically attempt to prevent the audio material from
distorting.

The Volume fader controls the volume of the material.

Filter sweeps/Morphing

There's also an option to create filter sweeps and morphing.
1. Todo this, activate the start curve on the far right.

2. Now a red filter curve can be drawn for the start of the audio material , for example
a mountain in the left side of the display (low pass range).

3. Activate the end curve.
4. Now a blue filter curve can be drawn for the end of the audio material , for example
an increase on the left side of the display (high pass range).

5. Click Test to start realtime playback and you will be able to hear a soft filter sweep
from the red to the blue curve.

Invert phase

With a stereo signal the phase of a channel is inverted. In other words: The waveform is
flipped from top to bottom, all positive values are replaced by negative values and vice
versa. This cancels all the signal components that are identical in both channels. The
result is a special, hollow sound that only contains the extreme right and left positions in
the stereo image. One side effect of this function is that the object is only played back
through the rear speaker in a Dolby Surround system.
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This special effect "chops up" a sample into a given number of parts (16-128) Select the
number of steps, which will then be distributed over the duration of the sample.
Additionally you can set the volume for each individual step using the fader, so that the
hard sections can be produced in the same way as soft levels.

The Gater function can also work as a filter to create interesting sound deformations
which are particularly good for Techno! This is useful when you want to create a cool
sample from a sound without its own rhythm.

In "Division" you can set more than 16 sections to produce even more variations in the
sound. The fader settings are then repeated which means that step 17 has the same
value as step 1 etc.

A real-time monitoring function allows immediate musical control of any fader change.

There are two operating modes which can be combined with each other, Volume and
filter curves and Rearrange.

Volume or filter curves

The faders change the volume or timbre of the audio material in 16 (or more) steps. Each
fader corresponds to a 16-tel of the audio - with i.e a 1-bar loop a 16th note, in a 2-bar
loop a 8th-grade etc.

Interesting, rhythmic patterns result e.g by lowering the volume of an individual fader or
by staircase-style increases. It can also quickly create different gradients using the
random function. The realtime monitoring function gives you constant acoustic control.
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Gater progressions make it very simple to create rhythmic sounds from a simple string’s
or synthesizer-section, or to emphasize or tone down certain beats in a drum loop.

New arrangement

Using the color-coded numerical fields beneath the fader the playback order of the 16
steps can be altered. So it is possible, e.g to repeat a beat from the first 16th on the
fourth 16th. For this, the number under fader Nr. 4 must be the number 1. Through the
use of color it is shown that at position 4 the material from position 1 is played.

By rearranging the parts, you can quickly and effectively create lots of variations from
one drum loop.

Reversed

Here the samples are reversed so that they can be played from the end to the beginning.
Some really interesting effects can be achieved using this feature, among others the
infamous "Backmasking" (playing lyrics backwards).
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Loading, Saving and Exporting Projects
In this chapter, you'll learn everything you need to know about loading and saving
projects, how to backup work, and how to export finished songs.

Create a new project

E To create a new project, click this button or select File > New Project.... (Keyboard
shortcut: Ctrl + N)

The project is created with a preset number of 4 tracks. Additional tracks can be added
using the corresponding button in the arranger.

If you want to start right away with a higher number of tracks, open the project settings
dialog (keyboard shortcut: A) and select one of the default values. Since all changes made
in this dialog are always used as presets for new projects, all new projects created in
future will also be assigned this number of tracks. This also applies to all other settings
defined in this dialog, such as for sample rate or automatic backup.

Save/load projects

A "project" encompasses all objects in the arranger with their positions, fades, lengths
and volumes as well as all settings and effects.

In other words, saves your project and closes MAGIX Music MAKER. When you start the
program and load your project later, it will look and sound exactly the same as before and
you can continue from where you left off.

Projects can be saved via the menu "File"as an MMM file and loaded again.

Save a project

E To save your project, click on this button or in the menu go to File > Save project
(keyboard shortcut: Ctrl + S).

The project will be saved. When you save your project for the first time after creating it,
you will be asked to assign it a name and storage location. The default storage location
used is the one specified in the Program settingsFolders (7213).

Occasionally, you might only want to try something out and would like to keep the
current version of the project. In this case, it is recommended to save the project first
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normally and then additionally under a new name via the menu under File > Save as....
Under this name, you can continue to save your current work, but can revert to your old
version if desired.

Load project

n To load your project, click on this button or select File > Load project from the
menu (keyboard shortcut: Ctrl + O).

Please note that the program must be able to access object (746) files used in the
project. MAGIX MusiC MAKER first searches for sounds and videos used for the project
where you saved the project. If it is not found there then MAGIX MusiC MAKER
subsequently searches for the objects in the same folder as the project itself.

Project Settings

In this dialog, the general properties of the project can be set. Statistical information
about the project is also displayed.

Keyboard shortcut: A

General

« Name: Enter the name of the current project.

« General project settings
Path: This is where you determine the folder on your hard drive in which your
project is saved.
Save automatically: Saves the project automatically according to the settings used
for automatic backups in the program settings.
Use settings as presets for new projects: The settings entered in the Project
settings dialog are also applied by default to all new projects. If you specify project
settings that you only wish to use once, you should deactivate this option, so that
MAGIX Music MAKER uses the default settings again for the next new project.
Number of tracks: Here you can set the number of tracks you wish to use.
Audio sampling rate: The default sampling rate is set to 44,100 Hz (CD-Standard).
Time signature: Several types of bars are available to choose from, for example %
beat. With various grid settings you can also set additional time signatures. For
example, with a set 3/4 beat and a 1/8 note grid a 6/8 beat would be the result.
Video resolution: Here you can specify the presets for the video resolution used
and the video format.
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Synchronization

« Options for Synchronization (7181) and Rewire (7182) support.

Information

o Name/Path: See above

o Created on: Displays the time the project was created.

« Last changed: The time of the last save.

« Number of used objects: Displays the number of all objects in the project.

o Used files: Here the names and paths to all multimedia files used in the project are
shown.

Backups

Backup projects

MAGIX Music MAKER automatically saves backup projects of the current status of your
work periodically as a safety measure. This type of automatic backup gets the file
extension MM_ (underscore) and are stored in the same file as the main file for your
project.

Backup projects can be used when, for instance, a program crashes in order to recover
the last status of the project. These automatic backups are also useful if you
unintentionally saved your change and wish to return to the previous version.

Saving the entire project

When loading projects you must ensure that all media files used are available in their
respective folders. To save projects completely, to archive them, or to edit them using a
different computer, use the function Save project and used media... located in the menu
under File > Backup (Keyboard shortcut: Ctrl + Alt + S). This will save the entire project
along with the media files in one folder.

If you instead select Save project and used media (audio as &Ogg Vorbis)... (keyboard
shortcut: Ctrl + Shift + C), all the audio files used will be compressed into the more space-
efficient OGG format before being saved.

If you have purchased the CD burning feature with your Edition or separately, you may
also save the project to CD/DVD.
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Choosing File > Backup > Burn project and media to CD/DVD-R(W)... (keyboard
shortcut: Ctrl + B) from the menu, burns the project and all its associated files to CD or
DVD.

By selecting Burn manually selected files to CD/DVD-R(W)..., you may also select which
files you would like to burn to disc.

~ Both options use a separate program, MAGIX Speed burnR, for this task. For more
information, please consult the Help included in this program.

Export Wizard

The export wizard can be opened via File > Export > Common export options (keyboard
shortcut: X).

This bundles different options for exporting your project in different formats, for burning
onto CD, or publishing on the Internet with different platforms.

(%] Export project X

Select an export option:

Export as WAV

Export as MP3

Export as 0GG

Export your song in the widely

Post on SoundCloud®

Export as WAV: Export a song in the best possible quality as an uncompressed WAV file.

Export as MP3: This selection exports the project in the popular MP3 format for use on
the Internet or on mobile playback devices (MP3 players, mobile phones, etc.).

Export as OGG: OGG, the open source alternative to MP3, offers slightly better audio
quality for the same file size - however, not all devices can play this format.

To export to these and other formats, use the Audio export dialogAudio export dialog
(7156)
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Burn to CD/DVD: This selection exports the project in the best possible quality and
opens an additional program for burning an audio CD. The option is also available to
backup the entire project with all involved files onto CD or DVD. See Burn audio CD
(2160).

Publish on YouTube: This selection uploads the project as a music video to YouTube.
More info about YouTube export is available the Publish online (7158) chapter.

Publish on Soundcloud: The project will be uploaded to Soundcloud. You can find further
information about this in the section Publish online (7159).

Audio export dialog

You can find all possible export options and audio formats in the menu under File >
Export. Depending on the chosen file format, the export dialog contains a number of
other options, which are explained below.

MP3Export *

File

‘::\U;Er’s\user‘user‘i\Dncuments\MAGlX\Mu;ic MEkEI’\NE\-‘\| | Oll& |

] Overwrite file without a warning message

Options
Bit rate: |__ 128 kBit/s =]

[] Only export the range between start and end markers
[wf Normalize

Reset

File information
Length of range for export: 405
im: ize of file with the current settings: 63.1 KB

[ ok J[ Cancel |[  Help ]

File
In "File" you can enter the file name for your exported file.

Use the folder symbol to select the folder into which you want to export. The
dialog will remember the export path for future exports.

IEI Use the "home" symbol to restore the original preset (7213) path.

The option "Overwrite file without confirmation" option allows you to execute multiple
exports in the same file.

Options

Only export the area between the start and end markers: Set this option if you wish to
export only one section of the project.

Advanced: Here you can open the advanced settings dialog for the corresponding audio
format (see below).
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Normalize: This function should always be activated. It guarantees that the music is not
too loud/overmodulated or too quiet.

Audio as Wave/ADPCM

The audio material is exported as a standard wave file. This is the conventional format for
further use on Windows PCs. These files are not compressed and retain their full sound
quality.

Mono/Stereo/5.1 Surround: Select whether to export in mono/stereo or 5.1 Surround.
5.1 Surround is available only if you create a 5.1 mix. See Mixer in Surround mode
(2176))..

Export tracks individually: Each track is written to a separate file. Use these function if
you want to mix down your project in a different program.

Keyboard shortcut: Shift + U

Compression (IMA ADPCM): This option compresses the WAV file in to the ADPCM
format. This format is needed for playing WAV files on older mobile phones. Many older
mobile phones also need a lowered sample rate. (usually 16000 Hz).

Keyboard shortcut: Shift + W

Audio as MP3

MAGIX Music MAKER supplies an optional MP3 encoder for especially fast, top-quality
conversions into the popular MP3 audio format.

Hint: The MP3 encoder cannot be used as a codec for the audio track of AVI audio files.

Bit rate: The "Bit rate" selection specifies the level of compression: The higher the bit
rate, the higher the quality of the exported audio file. On the other hand, the bit rate
determines the final file size: The smaller the bit rate, the smaller the files.

Keyboard shortcut: Shift + M

Audio as Ogg Vorbis

"OGG Vorbis" is a license-free open source audio codec with very good sound
characteristics for comparably small files - similar to the MP3 file format.

In these settings under Advanced..., you can choose from three various encoder modes
and bit rate. Set quality. Constant bit rate enables streaming and maximum compatibility;
with variable bit rate a better audio quality with the same size files can be achieved.

Keyboard shortcut: Shift + O
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Audio as FLAC

FLAC is the abbreviation for "Free Lossless Audio Codec". This is a freely savable format
that can be used to compress your audio data to 50% of their original size. Unlike other
compression methods like MP3 or OGG, the full sound quality is kept intact with FLAC.

Keyboard shortcut: Shift + F

Audio tracks as single waves

Opens the WAV export dialog with activated "Export single tracks" option. Clicking on
OK saves each track as a separate wave file in the export folder.

Keyboard shortcut: Shift + U

Publish online

The menu entries featured under File > Export >"Community upload" or via the Export
assistant allow you to upload the finished song to different web communities.

Export to YouTube

You can upload your project directly to YouTube from MAGIX MusiC MAKER.

The command opens a dialog where you can set the name of the project for YouTube
(default is the same as MAGIX Music MAKER), description, keywords (so-called "tags"),
and the category for the video. After confirming this data with "OK", the project will be
exported and uploaded to YouTube. For connecting and transmitting the video file, you
must log in with your YouTube username and password. If you don't have an account
open your browser and go to YouTube to sign up for an account first.

After a successful upload, your browser will open to show you your video's info page so
you can check the entered data once again. If everything is as you want it, you can leave
the page and the new video will now appear in the list of your own videos. YouTube
takes to process the video for online presentation you and every Web user around the
world can watch it.

Title templates for YouTube

If your project does not contain a video, then you can still upload it to YouTube with an
attractive still image.
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In the Templates you will find the subfolder YouTube under the Title. This contains
special title templates for YouTube videos. These templates feature neutral designs or
match the style of the Soundpool (hip hop, rock etc.), and contain standard text for
artists, title, album, and comments. These titles also appear throughout the entire length
of the project.

Soundcloud

Soundcloud is a community that is especially designed for musicians. The free version
provides 120 minutes of storage space for your songs. Every song may be embedded as a
player widget into external websites; the widget even allows comments along the
timeline of the song and an optional download of the original song.

For more information about the possibilities provided by the Soundcloud community and
the different premium accounts see www.soundcloud.com

The website's user guide is in English.

« Under Titles, you can specify the title, under which the piece of music should
appear on Soundcloud.

« Enter a short description for your file under Description.

o To make sure your music is found on Soundcloud, you should specify meaningful
keywords under Keywords

« Broadcast defines who may listen to your music on Soundcloud. It is recommended
to select "Public" to reach the largest audience possible.
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Burn audio CD

Two options are available for burning your project as an audio CD:

1. To burn an Audio CD, export your project as a wave file: Click on "File" and select
the "Export arrangement"” option > "Audio as Wave/ADPCM". The WAV file
created can be burned as an Audio CD with any burn program.

2. The "Burn song as audio CD" option in the "Share" menu exports the project
directly in a Wave file and transfers it to the MAGIX Speed burnR burn program.
Optionally, the Sound Forge Audio Studio can be used for this purpose. You can
load your project into the Sound Forge Audio Studio using the option "Burn project
on audio CD" and then burn an audio CD using this CD mastering tool. Or you can
open MAGIX Speed burnR, for example, with the help of the context menu in the
Media Pool. An MP3 data CD can also be created MAGIX Speed burnR.
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Additional functions

This chapter focuses on all other functions,

Store

New Soundpools, function packs, presets and virtual instruments can be bought directly
in the Store within the program. Soundpools, presets and instruments are automatically
downloaded and installed following purchase and can be found in Loops and Instruments
windows. New program functions can also be used right away.

Soundpools

NEW COLORFX TAPE MACHINE
L

NEW: colorFX TapeMachine plug-in

Maore vibrancy & warmth for miding & Masteri

|~ GENRES  [EEYTRES BINAME ~
3 FUNK |
Blues Dance Easy Listening
Folk Hip Hop Jazr
Hegdqgas Rock Scorg Soul f REB

Variouws World Music

ANER A

LOOPS
UNLIMITED

[ - e |
AMBIENT

CHIPSOUNDS
AGLITCHES

mezTocioos: [y [

The top section displays special offers and selected content.
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Soundpools v

Here, you can switch between different Store categories:
« More instruments: For purchasing additional software synthesizers (758).
« Presets: More presets for the software synthesizers supplied can be found here.

« More functions: Contains function packs for expanding the functions in
MAGIX MusIC MAKER, such as CD burning function, VST and more.

« Editions: Editions are bundle offers that include specific feature packs and free
credit for Store content. To learn more, read Editions (724)

Note: You can learn more about individual functions in the program documentation,
which outlines all the features and functions available in MAGIX MuSIC MAKER.

All available content is displayed in the form of tiles. The search list above lets you filter
search results such as music genres or the names of packs.

| v GENRES |App|ying the genre filter to narrow down the selection according to genre.

The drop-down menu also lets you filters results in terms of new features,
discounts and updates.

Other control elements appear on top of a tile when the
mouse hovers over the tile:

« Using the play button in the middle, you can preview a
sample song with the loop, instrument or preset.

« The info button below right lets you switch to an info
page with additional information for the content.

« Clicking on the price on the left starts the purchase
process.

Buy new content

When you make your first purchase, you will be asked to select a currency. Then, log in to
your MAGIX account.

WELCOME ENTER PASSWORD TO COMNFIRM

P ]
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In the next step, select the payment method and enter the required details.

#i MAGIX B PayPal

SELECT PAYMENT METHOD Pay with PayFal

VISA
Paeria e —A

] TR O i e |
-l-’ Pipans Fon your Mgeiirooed ey will nasd v =l
E' AUTOMATIC DEEIT TRAMSFER
Fas Wil reeiecl 0 TN DO O 0 I Py vy et chedni
Crmpin g Ared
PAYFAL
P s

This step will be skipped for later purchases. You will go straight to the "Purchase"
window. You can also adjust the payment method afterwards by clicking on the pen icon

next to "Pay with".

I MAGIX

YOUR SELECTION

1

2step - Selecta N 19"

Redeam coupon Iﬁﬂpﬂpmlnttﬂll

Click on "Buy now" to complete the purchase.

Your purchase will download immediately, as shown by the download | 26% |

progress on the tile.
After downloading and/or installing the content, you can switch to a >
view which will display your newly purchased content (marked here

as "NEW").
"1'- 25tep - Selecta o

You can use the loops and instruments you have purchased in your projects right away.

Activate Edition

When you install MAGIX Music MAKER for the first time, you have access to the free
basic version. If you have bought an Edition (724) you'll also receive a selection of
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additional content including Soundpools, instruments, presets and program functions. In
order to use this content, you will need to activate the Edition first, then add the content.

To do this, click on Sign in in the account area of the start dialog and log in to your
MAGIX account. Now, please enter the serial number of the Edition you purchase under
Enter serial number.

Next time you go to the Store, you will see a balance counter for each Store category.

m g SOUNDPOOLS

You can now add the relevant content in the Store. This works exactly the same as a
normal purchase - all you do is click on the price. The only difference is that you don't
purchase the content - it's free.

] MAGDX Store
W MAGIX

SELECTED ITEM

80s - Vaporwave €0.°
Slowed-dow ut of the

After you download and install content, you'll see your remaining balance in the balance
counter. When you have used up your balance, you can continue purchasing additional
content as normal. Then, you will need to enter payment information.

Notes:

« When you own a more basic Edition (or own a previous, basic version) and then buy
a more advanced Edition, you will not receive all the content again - instead, you'll
only receive credit for the more advanced Edition.

« If you are upgrading from a previous MAGIX MusIC MAKER version, all features and
sound content already available in this version will be automatically marked as
purchased in the Store and can be downloaded there. Enter the serial number for
your previous version in the start dialog.

. The Store also offers instruments and third-party effect plug-ins for purchase in
the Instruments and Features categories, for which the balance from the Editions
cannot be used.

Re-download purchased content

Content you have purchased is not linked to a specified computer or installation, but to
your MAGIX account. If you re-install MAGIX MusiC MAKER on another computer at a
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later point, you can download all the content you have already acquired without needing
to repurchase it.

Iltems you have already purchased are faded out in the shop by default. Select the
"Show purchased items" option under the gear icon.

This displays all items in the shop.

Content which you have purchased but is not present in your current 0
installation is marked with this symbol. Click the symbol to re-download the

content.
Existing purchases are marked with this symbol. Click it to switch to the content ~ ##
in the Soundpool or instrument view.

Content that has been purchased and downloaded, and for which an update is
available, displays this symbol. This may be the case if a bug fix is available for a

software synthesizer, or if the format for Soundpools has been changed.

Content n

Use the "Download purchased content" function to open the Downloads window, which
lists all of your purchased content.

Downloads

All content you have acquired appears under Downloads, whether this is content
purchased after the fact, or content included as part of your Edition (724) that you
haven't downloaded yet.

Revolta - Plus Pres...

Song Maker Al

Vita 2 Premium Pre...
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After activating an Edition or reinstalling MAGIX MusIC MAKER, for instance on another
computer, this list may be pretty long. Therefore, you can select Download all to start all
downloads simultaneously.

You must install all packs separately, however, since further information may be needed
from you for the installation of some program functions or instruments. Following some
installations, MAGIX MusiC MAKER may need to be restarted before the downloaded
content can be used.

Installed functions, Soundpools or instruments will be displayed above in the list under
Installation complete until the next program start.

Remix Agent

To create a remix, elements from a completed song or components of a song are added
and removed creating a new song. In order to combine your own loops and beats with a
given song, it is important to know the exact tempo (in BPM - beats per minute) of the
song. The MAGIX MusiC MAKER in Remix Agent allows you to define the tempo of MP3s
or imported tracks from a CD in MAGIX MusiC MAKER.

Once the tempo has been determined, you can optionally match the tempo of the project
to the tempo of a song, the tempo of a song to the tempo of an existing project, or divide
a song into individual beats (remix objects), which can then be rearranged as desired.

Requirements for using the Remix Agent
« The song must be longer than 15 seconds.
o The songs have to contain "rhythmic" music.
o The track must be in stereo.

If audio files longer than 15 seconds are loaded into the project, the Remix Agent is
started automatically.

Workflow of the Remix Agent

The Remix Agent works in four steps:

Step 1: Checking the start marker

Step 2: Tempo recognition

Step 3: Specifying beat starts

Step 4: Application of BPM and beat recognition
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Tap tempo

Locked: 12803

M Joans i B H
-n-l b PN

Tempo

«|m[r[w
120935 BPM —— 1 Mute

<< Back Continue>> || Cancel ][ Help

Step 1: Checking the start marker

Place the play cursor at the position where detection should start in the object by clicking
the timeline. If the object contains a longer intro without beats but rather calm
synthesizer pads, you should position the start marker after the intro.

Furthermore, the start marker should always be positioned just before a beat hit, even
better, just before a beat at the start of the bar.

Step 2: Checking the automatic tempo recognition

After opening the Remix Agent by pressing the "Continue" button, it will begin to analyze
the audio material and try to determine the tempo. The object is played back while a
metronome click relative to the event can be heard and numbered green beat lines
appear in the waveform.

The following will be indicated:
« Position of the start of the measure (one): red lines.
« Position of the other quarter notes (two, three or four): green lines.
« Reliably recognized positions: thick lines.

Unreliably recognized positions: thin lines.

Tapping is indicated by additional blue lines.

Note: If the tempo or bar information of the object you wish to analyze is already
available, these are displayed as dots at the respective positions above the display of the
wave shape.

Under the waveform on the left side the established tempo is displayed in BPM. There is
a small transport console in the middle to make navigating easier. The slider serves as a
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position controller. To set the metronome volume, an additional fader and mute button
are provided on the right-hand side.

Change beat positions and tempo

The automatic tempo recognition doesn't always work right away. If you don't hear the
metronome clicking in time with the music, click the "No" button in the upper section of
the dialog in order to access the manual tempo input dialog.

To correct the metronome speed and any timeshift that may occur between the
metronome clicks you can use the tempo correction as well as the "Tap tempo" button:

Tempo correction: The Remix Agent provides various speed settings - the speed the
Remix Agent determined as the most probable is preset. If this tempo isn't correct, you
can choose another one from the list. The next time you play back the song it should be
in sync with the metronome.

On/Off beat correction: Now it may happen that the tempo is right, but the beats have
been displaced. "On/off beat correction" provides a number of alternatives for moving
the beats according to the complexity of the rhythm. Try out various alternatives until the
metronome clicks are in sync with the beat.

Tap tempo: Instead of selecting the tempo under "Change Tempo", you can click
rhythmically on the "Tap tempo" button or press the "T" key. Additional blue lines are
displayed in the wave display. After at least four taps, the Remix Agent attempts to select
the correct tempo from the list in "Tempo correction". The display next to the "Tap
tempo" button displays the current status. Keep tapping until the red display showing
"Unlocked" changes to the green "Locked" setting.

Use the "0" key to manually set the quarter beats while the music plays. Surrounding
markers will automatically be removed to ensure that the set tempo remains intact.

You can move the markers with the mouse. If you hold down the "Ctrl" key
simultaneously, the subsequent markers are also moved. If the metronome clicks now
correspond with the music, you can continue to the next step.

Step 3: Determining the start of a bar:

Next you can set the time signature. The default setting is 4/4 but you can adjust this if
necessary. The beat at the start of the bar should coincide with the high sound of the
metronome, or the red line in the waveform display.

It can now be corrected in one step: If the start of the bar can be heard, click on Tap One
once using the mouse or press the "T" key on the keyboard. Alternatively, select how
many quarter notes the "One" is to be moved back. Use the "0" key to manually tap the
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position of the beginnings of the bars during playback. This allows you to correct the
beginnings of the bars in longer sections.

Continue to the last step if the starts of the bars are now correct.

Step 4: Applying BPM and bar recognition
This lets you determine what you want to do with the analyzed audio material. The
following option is available:

o Create remix objects from the analyzed audio material

o Adjust the project tempo to that of the analyzed audio material and vice-versa.

o Save only the tempo and beat information in the audio file for possible editing later
on.

Following this, you can also start the Remix Maker (7172) and the Harmony Agent
(2174)

Create remix objects

This will split the song into individual objects according to beats. The following uses are
possible:

« Create loops from complete songs which you can then use with your own material.
Important: Not all remix objects are suitable for loops. Less complex material such
as drums from an intro are ideal.

« To remix songs, that is, change the order of the objects, cut and duplicate individual
parts or beats of the song, or enhance the song with various other loops or synths.

« For mixing 2 songs: The beat and tempo match perfectly so you can fade without
"side effects".

You also can activate this function from the "Object" menu only if the tempo information
has been saved.

Audio quantization: The new objects are precisely fitted into the bar grid of the project.

There are slight tempo variations in “hand-made” music, so that different bar lengths can
occur. To make sure the objects fit into the bar grid of the project, the time processor is

automatically activated and object-timestretching used so that the difference in length is
corrected.

Use resampling for small corrections: If the required corrections are not too significant,
you can use higher-quality resampling instead of time-stretching. You should then no
longer change the project tempo as this may result in considerable pitch changes.
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Remix objects in loop mode: New objects are put into loop mode. When extending the
length of the object using the right object handle, the object is continuously played back.

Set project tempo to object tempo: (See "Adjust tempo”).

Note: The time correction allocated to the objects can be undone later if the time
processor is opened and edited (menu item: Timestretch/Resample Object Menu).

Cancel: The dialog will be closed.

Adapt tempo

Set object tempo to project tempo

Adjusts the object length to the existing project. There are three different options: Time
stretching, resampling or audio quantization.

o Use Time stretching: The pitch of the song remains constant in time-stretching;
however, the sound quality may suffer.

« Resampling changes the pitch (similar to changing the speed of a record player), but
retains most of the sound quality.

« During Audio quantization the tempo adjustments are calculated into the audio file
in such a way that it appears as if remix objects were created and then immediately
compiled into a new audio file (see below). If recognition is unreliable, the result can
show extreme tempo variations. In this case, it is particularly important to set the
playback marker at such a position (before opening the Remix Agent) that the
tempo can be reliably recognized. The advantage of audio quantization is that
smaller tempo variations can be balanced in the music. The beat starts of the music
always correspond with the beat starts of the project. They do not slowly drift
apart.

Set project tempo to object tempo

The project assumes the found BPM value. If you would like to use the cut-up song as
the basis for a new composition like with remixes this option should be active.

Save tempo and bar info

Only the information will be saved in the Wave file. This makes sense if manual
correction is required for defining the bar/tempo. Once the information has been saved
the tempo and bar adjustment will no longer be required for future tempo and bar
adjustments or when creating remix objects.
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Find loops

The Loop Finder was developed for the purpose of finding BPMs in short rhythmic
passages and placing BPMs into the project. Furthermore, the BPM Finder can help to fit
short loops into an existing project or extract short rhythmic passages from drumloops.

The Loop Finder can also help to fit short loops into an existing project or extract short
rhythmic passages from drum loops.

Note: For longer passages (e.g. complete CD tracks), you can use the Remix Agent
(7166).

The waveform of the audio material is displayed in the upper part of the dialog, preset at
a zoom level of about 10 seconds.

The principle involves moving the green start marker to the start of the beat and the red
end marker to the start of the next beat. The BPM display to the left then shows the
tempo of the loop in beats per minute (BPM). Here we presume that there are exactly the
same amount of beats in the selected passage as is displayed in the "Beats" input field - 4
is the default. If there are two full bars between the start and end markers, the number of
beats has to be increased to eight, otherwise the Loop Finder will only correlate half the
speed.

The precise marking of the beat length is required for exactly defining the loop length.
This is also possible manually by moving the start and end markers, and can be similarly
precise when using the zoom functions. But it's easier to do so using the following:

Tap tempo: activates the automatic step-sequence to determine the tempo. First, audio
playback begins at the start marker position. Then you will be requested to tap in the
beat with "Tap" or by pressing the "T" key, that is, the "T" key should be pressed in time
with the music. Playback stops after the number of beats set above is reached. The start
marker is now positioned at the start of the tap process and at the end marker at the end.
And that's it! The beat has now been set and the tempo can be read. Program automation
makes sure that the start and end positions are placed exactly at the next beat. Even if
the tap process didn't work out exactly, automation nearly always finds the right beat
meant when tapping.

Snap marker: You can use the red and green arrow buttons at the top beside the wave
display for moving the start and end marker one beat forward or one beat back. This
makes it very easy to select "round loops", i.e. whole bars, during running playback.

As long as a loop runs through without any problems, the correct tempo will be able to be
read to the left.
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Here you should make sure that the number of beats per bar (default: 4) has to adapted
to the actual loop length. That means if four bars are selected as a loop, 16 has to be
entered into this field.

Start (S) and End (E) Markers: These markers indicate the beginning and the end of a
loop. You can move them around with the mouse to fine-tune the range.

Cut: Once a correct loop has been found, it can be cut using the this function in order to
be able to use it again later.

Use new BPM: The project applies the BPM value found.

Timestretching: Adapts the object to the tempo of the project (as a result of the
determined tempo) using timestretching.

Resampling: Adapts the object to the tempo of the project (as a result of the determined
tempo) using resampling.

Keyboard shortcut: L

Remix Maker

The Remix Maker can be run directly following the Remix Agent.

Use the Remix Maker to automatically create remixes. Here, the remix objects created by
the Remix Agent are moved, copied, and newly compiled according to specific criteria.
You can select one of four DJs who each represent different styles and specify the length
of the remix and the form of the compilation.

Opening the Remix Maker

« New Song

1. Load a new song that you'd like to remix. It should preferably contain clearly
rhythmic material.

2. When the Remix Agent loads it breaks down the song into useful parts (See
above "Remix Agent").

3. Inthe last window of the Remix Agent, activate the Open Remix Maker
option.

4. After the Remix Agent has broken down the song Remix Maker will
automatically open.

o Pre-edited songs in the arranger
1. Load an project, that contains a song which has loop-cut objects.

2. Select one of the loop objects.
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3. With a right mouse click select the Remix > Remix Maker option from the
context menu.

« Long, unedited audio objects in the arranger
1. Load an project that contains a long, unedited audio object.

2. With a right mouse click select the Remix > Remix Maker option from the
context menu.

3. A prompt will appear asking you whether remix object should be created or
not.

Presets

smooth loop chaos straight

Here you can choose from four DJs with differing remix characteristics. It's best to try
out all four and check out the results.

Length adjustment:

Very short: Approx. 20 seconds.
Short: Half the length of the original song.
Normal: Normal length of the original song

Doubled: Double the length of the original songs.

Song structure

Here you can edit the order of the selection in more detail.
No changes: The order of the objects remains the same.

Small changes: A sequence of objects ("Pattern") will either be repeated or the following
pattern will be added.

Comprehensive remix: The objects in the original song are assembled far apart.

Random: The objects will be randomly ordered.

Fills

"Fill" i.e "Fill in" means that the loop object is cut from the Remix Agent and then in turn
cut into very small components, which are then looped and played back very quickly one
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after another other for an intermittent change from the regular beat.
None: No fills are used.

Moderate use: A few, simple fills are used.

Heavy use: Numerous, interconnected fills are used.

Random: All possible fills are used in a random order.

Harmony Agent

MAGIX Harmony Agent - Harmonieerkennung x

erseizen

«(m[r]mw

Abbrechen Hilie

The Harmony Agent is designed to analyze harmonies.

When you open the Harmony Agent, the music track is analyzed first. The Harmony
Agent attempts to automatically identify harmonies for each quarter beat of the music.
The correct beat information (7166) is an important prerequisite for the Harmony Agent.

During subsequent playback, the detected harmony is played as a chord by an internal
generator for verification purposes. You can adjust the volume with the "Volume"
function. "Mute" deactivates the generator.

The transport control controls playback of the music track. The position slider below lets
you quickly move to a certain passage.

Checking and correcting automatic harmony recognition

After the analysis, you can manually correct harmonies which were not correctly
identified. Note that major chords are written with capital letters and minor chords with
lower-case letters. To select a chord left click on the respective harmony symbol in the
waveform display. Hold the key if you want to mark several subsequent harmonies.

Recommended alternatives to the recognized chords are displayed in the section
"Correction" under the menu Suggestions. The initially recognized harmony is marked
with an *. If none of the alternatives apply, you can select the correct "Root" or "Chord"
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from the menu. Use the option "Replace marked harmony in the entire song" if you are
sure that the incorrectly recognized harmony is not included in the entire song. Usually,
major and minor keys have been mixed up.

Once you are sure that all harmonies are set correctly, click "Continue".

Using harmony recognition
You can apply the information from the Harmony Agent here. There are different ways to
output harmonies:

Generate chords in arrangement: In the project two tracks are created, one that
contains the chords symbolized as guitar chords, the other contains other title objects
with the respective chord symbols. You can graphically display harmonies in the video
monitor in sync to the music.

Save information about harmonies from the audio file: This also ensures that the
harmonies are available later. For instance, to display the harmony information in the
timeline (Edit > Show object marker > Harmony marker).

Display: You can choose between different displays for the harmony symbols. You can
choose between English, German or Roman symbols to "name" the tones. You can also
set "Predraw" to force enharmonic reinterpretation. "#" shows all notes as "sharps" (C#,
D#, F#,...), and "b" displays them as flats.

5.1 surround
MAGIX Music MAKER supports playback in real 5.1 Surround.

What you'll need

To edit audio tracks in Surround Mode you need a sound card in your computer which
can operate the following channels:

o frontleft (L) / right (R)
« center (C) / Subwoofer (LFE)
o back left (Ls) / right (Rs)

Surround playback is possible with all audio driver models. You can adjust these in the
program settings in the Audio/MIDI tab.

Output of the six output signals in all driver models in the output channels is in the same
(standardized) order:

Channels 1/2:L- R
Channels 3/4:C - LFE
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Channels 5/6:Ls - Rs

Mixer in surround mode

FX FX

Surround Surround Surround Surround Surround Surround Surround
Panner Panner Panner Panner Panner Panner Panner

S M S v S M S v S v S M S M Surround 5.1

Bass

Sequence Steeldrums Keys 1

Piano VSTi

To activate multichannel playback, open the mixer (M key) and click on "5.1 Surround"
button in the master.

The mixer channel pan control is replaced by a Surround Panner button that opens the
5.1 Surround Editor.

The Surround Editor is also available for the FX tracks (752). For example, you can send
the original track to the front L/R speakers, the FX track however will remain at the rear
L/R speakers.

The master volume is applied to all channels, here the left controller influences channels
L and Ls, the right controller; channels R and Rs and the middle value of both controller;
the channels C and LFE.

The master plug-ins are only applied to the front channels.

In the master FX rack of the MAGIX Mastering Suite the full effect palette is not available
in 5.1 Surround mode, but rather only the compressor and the parametric equalizer
(©7123) (from the Mastering Suite). The settings of these effects have the same effect on
all six channels.
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5.1 Surround Editor

{21 5.1 Suround Editor - Track: 1 N

In the 5.1 Surround Editor of the mixer track you can arrange the audio signal of a track
(displayed as two red sound sources) in the "imaginary" room. The signal is dispersed to
the 5 (blue) loudspeakers which represent the individual surround channels.

There are 6 channels:
o L: Front left
o R: Frontright
o C:Center
o LFE Sub bass (Low Frequency Effect) channel
« Ls: Back left/left surround
o Rs: Back right/right surround

Dispersing the signal to the 5 loudspeakers occurs after the so-called sound source emits
a sound field of a certain level (displayed as red circles). The further away a loudspeaker's
source is, the less its share of the corresponding loudspeaker channel. The position of the
source and the loudspeaker can be moved with the mouse.

The sub bass level (LFE) is set directly in the corresponding field, which you can also
adjust with the mouse.

There are various modes in which you can use the source signal:

Mono: The (stereo) source signal is seen as mono material, the left and right channels are
mixed together and arranged together. The original stereo information is lost here.

Stereo 1: Similar to mono mode insofar as the left and right channels are moved
together, however, only a portion of the left source is audible in the loudspeakers Land
Ls, and only a portion of the right source in the right channels R and Rs. The stereo
information remains as faithful as possible.

Stereo 2: The left and right channels can be moved individually. The distance between
the left and right source is retained when you move the left source. You can move an
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individual source by holding down the "Alt" key. You can move an individual source by
holding down the "Alt" key.

Center/LFE: Only the left channel is arranged. In return, the LFE share is drawn solely
from the right channel. This mode is only of importance when importing Surround
material.

The width determines the level of the sound field of an individual source.

Importing and exporting surround audio files

Import

Interleaved 6-channel wave files can be imported. On loading, these can be transformed
automatically into 3 stereo wave files and the corresponding track settings can be
activated (First track L/R, second track C/LFE, third track Ls/Rs).

Export

Surround exports can occur in any one of the following formats:

« Interleaved 6-channel WAV files: These are wave files containing 6 channels
(corresponding to the surround channels L,R,C,L,Ls,Rs).

« Windows Media files (Windows Media Audio or as a surround soundtrack of a
Windows Media Video).

The files created are fully compatible with the normal file formats. This means that they
can also be played on computers incapable of playing Surround (in normal stereo).

The export is performed using the same menu commands (e.g. File > Export > Audio as
wave) like the normal stereo export. Surround 5.1 will then be preset for export in the
export dialog (7156).

Automating Surround position

Panning of the sound source on the loudspeaker can be automated to simulate
movements in the room. For this to happen, Automation must be activated.
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There are two methods to create automations: record and draw.

To record (when automation is on), the sound source is moved between the loudspeakers
during playback. When recording the automation, the Record checkbox lights up red.

The draw function is an alternative way of recording complex movements. If drawing
mode is active, all panner movements are transmitted to the time interval between the
start and end marker (when the mouse button is dragged). You can draw the entire
movement curve for the selected time range.

Reset deletes surround automation from the track.

There is no automation of the parameters for width and LFE, of the distance between the
left and right source in "Stereo 2" mode, or of the loudspeaker positions.

Integrating other programs - Synchronizing and
ReWire

MAGIX Music MAKER enables other programs or external MIDI hardware (e.g.
Grooveboxes, hardware sequencers) to be remote controlled via MIDI synchronization or
to be controlled by these devices. Synchronization means that both components involved
always use exactly the same tempo and operate at the same time position.

ReWire technology makes it possible to play ReWire-capable programs like
Propellerheads Reason or Ableton Live in MAGIX MusiC MAKER just like a software
synthesizer via MIDI objects.

Synchronization

Sometimes MAGIX MusIC MAKER is not enough on its own. A friend has a Groovebox
and wants to jam...
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If two software or hardware sequencers (devices like Grooveboxes or keyboards) are
intended to play music together, then it's important to synchronize them.

Why is that important?

You would have to be pretty skilled to be able to play both programs or devices at the
same time - there would most likely be problems with time delays, and as soon as one
side pauses or skips forward, chaos is fairly likely the result.

Even if playback was started simultaneously (or "synchronously"), the sequencers may
become "out of sync" over time. That's because, even if the same tempo is set on both
ends, it will never match 100%. Software sequencers use a time-based value to
determine the tempo, which is derived from the sample rate of the sound card.
Theoretically, this has a fixed value, e.g. 44100 Hz, but in practice this value can differ, so
that the real tempo can be slightly faster or slower than the one indicated.

Therefore, synchronization means that one side constantly receives information about
the current time position from the other, and that the position and tempo is corrected
correspondingly to result in a match. This includes provision of all transport functions like
start stop, or jump to a specific time position.

The side which sends the synchronization information is called the Master, and the side
which receives the information is called the Slave.

MAGIX Music MAKER can run in both of these functional modes. For synchronization,
the protocols MTC (MIDI time code) and MMC (MIDI machine control) are applied.

For synchronization, a normal MIDI connection is required, i.e. depending on the
operational mode, you connect a MIDI output (MIDI OUT) on the computer with the
MIDI input (MIDI IN) on the other computer or device for master synchronization or
other way around (MIDI input on the computer with the output on the other machine for
slave sync).

Activate synchronization in the dialog Arrangement settings (keyboard shortcut: A)
under the Synchronization tab.
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Synchronization settings

MIDI Synchronization
' Receive MIDI Synchronization

Deevices Maple Midi In: Port 1 bl

Frame Rate: 25 frames/s bt

S MIDN Symchromization

Receive synchronization (slave): Slave sync on. MAGIX Music MAKER follows the tempo
and transport control of the external device/program.

Device: Here you have to select the MIDI input driver via which MAGIX Music MAKER
should receive the MIDI timecode.

Frame rate: The master and slave frame rates must match. Synchronization with video
programs/video hardware matches the frame rate of a specific video format, e.g. 24 for
cinema, 25 for PAL video/audio synchronization, 29.97 drop/no-drop or 30 for NTSC
video.

Pre-roll frames: Here you can enter a frame number that MAGIX MusiC MAKER will
ignore before synchronization starts. This takes into account the fact that analog devices
normally require a certain amount of time before they reach the correct speed. In order
to prevent synchronization of MAGIX MusiC MAKER to an invalid time, this can be
skipped by means of preroll frames.

Send synchronization (master): Master sync on. The external device/program follows
the tempo and transport control in MAGIX MusiC MAKER.

Start offset (ms/SMPTE): Here you can specify a period in milliseconds and SMPTE
frames (minutes:seconds:frames) to be deducted from the incoming SMPTE time before
the time is applied for synchronization. With an offset of 60:00:00 (1 hour), you can
therefore synchronize a tape with an SMPTE code that starts at 1 hour; MAGIX Music
MAKER will still start at O at the tape beginning. Vice versa, sending a timecode snaps this
value to the current position.

Correction factor: Normally, this value should be at "1" if you don't change it. In seldom
cases, synchronization of MIDI and audio can run apart for longer project. You can

181 /216



Additional functions

accelerate the speed of the MIDI playback by slightly increasing this factor (e.g. to
1.000001).

ReWire

ReWire-compatible client applications (like, for example, Propellerheads Reason) can be
integrated into MAGIX MusIC MAKER as synthesizers.

Activate the ReWire function in the Project settings ("E") under the Synchronization tab.

Afterwards, installed ReWire applications can be loaded as instruments into a track. All
ReWire client applications appear as individual sections in the selection menu for
software instruments in the track header and in the MIDI editor and are loaded as
software instruments (VSTi).

Several client applications can be opened automatically by right clicking on their name in
the selection menu, just as you can open the plug-in window for VST instruments by right
clicking. ReWire clients which support the direct opening of the client application via the
host application (MAGIX Music MAKER) need to be started manually. You can do this by
starting your client application as you would normally. It then automatically recognizes
the host and starts in a special client mode. The client application should always be
launched after MAGIX Music MAKER and should be closed before exiting.

The ReWire application can be controlled via MIDI, just like a software instrument. The
client application runs, starts, and stops synchronously with the time position in
MAGIX MusiC MAKER so that you can also use the sequencer in the client application.

The "classic" MIDI channel of MIDI notes and events is not important; it is replaced by
the ReWire MIDI bus system. MAGIX MusiC MAKER only sends to the ReWire MIDI bus
and only supports the ReWire master output-side, not the ReWire audio bus system.

[ ]
Automation curves
Alongside the object-based effects and the mixer effects for entire tracks/for the entire
sound, there is also the option of controlling effects via freely drawn curves.

There are track curves and object curves. The track curves are saved in the track and
affect all of the objects the track. Object curves are attached to an object and can be
moved together with it If the object's length is changed the curve will be adjusted

accordingly.

[ 7
Object featuring FX Level 1 object curve on a track with an active volume curve

L.

b

Morphium|1l ogg.HD
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Automation curves change a specific value, e.g. the volume value for a track, which is
"automated" during playback. This enables you to make your projects more exciting, e.g.
the volume of several tracks shortly before the refrain may be reduced slightly in order to
make the refrain itself more powerful once it appears.

Effects that may be automated

The following effects can be controlled via effect curves:

Audio objects

« Volume and Panorama are identical to the functions in the mixer, in which case a
volume curve is added to the mixer setting and a panorama curve replaces the
mixer setting entirely. 0% in the Panorama corresponds with all the way to the left,
while 100% is all the way to the right.

« Softening and sharpening filters as well as distortions (objects only) are additional
effects that are only available for effect curves and that are independent of the
filter or distortion effect in the effects rack. This controls the filter's input
frequency or the degree of distortion.

« Effects level 1 and 2 control the effect level sent from the object or track to the
two effects tracks (752).
In this case, the value of the curve is added to the

Video, image, and title objects

e XY position: An X curve value of 50% corresponds to the normal position; at 0%,
the video is moved to the left by its own complete width, and at 100% it is moved
to the right (it becomes invisible in both cases). Analogous to this, a Y value less
than 50% moves the video downwards, and a value more than 50% moves it
upwards.

« Height/Width/Zoom: 50% corresponds with the original size; 100% corresponds to
double size. 0% causes the object to disappear.

« Rotation: 50% corresponds to the original orientation, 180° corresponds to the
maximum clockwise rotation, and 0% 180° rotates the object counter-clockwise.

Video effects are only available as object effects.
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Track automation

B You may also show an automation curve for editing the project in the track's
"Effects" menu. In this case, only one automation curve per track will be displayed;
all automation curves are able to affect the track simultaneously.

Audio FX Rack Track...

:
e

Drums & Percussion
Bass

Guitar

:
%

Key Instrument

.
L

Viocals
Vioice Recordings
Wind Instruments

"

Strings

Special Effects
Flute

Reset

Sawe track effects

L3
L3
3
13
3
L3
L3
L3
L3
3

"

Volume
Panorama

FX 1 level

FX 2 level
Smooth Filter
Sharp Filter

Maowe track dawn

Edit track curves

The curves can either be edited with the individual handles or by freely drawing the
effects curve.

New handle points can be added by left-clicking on the curve; existing ones can be
deleted by double-clicking. All handles can be moved with the mouse in a horizontal and
vertical direction.

In Automation (749) mouse mode, the left mouse button may be used to draw a new
curve on the track.
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Object automation

Object curve effects are selected and edited in the "Dynamic Effects Editor" dialog. This
can be opened with the command Automation for this object from the context menu by
right-clicking on an object.

(2] Dynamic effects x

Organ Riff] 6_ogg.HDP

Volume

Adjustment

Rhythmic envelope

Invert envelope

Delete envelope

In the top drop-down menu, you can choose from the available effect curves for the
selected object. The box activate allows you to activate the respective curve. To keep
things clearly laid out, only one curve for an object can be edited at time, all other active
curves will be displayed as thin, black lines on the object.

~ Tip: You can select and activate another object and its automation curves without having
to close the editor in the meantime.

~ The volume and panorama curves of an object may also be hidden/shown via "Effects ->
Automation".

Rhythmic envelope: This options creates a rhythmic curve either via the generator or (for
audio objects) via volume analysis of the object.

Invert envelope: Mirrors the current curve on the 50% horizontal axis, i.e. 0 becomes
100%. For a panorama curve, this would result in the playback side changing.

Reset envelope: Deletes the current effect curve.

Editing object curves

Standard mode: While the project is not being played back, it is possible to use a slider to
create and vertically move a point of the effect curve and move it vertically at the start
marker's position. This means that you can edit an effect curve by placing the start
marker at different positions and adjusting the curve's value at that point using a slider.
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Draw mode: Move the slider in the dialog (while the playback is stopped) and a curve will
be drawn in the track between the start and end marker accordingly. The duration of the
curve drawn corresponds with the object's duration. Automation mouse mode (749) is
also activated so that the curve may also be drawn in with the mouse. This also works
while playback is running.

Active Adjustment: Adjust curve to object length: Specifies behavior of the object curves
if the length is altered subsequently. If the "Active adjustment" option is active, the
object curves are compressed and extended with the objects, i.e. the curve points are
moved correspondingly. For instance, if a pan curve is set so that an object is moved from
100% right to 100% left, this is also done after the length has been changed (only slower
or faster).

Curve generator

The curve generator will create a beat-based automation curve that pulses according to
eighth, quarter, half, or full notes. Enter a minimum and maximum value or define delay
values as an option for the beat-based envelope curve calculation.

The option "Create..." opens a selection dialog to define the shape of the automation
curve more accurately.

[Z] pialeg *

One cycle per...

Eighth decreasing
Quarter Sawtooth increasing
Half Square

Full bar Triangle

Options

Cancel

Beat-based: This option causes the form of the automation curve to follow the beat in
the arrangement.

There are 4 basic patterns available for beat-based automation curves: 2 sawtooth
shapes, rectangle, and triangle. These shapes run depending on the beat and control the
intensity of the activated effect. The left side of the dialog enables the automation curve
to be set to activate once per eighth, quarter, half, or whole note.

Options: This opens an additional dialog to control the style and intensity of the
influence of the beat on the automation curve.
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« Limitation: Determine the minimum and maximum value of the envelope. Via
Delay Minimum/Maximum the basic forms can be altered further.

« Shift moves the entire curve. This lets you create interesting off-beat effects.

Scan envelope: This option allows the volume process to be displayed as an automation
curve (as an alternative to a beat-based automation curve).

First normalize: This function normalizes the level of the audio object before the object
is scanned to create an automation curve.

MAGIX Audio Remote

The MAGIX Audio Remote app is for remotely controlling certain functions of
MAGIX Music MAKER via smartphone or tablet. Your computer and device need to be on
the same Wi-Fi network for this to work.

Download the app for Android or for iOS or download directly from MAGIX.

Get Connected

Setting up a connection between MAGIX Music MAKER and MAGIX Audio Remote is
simple.
1. Make sure that your PC and the mobile device are connected to the same network.
The connection will be automatic if both devices are using the same internet router.

2. Open the app and click the gear icon in the top right corner. The settings screen
shows the name of the computer on which MAGIX MusIiC MAKER is running under
List of found devices.

3. Tap the Connect button. The connection is now established.

General operation

. Tune-ups

The gear icon opens the settings screen. This is where you set up the connection
to the program. Use the slider to adjust screen brightness.

- Menu: Here you can choose how many pages you want in the control area.
Currently, there are four pages in the control area

o Filter
« Reverb
e Transport

o Live Pads
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The small transport console is visible on every page.
0 Loop on/off

9 Go to start

9 Stop

6 Play/Pause

6 Record

Filter

Filter is a remote control / modulation source based on physical modeling for the filters in
MAGIX Vita Solo Instruments.

The vertex of a filter curve is controlled by a sphere graphic that hangs from a thread in a
set position (the sun). When the whole thing is set in motion, things start to get exciting.
Depending on how the graphic is manipulated, you can carry out slow filter changes, LFO
modulations or chaotic reflections. Even if you're not an expert, the interface makes it
easy to experiment.

To use the filter, load one of the Vita Solo Instruments with filter. How to set the filter in
motion:

« Click on the graphic and drag it. You can also click in space and drag to illuminate
the sphere with a tractor beam.

o The sun can be moved.
o Zoom between the sun and sphere to change the length of the thread.

e Click on the sun to undo the connection between the sphere and the sun. The
sphere now flies freely through space. It bounces off walls and the sun and gains
energy in doing so. The "ground" is in the lower part of the screen.

« Drag below left or right to the change the gravity.

« Two-finger zooming in free space changes the damping. As damping is increased,
the quicker the sphere comes to a stationary position.
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In technical terms, the Filter control sends the xy positions of the sphere as MIDI CC20 and
CC21 to the Vita Solo Instruments. These correspond to the controllers that are used by
the the first two Novation LAUNCHKEY MINI sliders and that are assigned preset
parameters in all the Vita synthesizers. In the replications of the synthesizers these are the
cut-off and resonance filters. These attributes can be changed in order to modulate two
other synthesizer parameters with the "Filter".

Details for assigning MIDI controllers to Vita Solo Instrument parameters can be found
under Automation of Vita Solo Instruments (770)!

Reverb

In the reverb page you can control reverb in the Vita synths.

« Setroom size in the rectangle
« Zoom with a two-finger gesture to define the amount of reverb (Dry/Wet).

Transport control

The transport console performs exactly the same function as in MAGIX MusIiC MAKER
(and in the small transport console on the edge of the app).

Tip: For anyone creating music and producing at the same time, a recording in a recording
booth can be controlled remotely.
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Live Pads

Operate the MAGIX Music MAKER with the app. The interface will be the same as the
Live Pads interface (7190) in MAGIX MusIC MAKER.

Live Pads

The Live Pads are ideal for quick music production in realtime, live performances or
sketching out ideas for new songs. You can control 16 matching loops, global pitches and
effects via mouse, keyboard, MIDI keyboard or smartphone app (7187). This transforms
MAGIX MusiC MAKER into a musical instrument that can be played right away and
intuitively. 50 premade Live Sets in 13 great styles are included. You can also create your
sets from the Soundpools and your own recordings.

Live Pads interface
E Open the Live Pads by clicking on this button or by pressing the H key.

o Pads:Loops are started using the pads.

e Pitch: Like in the Soundpools, all melodic and harmonic loops in a live set are divided
into 7 pitches. If you choose a different pitch, all loops will adapt to create a
harmonic mix.

9 Record: If a recording is active, objects added to the project via the pads stay in
place and the live performance is recorded.

Q Quantization: When the pads are clicked, the loops don't start immediately, but
right on the beat to ensure that beats and melody synchronize. You can set the time
resolution for this (1 beat to 1/32 note) or deactivate quantization entirely.
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9 Presets: Select one of the pre-programmed live sets from the submenu and load it to
the pads. Use the < > buttons to select the previous/next Live Set.

@ Opens the settings menu with the following options:
« Create empty Live Set: Removes all samples from the pads.
« Load Live Set: With this button you can load your own or premade live sets.

« Save Live Set: The complete assignment of the Live Pads can be saved with
this button as a "Live Set" (.Ims file) to be used later. The current Live Pad
assignment will be saved together with the project.

o Reset

« Sync mode: See below

« Pad text: Use this option to hide the labels of the pads.

« MIDI control: MIDI control of the pads can be deactivated here.

Playing the Live Pads

Load one of the live sets supplied by clicking on "Presets". This fills the pads with loops
and gives them different colors. Loops can be played back by clicking on the
corresponding Live Pads using the computer (keys 1-8 and Q-I) or MIDI keyboard (see
below).

As soon as a Live Pad is selected, playback begins. During playback the corresponding
object will appear for each Pad, and then disappear again when the Pad is released (when
recording with REC it will remain visible).

The pads that are being played will illuminate more brightly.

Pads in the same color form a group. This means that these loops are sharing a track and
only one of them can be played at a time - for instance different variations of one drum
loop.
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Sync mode

By default, loops are played in Sync Mode, as if they were all started at the project start
and switched with the pads to "audible" (Mute Automation). This means that all loops
always play in synch. Use this mode to create a basic structure for your project. If the
sync mode is turned off, loops will always be played back from the start. Use this mode if
you would like to add solos or effect sounds or separate the beats in break beats. Sync
mode can be deactivated through clicking on the gear icon.

Your own live sets

Using drag & drop, you can add samples from the Loop window to the Live Pads in order
to put together your own live sets. If you're using loops from the Soundpools in addition,
these also adapt to shifts in pitch. However, pitch shifting will not function with your own
samples, or recordings that don't contain any information about pitch.

If using several drum loops that are played backed alternatively, these should be mutually
exclusive. Therefore, they need to be grouped together. To do this, right-click on the
pads you have selected and choose the same group number for all of them.

Text to speech
With this function you can have the computer "speak" a text. You can adjust the speed
and volume of the spoken passage, as well as the voice used.

Open the dialog Generate speech from text... via the Effects menu or by using the
shortcut Ctrl + Shift + T

Load text: Here you can load a text file in the formats: *.txt or *.rtf.
Save text: Your entered text can be saved.
Test: After entering your text, you can preview the result.

Voice: If additional voice packages (TTS engines) have been installed, you can select a
different voice here.

Speed: Playback speed can be regulated with this controller.

Volume: Output volume is regulated with this control.

Format: Here you can determine the quality of the created wave file (.wav).
File: Path selection for the wave file to be created.

Create object in arranger: When you're happy with the result, click on this button to
create an audio object in the arranger and close the dialog.
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Notes

In the Notes window, you can add notes to the current project that are saved together
with the project file, for example lyrics, to-do lists or information about the recording.
This is a common text editor with some additional formatting options.

E Open the Notes window by clicking on this button or by pressing the N key.

o Ellmport text You can import texts in HTML or plain text format. HTML
formatting is kept, but cannot be edited beyond the possibilities of the Notes editor.
If notes already exist in the editor, you can choose whether the imported text should
replace the existing one or whether it should be added.

Export text You can export the contents of the Notes editor as an HTML file.
@ Formatting

E Headline E Bold CursiveE Bullets E List

To format a paragraph (e.g., headings, lists), place the text cursor in the line and
select the corresponding icon. To format individual words (e.g., bold, italics), select
the words first and then click the corresponding button.

9 Text editor Type in your text here.
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Menus

All of the program's features are listed and thematically sorted in the menus.

Many features can also be accessed elsewhere using buttons, the advantage of items in
the menu is that they can be performed using keyboard shortcuts.

File menu: Here, all the functions for loading and saving projects and media files, as
well as the program, language and project settings can be found.

« Edit menu: Here, all the functions for editing the arrangement can be found.

« Effects menu: Here, all audio effects that cannot be accessed from the Object
Effects or Track Effects windows, the master effects and other audio features can

be found.

« View menu: This menu can be used to show or hide the different windows in
MAGIX Music MAKER and to define settings for the arranger's functionality.

« Help menu: Here, various help functions can be accessed locally or on the Internet
to assist you while working with MAGIX Music MAKER. Various settings for the

Store and your MAGIX account can also be found here.

File menu

New Project Wizard

A new project (7152) will be created.
Keyboard shortcut: Shift + N

Load project
This loads a MAGIX MusIC MAKER project.
Keyboard shortcut: Ctrl + O

Save project

The current project will be saved.
Keyboard shortcut: Ctrl + S

Save project as...

The current project will be saved in a new file.
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Shortcut: Ctrl+Shift+S

Read more on this under Save/load projects (7152)!

My projects

In this submenu, recently opened projects are listed for quick access.

Import audio CD tracks

This menu command opens the CD import dialog for importing tracks from audio CDs
into projects. More can be found in the Importing Audio CDs (736) section.

Keyboard shortcut: C

Export

In this submenu, all functions for exporting a finished song can be found, for more details
read the chapter Export projectLoading, Saving and Exporting Projects (7152)

Settings

In this submenu, you can open all the important setting dialogs and specify settings.
o Program settingsProgram settings (7209) (keyboard shortcut: P)
« Project settingsProject Settings (7153) (keyboard shortcut: A)
« Automatic pitch adjustment, see Pitch barPitch bar (743)

« Audio recording, see audio recording dialogAudio recording dialog (733) (keyboard
shortcut: Shift+R)

o Language: Change the language used in MAGIX Music MAKER here. Normally, the
language that is used for installation is set as the program language.

o Reset standard program settings: Use this function to reset all Program settings
you made in MAGIX MusIC MAKER to their original settings.

Exit
Closes MAGIX MusIC MAKER.
Keyboard shortcut: Alt + F4
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Menus

Edit menu

Undo

=] |n projects the last (up to 10) changes, including object and playback manipulations,
B8 -an be undone. This way, it's no problem if you simply want to try out different
operations. If you don't like the result, you can always revert to the previous state
using "Undo".

Keyboard shortcut: Ctrl + Z

Redo

This function undoes the previous "Undo" function.

Keyboard shortcut: Shift +Y

Object

Create a new object

You can create new empty objects with these functions:

o New MIDI object creates a new MIDI object in the current track. You can choose
between empty MIDI objects with 1, 2, 4 or 8 bars in length and some standard

templates.
Keyboard shortcut: Ctrl + Alt + N

« Create a new title object: A new title object will be created and the Title editor will
be opened.
Keyboard shortcut: Alt + Shift+ T

« Generate speech from text (7192)

Cut objects

Objects selected from the current project will be cut out and saved to the clipboard. They
can then be pasted to a different location.

Keyboard shortcut: Ctrl + X
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Copy Objects

Objects selected from the current project will be cut out and saved to the clipboard. They
can then be pasted to a different location.

Keyboard shortcut: Ctrl + C

Duplicate objects

This menu point duplicates all selected objects. The copies appear beside the original and
can be placed in the correct position using drag & drop.

Keyboard shortcut: Ctrl + D

Insert objects

The contents of the clipboard are added into the current project at the position of the
start marker.

The playback marker is positioned at the end of the most recently inserted object so that
the quick and easy multiple use of the command is also possible. Existing objects now
become overwritten.

Keyboard shortcut: Ctrl + V

Inserting multiple objects

This function is similar to Insert objects, but you can choose how often the content of
the clipboard is to be inserted.

Keyboard shortcut: Ctrl + Numeric pad '+'

Deleting objects

H Removes the selected objects from the current project.

Keyboard shortcut: Del

Splitting objects

3 You can cut a selected object at the position of the playback marker into two
smaller objects.
If no object is selected, all objects are cut at the playback marker position.

Keyboard shortcut: T
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There is a special Mouse mode (750) for splitting objects.

Save objects as takes...
The selected objects are saved in the takes directory.

For more about using takes, please refer to the section Takes (756).

Keyboard shortcut: Shift + K

Grouping

« Group objects: All selected objects will be assembled in one group. This means that
as soon as an object is selected in the group, all objects in the group become
highlighted so that you can work on them collectively.

Keyboard shortcut: Shift + G

« Ungroup objects: This command splits an object group into separate objects.
Keyboard shortcut: Shift + U

Loop range

Normally an object is always looped over the full length of the underlying audio file. To
set a clip from a file as a loop, shorten the object at the front and the back with the
handles and choose Set custom loop.

This function is very useful for setting your own recording as a loop, as the silence at the
beginning of a recording can be cut away.

Using Deactivate user-defined loop, the user-defined loop length is reset.

Object properties

This function displays the information about the currently selected objects such as file
name, position on the hard-drive, tempo, etc. The Object Editor also defines the
foreground and background color of every object in the arrangement.

Keyboard shortcut: Ctrl + P

Track

Add track

A new empty track will be added to the arranger.
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If you already know that you need several tracks, you can set the number of tracks in the
Project settings (in the menu under File > Settings or (keyboard shortcut: A) to a larger
value, so that you won't need to click this button as often.

Keyboard shortcut: Ctrl + |

Combine audio...

This function can combine the project or segments of the project into a single
audio/video object. Please read more on this in the section Combine audio (757)

Keyboard shortcut: Ctrl+Shift+G

In addition to the to various features to Cut, Copy, Paste, Duplicate and Delete objects,
these features are also available as "band-oriented" editing tools. This means that the
copy operation is applied to the content on all tracks within the Range between the start
and end markers, regardless of which objects are selected. Just like if the arrangement
were a tape, from which parts are cut or pasted.

/1 This leads to an important distinction from copying/pasting objects: The following content
on all tracks is moved forward when cutting and deleting, so there is no gap.This leads to
an important distinction from copying/pasting objects: The following content on all tracks
is moved forward when cutting and deleting, so there is no gap. When pasting, the
following material is moved backward and not overwritten.

Cut range

The area between the start and end markers is cut from the current project and placed on
the clipboard. This section can be reinserted elsewhere. The objects located at the end of
the pasted material will also be moved forward.

Keyboard shortcut: Ctrl + Alt + X

Copy range

The area between the start and end markers in the current project is copied to the
Clipboard. This section can be reinserted elsewhere.

Keyboard shortcut: Ctrl + Alt + C
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Insert range

The contents of the clipboard are added into the current project at the position of the
playback marker. The objects located at the end of the pasted material will also be moved
forward.

Keyboard shortcut: Ctrl + Alt + V

Insert segment multiple times

Similar in function to Insert range, but you can stipulate how often the content of the
clipboard is to be inserted.

Delete range

The area between the start and end markers in the current project is deleted and the
following objects are moved forward.

Keyboard shortcut: Alt+Del

Extract range

The area between the start and end markers is retained, all the material in front and
behind it are then deleted. Use this option to isolate a specific part of an arrangement for
further individual editing.

Keyboard shortcut: Ctrl + Alt + P

Navigation

Using these commands, a viewable portion together with the start marker will be moved
in the timeline. You can quickly skip between different jump markers and object edges.

Note: These commands similarly move the playback marker when it's stopped, the marker
always remains visible in the project section.

To next object edge Ctrl+0

To the previous object edge Ctrl + 9

To beginning of project Home

To end of project End

Go to start marker Ctrl + Home
Go to end marker Ctrl + End
Page to right/left Page up/down
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Grid unit to right/left Ctrl + Page down/up

Using these commands, a viewable portion together with the start marker will be moved
in the timeline. You can quickly skip between different jump markers and object edges.

Set jump marker

This sets a jump marker at the position of the current playback marker. Here you can
note specific parts of the project. With the "Move playback position" function you can
quickly jump to these positions.

Keyboard shortcut: Shift +1...0

Go to the next jump marker Ctrl + Shift + PgDn
Go to the previous jump marker Ctrl + Shift + PgUp

Create jump marker sequence

This option duplicates the currently selected playback area between the start and end
markers by setting start markers equidistant to one another in the bar ruler. Now you can
jump to every jump marker using keyboard shortcuts.

Keyboard

Delete all jump markers

Deletes all jump markers
Keyboard shortcut: Alt + Shift + M

Move playback position
This moves the playback marker to the position of a jump marker. This function can best
be used via the keyboard.

When stopped, you can immediately move the playback markers to the position of the
saved jump markers. During playback, the playback marker along with the playback range
will be moved. Here, the old range is always played until the end so that you can remix
your project live once the jump markers have been placed where you want them without
losing the beat.

Keyboard shortcut: 1 ...0

Select all

All objects found in the project are selected.
Keyboard shortcut: Ctrl+ A
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View menu

Standard layout

Resets the window arrangement and the windows' docking in MAGIX MusIC MAKER to
the default setting:

o Loops and Store are docked to the right of the arranger.

o Keyboard, BeatBox and Song Maker are docked below the arranger.

Layouts

Here, you will find different preset window arrangements for various tasks, which can be
quickly selected using the F4 to F8 keys.

For more information about free-floating window arrangements, please refer to
Overview of the program interface (722)

Window

This menu lets you open and close the various windows in the program.

Arranger

Optimize view

BER The start marker is set to the beginning of the project, the end marker is set to the
end of the last object, so that the entire project can be played.

Zooms out of the project so that the complete duration of the project is visible. The
vertical zoom steps (track height) remain preserved.

Keyboard shortcut: F12

Maximize height of tracks

This option lets you quickly maximize or minimize track height.
Keyboard Shortcut: Tab
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Objects with stereo imaging

If this option is selected, audio objects are displayed with separate waveforms for each
stereo channel In addition, video objects are displayed as individual frames in the
arranger. Normally, only the first and last frame are shown to allow for a faster display.

Shift: Ctrl + Alt + Z

Show loop range

The loop range between the start and end markers is highlighted and played back as an
endless loop. This can also be deactivated here.

Display pitch ranges
Displays or hides the Pitch bar (743).

Horizontal scrolling

This option reverses the horizontal and vertical functions of the mouse wheel for
zooming and scrolling (745). This means you can use Shift and Ctrl+Key for zooming and
scrolling the tracks instead of for the visible duration. This corresponds with the
performance of the mouse wheel in the old MAGIX MusiC MAKER version.

Cursor keys move playback marker

This option is activated by default. If you disable this, you can move the playback marker
with the arrow keys while additionally pressing the Alt key. You can then move the
playback range (742) with just the cursor keys.

Show object marker > Show bar/beat/harmony marker

After running the Remix Agent or Harmony Agent, the analyzed audio material receives a
beat or harmony information in the form of markers that can then be shown in the
arranger with the above commands.

Keyboard shortcut: Bar marker Ctrl + Shift + F9
Harmony marker Ctrl + Shift + F10
Beat marker Ctrl + Shift + F11
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Effects Menu

Master Audio Effect Rack

Here you can open or close the master effect rack. You can read the "Audio effects"
(©»108) chapter for more information on audio effects.

Keyboard shortcut: B

Mastering Suite

You can open the MAGIX Mastering Suite (7127) with this option.
Keyboard shortcut: N

Text to speech

Read more on this topic in the Additional functions (7192) chapter.
Keyboard shortcut: Ctrl + Shift + T

Audio effects

This submenu contains the non-realtime effects (7148) Sketchable filter, Gater, Invert
phase, and Reverse, which cannot be applied using the Object Effects or Trace Effects
(»7108) windows.

Convert stereo into two mono objects

With this option, stereo recordings can be split into two mono objects which are then
grouped together. You can use the "Ungroup" button to edit the channels as independent
objects.

Keyboard shortcut: Shift + Z

Load/Save/Reset audio effects

You can save the current effect combination of an audio object separately and apply it to
other objects later. Alternatively, you can deactivate all currently used effects entirely
(reset) if you want to undo the changes.
Keyboard shortcut: Load audio effects Ctrl + Alt + O

Save audio effects

Reset audio effects Ctrl + Alt + R

204 /216


../../../../../Content/Audioeffekte.htm
../../../../../Content/MAGIX Mastering Suite.htm
../../../../../Content/Sprache aus Text erzeugen (Text-to-speech)....htm
../../../../../Content/Nicht-Echtzeiteffekte.htm
../../../../../Content/Audioeffekte einsetzen.htm

Effects Menu

Volume

An assortment of different menu commands which influence the volume of your audio
objects.

Mute/Unmute

Use this command you can mute one or more selected objects. Selecting this command
again makes it audible once again.

Shortcut: Ctrl + M

Set volume

This function in the effects menu and context menu sets the volume of individual objects
to a uniform value.

Automatic volume damping

This command automatically dampens the volume of other audio objects. This can be
used to insert voiceovers into your project or add commentary to a film (with the original
sound). You can also specify whether you want to dampen the original sound of existing
videos or all soundtracks equally.

In the dialog you can activate and deactivate the value of the dampening.

You can use this command while recording audio (Audio recording (#33), advanced
options).

Shortcut: Ctrl + Shift + D

Normalize (maximum level)

The "Normalize" function raises the level of an audio object to the maximum possible
level without clipping the material. This searches for the highest signal peak in the audio
material and raises the level of the object so that this peak matches 0 dB (maximum level)
exactly.

Keyboard shortcut: Shift + N

Pitch, tempo & remix

These are the commands for remix functions in MAGIX Music MAKER.
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MIDI transposition

This command is only available for MIDI objects. This allows you to increase or reduce
the pitch of all notes of a MIDI object by a certain value (in semitones). See Arrange MIDI
objects (776)

Shortcut key: Shift + T

Harmony Agent
The Harmony Agent is designed to analyze harmonies.

You can read more about this in the section Additional functions (.7174).

Keyboard shortcut: H

One pitch higher/lower

You can quickly alter the octave of an included sample without having to go to the
corresponding loop in the loop window.

Create remix objects

If, while running the Remix Agent, the tempo and beat information were saved to the
audio file, this command can be used to create remix objects. If the Remix Agent has not
yet been implemented, this command starts it and opens the presets dialog for creating
remix objects.

Shortcut: Ctrl + J

Remix Maker

With the Remix Maker, automatic remixes can be created from Remix Agent (7172) loop
objects.

Shortcut: Shift + K

Tempo & beat recognition

MAGIX MusiCc MAKER provides a Remix Agent for the automatic determination of the
speed in BPM (beats per minute) and for the creation of loop objects.

You can learn more under Remix Agent (7166).

Shortcut: J
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Loop finder
See Find loops (7171)

View menu

Standard layout

Resets the window arrangement and the windows' docking in MAGIX MusIC MAKER to
the default setting:

o Loops and Store are docked to the right of the arranger.

« Keyboard, BeatBox and Song Maker are docked below the arranger.

Layouts

Here, you will find different preset window arrangements for various tasks, which can be
quickly selected using the F4 to F8 keys.

For more information about free-floating window arrangements, please refer to
Overview of the program interface (722)

Window

This menu lets you open and close the various windows in the program.

Arranger

Optimize view

B The start marker is set to the beginning of the project, the end marker is set to the
end of the last object, so that the entire project can be played.

Zooms out of the project so that the complete duration of the project is visible. The
vertical zoom steps (track height) remain preserved.

Keyboard shortcut: F12

Maximize height of tracks

This option lets you quickly maximize or minimize track height.
Keyboard Shortcut: Tab
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Objects with stereo imaging

If this option is selected, audio objects are displayed with separate waveforms for each
stereo channel In addition, video objects are displayed as individual frames in the
arranger. Normally, only the first and last frame are shown to allow for a faster display.

Shift: Ctrl + Alt + Z

Show loop range

The loop range between the start and end markers is highlighted and played back as an
endless loop. This can also be deactivated here.

Display pitch ranges
Displays or hides the Pitch bar (743).

Horizontal scrolling

This option reverses the horizontal and vertical functions of the mouse wheel for
zooming and scrolling (745). This means you can use Shift and Ctrl+Key for zooming and
scrolling the tracks instead of for the visible duration. This corresponds with the
performance of the mouse wheel in the old MAGIX MusiC MAKER version.

Cursor keys move playback marker

This option is activated by default. If you disable this, you can move the playback marker
with the arrow keys while additionally pressing the Alt key. You can then move the
playback range (742) with just the cursor keys.

Show object marker > Show bar/beat/harmony marker

After running the Remix Agent or Harmony Agent, the analyzed audio material receives a
beat or harmony information in the form of markers that can then be shown in the
arranger with the above commands.

Keyboard shortcut: Bar marker Ctrl + Shift + F9
Harmony marker Ctrl + Shift + F10
Beat marker Ctrl + Shift + F11
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Program settings

In Program settings, you can customize certain features in MAGIX MusiC MAKER to your
liking as well as for the capabilities of your computer's hardware.

ﬂ To open the program settings, click on this button or select File > Settings >
Program settings in the menu. (Keyboard shortcut: P)

General

Arranger

Autoscroll during playback: If autoscroll is activated, the screen view automatically
shifts when the playback marker reaches the right edge of the screen. Here, two speeds
for autoscroll are available and it can also be deactivated.

Simplified object display:If this option is selected, audio objects are displayed with
separate waveforms for each stereo channel In addition, video objects are displayed as
individual frames in the arranger. Normally, only the first and last frame are shown to
allow for a faster display.

Spacebar stops at current position: Activate this option if you want the playback marker
to remain at the same position after stopping playback. If this option is not active, the
playback marker will jump to the original position when playback is stopped.

Automatic saving of backup projects

Here you can the time intervals at which automatic backup projects will be saved. (7154).

Hints

In its newly installed state, MAGIX MusiC MAKER displays a number of security queries at
various parts of the program. Each of these can be switched off by clicking the small box
at the bottom that says Don't show this message again. To display these warning
messages, select the "Reactivate dialogs" option.

Program interface

Hide news: This option deactivates the MAGIX News Center in the main interface of
MAGIX MusIC MAKER.

209 /216


../../../../../Content/Backup.htm

Program settings

Text size for readability and touch: A larger text size can be set here in order to use the
program on touch devices or devices with a high screen resolution.

Send usage data to MAGIX: Anonymous data is sent to MAGIX for improving product
quality. This option can be deactivated here.

Loops

Hide unavailable loops: All Soundpools are saved into a database automatically. The
Loops window lists all loops saved in the database, i.e. also those which originate from
external media (Soundpool discs) that may not be in the drive at the moment. These
results can be hidden, but this slows down the search results in the Loops window.

Hide instruments which are left empty in the style selection: Instrument groups for
which there are no loops present in a certain style are completely hidden in the Loops
window (instead of being grayed out).

Standard quality/Best quality: See High quality loops (726)

Clean up Store: The local Store database and its cache are deleted and reset. This
function is intended for emergencies such as if the shop is not operating correctly even
after restarting the program.

Rescan Soundpool: This resets the Soundpool database and rescans the Soundpools
folder.

Import

Options

Preview samples (Wav, OGG) while playing the project (Smart Preview): Here you can
switch off the preview when a playback is running (Smart Preview).

Automatically adapt samples to BPM: When loading or previewing the project,

MAGIX MusiC MAKER tries to adapt the samples to the tempo of the project. This always
works properly with newer MAGIX soundpool samples as the tempo information is saved
in the audio file. It usually works with all other loops as well, provided the loops are clean,
that is, they are cut to entire bar lengths.

With "For patched samples only", automatic timestretching can be deactivated for all
other samples. With "Apply to samples longer than 15 seconds as well", longer samples
will also be adapted if they contain tempo and bar information provided by the Remix
Agent.
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Automatic preview starts for...

Here you can deselect automatic file preview start in the file manager for certain file
types.

Import Formats

File formats that you never use can be de-selected here. Once de-selected they will no
longer be imported. Please keep in mind that several import modules exist for some file
types (AVI, WMA); MAGIX Music MAKER uses the fastest one in each case. If you
experience problems when importing certain files, you can experiment with deactivation
of certain import modules, forcing the program to use the slower but more compatible
import module.

Audio/MIDI
Audio playback

These options specify which sound card or output plays audio and which drivers should
be used.

Wave/Direct Sound/ASIO/WASAPI: Specifies which drivers should be used for the
sound card.

When using live monitoring and when playing and recording VST instruments in real time,
i.e. with as low a reaction time (latency) as possible, we recommended that you use ASIO
drivers for full functionality in MAGIX MusIC MAKER. If your sound cards do not have
ASIO drivers, you can use the MAGIX Low Latency driver. Only when you do not have an
ASIO driver and the MAGIX Low Latency driver isn't working either, select WASAPI,
Direct Sound, or, if none of these work, Windows Wave driver.

Advanced: Use these buttons to access the playback options window which provides
information on the current sound card. ASIO provides the settings dialog for the ASIO
driver, e.g. the supplied MAGIX Low Latency ASIO driver.

If you select ASIO as the driver model, you can set the output in the upper list field (for
cards with multiple outputs) and the ASIO driver in the lower list field. Advanced opens
the settings dialog of the ASIO driver. Please refer to the sound card manual for more
information.

Audio buffers

Here you can specify the buffer size that should be used for playback of the entire
arrangement or for previewing audio files in the Media Pool. As a rule of thumb: If
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response and loading times are too slow, reduce the buffer size; otherwise increase the
buffer size if the audio playback is choppy or if real-time effect computation errors occur.
Since error-free playback is usually more important than fast reaction times, the buffer
size should be raised to 16384 or 32768 to avoid drop-outs.

Video

Video standard

PAL is used in Europe; the United States and Japan use NTSC. This setting should not be
changed.

Movie display

The resolutions that can be set here concern only the picture display of DV videos in the
Arranger. If playback becomes jerky, we recommend entering a lower value. The quality
of exported videos is not influenced by this.

Options

Extract sound from videos during import: If a video contains audio data as well, you can
use this function to extract the audio track from the video. It will be loaded directly
underneath the video track and grouped together with it. If you ungroup them (in Edit
menu), you can edit the sound as an independent object.

Automatically adjust videos to BPM during import: With the available BPM information
you can automatically create a video in which the rhythm and order of pictures are
synchronized. This does not play all frames of a video, but some are excluded according
to the BPM setting on frame playback. The video appears faster at a higher BPM setting;
it "dances" to the rhythm. The tempo can be set before every new project in the
transport control. Otherwise, the project applies the BPM tempo of the first sample that
is loaded.

Adjust minor deviations from 4:3 aspect ratio during export: This option automatically
customizes photos that have an approximate 4:3 aspect ratio to 4:3 TV screen format.
The pictures are therefore easily stretched or compressed. This inevitably brings about
distortions in the picture. If this option is deactivated, black bars appear along the sides.

Automatic preview of exported material: This option starts the exported media file
immediately after exporting for verification.
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Automatically copy exported material to clipboard: This option is particularly useful
when used with other programs, such as Microsoft PowerPoint. If switched on, the
created multimedia file will be available straight after being inserted.

Video priority: Usually, audio objects have priority on playback. Here, an overloading of
the computer as a result of too many effects can bring about jerky video playback while
the audio continues to play without any problems.

To change this, you can give the video playback precedence over the audio. Video
playback is then renewed after every audio buffer, which may lead to interruptions in the
sound.

Folders

Folders

Here, you can change the storage locations where the various files used by
MAGIX Music MAKER are stored.

« Storage location for the Projects.

« Storage location for export (Export) or import files (Import), save recordings
(Recordings), If desired, recordings can also be saved in the project folder.

Storage location for files from the Soundpool (Soundpool)
« Path to an external audio editor (757)

Storage location of your MP3 collection (My MP3s).

Add VST plug-in path

This allows you to specify the search paths for your own specify VST plug-ins and reset
these path details to the default settings with Reset VST plug-in information.

For more information about this topic, please read the section Add custom Plug-ins in
the chapter "Instruments". (774)

Toolbar

ﬂ Settings (7209) E New project
n Load project E Save project
Undo last action (Undo) Redo action
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m Analyzer

Select mouse mode (748)

Grid on/off (743)
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Publishing works created in MAGIX Music Maker

Publishing works created in MAGIX Music
MAKER

What needs to be taken into account when publishing a
music or video production?

A distinction is made between "non-commercial use" and "commercial use".
1. What constitutes non-commercial use?

If songs are created with MAGIX MusiCc MAKER or if music is added to private videos,
they can be shared with others on social networks (e.g. YouTube, Facebook, Soundcloud,
Twitter or personal blogs/websites). The decisive factor in these cases is that no money is
made or will be made from the song or video soundtrack.

Examples of non-commercial use:

o A user creates a song with MAGIX MusiC MAKER and uploads it to their
SoundCloud page or YouTube channel.

« A user produces a song using MAGIX MusIC MAKER, burns it to CD then sends it to
their friends.

2. What constitutes commercial use?

Commercial use refers to videos with soundtracks or songs created using MAGIX Music
MAKER for commercial purposes. Commercial use if if sales are made, if revenue is
accrued through advertising (e.g. as a YouTube partner or through the process of
monetizing) or if contracts are concluded. In this case the necessary licenses must be
purchased.

Examples of commercial use:

o A user creates a song in MAGIX Music Maker and uploads it to their YouTube
channel, which they've enabled for advertising (YouTube Partner Program).

« A user produces a song in MAGIX Music Maker and makes it available for purchase
from an online download shop (e.g. iTunes, Musicload).

o A musician produces a song with MAGIX Music Maker for a CD Compilation, which
is sold at concerts.

o A user makes a video in which they advertise their company or one of their
company's products.
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Publishing works created in MAGIX Music Maker

~ Important: The downloadable styles that are licensed for commercial use consist of high
quality WAV files. Any "normal" MAGIX MusiCc MAKER content from the installation DVD
is in .0gg format for space reasons.
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